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• No part of the manuals included with this product
may be reproduced, transmitted, transcribed,
stored in a retrieval system, or translated into any
language in any form, by any means, without
Nikon’s prior written permission.

• Nikon reserves the right to change the specifica-
tions of the hardware and software described in
these manuals at any time and without prior notice.

• Nikon will not be held liable for any damages re-
sulting from the use of this product.

• While every effort has been made to ensure that
the information in these manuals is accurate and
complete, we would appreciate it were you to bring
any errors or omissions to the attention of the Nikon
representative in your area (address provided sepa-
rately).

• Nikon Capture 3 installer CD
• Nikon Capture 3 Install Guide
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WARNING!

Do not play the Nikon Capture 3 installer CD on audio CD equipment.  Playing a CD-ROM on an
audio CD player could cause hearing loss or damage the equipment.

Trademark Information
Apple, the Apple logo, Macintosh, Mac OS, Power Macintosh, PowerBook, and FireWire are registered
trademarks of Apple Computer, Inc.  Power Mac, iMac, iBook, and Finder are trademarks of Apple Com-
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CompactFlash is a trademark of SanDisk Corporation.  Photoshop is a trademark of Adobe Systems Inc.
Internet is a trademark of Digital Equipment Corporation.  Netscape and Netscape Navigator are regis-
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manual or the other documentation provided with your Nikon product are trademarks or registered trade-
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Read this chapter before installing and using Nikon Capture 3.

Overview
Read this section for a description of how this manual is orga-
nized and for an explanation of the symbols and conventions
used.

The Five Components of Nikon Capture 3
This section describes the components that make up Nikon
Capture 3 and introduces some of its more notable features.

System Requirements
Before installing Nikon Capture 3, check that your computer
system meets the requirements listed in this section.

The Elements of Nikon Capture 3
This section provides a brief overview of each of the compo-
nents of Nikon Capture 3 and their functions.

Workflow
This section explains how Nikon Capture’s various components
work together when processing photographs taken in the field
or in a studio setting, and how batch processing can be used
to edit multiple images.

Before You Begin

Introduction



2

Overview

Overview
About This Manual

This manual has been written to help you take advantage of the many features included in
Nikon Capture 3.  This chapter introduces you to Nikon Capture’s five components and ex-
plains how they can be used as part of different workflows.  Each of these components is
described in greater detail in the chapters that follow.  The final chapter, “Technical Notes,”
includes information on how Nikon Capture can be used with other applications that support
color management, together with troubleshooting instructions and a glossary of terms.

Before using Nikon Capture 3, you should know how Nikon Capture fits into your particular
workflow, and what components and functions you will need.  You can then refer to the
chapters on the relevant functions as needed to complete each task.

Symbols and Conventions
The following symbols and conventions are used in this manual:

Life-Long Learning

As part of Nikon’s “Life-Long Learning” commitment to ongoing product support and education, con-
tinually-updated information is available on-line at the following sites:
• For users in the U.S.A.: http://www.nikonusa.com/
• For users in Europe: http://www.nikon-euro.com/
• For users in Asia, Oceania, the Middle East, and Africa: http://www.nikon-asia.com/
Visit these sites to keep up-to-date with the latest product information, tips, answers to frequently-asked
questions (FAQs), and general advice on digital imaging and photography.  Additional information may be
available from the Nikon representative in your area.  See the URL below for contact information:
• http://www.nikon-image.com/eng/

Menu items and button names are shown in bold.

This icon marks cautions, information that you
should read before use to prevent possible dam-
age to your camera or computer.

This icon marks notes, information that you
should read before using this software.

This icon marks tips, additional information you
may find helpful when using this software.

This icon indicates that more information is
available elsewhere in this manual.
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About This Manual

Background Knowledge
This manual assumes knowledge of operations common to Windows and Macintosh environ-
ments.  Refer to the documentation provided with your computer for more information on
operations specific to your operating system.

Illustrations
This manual is for use with both Windows and Macintosh versions of Nikon Capture 3.  While
the majority of the illustrations in this manual show the Windows versions, save where other-
wise noted the operations described apply to both operating systems.  Depending on the
operating system used, dialogs and menus may differ slightly from those shown here.

The ReadMe File
Be sure to read the ReadMe file on the Nikon Capture 3 installer CD, as it may contain impor-
tant information that could not be included in this manual.

Camera Control (Macintosh)

The Macintosh version of Nikon Capture 3 Camera Control does not support the D100 digital camera.

Windows XP Home Edition/Professional, Windows 2000 Professional, Mac OS X

Installing and using Nikon Capture 3 under a multi-user operating system requires Administrator privi-
leges.  When using Nikon Capture 3, log in as:

Windows XP Home Edition/Professional Computer administrator

Windows 2000 Professional Administrator

Mac OS X Administrator
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The Five Components of Nikon Capture 3

The Five Components of Nikon Capture 3
About This Product

Thank you for your purchase of Nikon Capture 3 software for Nikon digital cameras.  The
Nikon Capture 3 CD contains both Nikon View 5 and Nikon Capture 3.  Nikon View 5 is
comprised of three components: Nikon Transfer, which is used to copy pictures from the cam-
era memory card to the computer hard disk; Nikon Browser, which is used to browse images
after they have been transferred to your computer, and Nikon Viewer, which is used to view
images.  Nikon Capture 3 contains an additional two components: Nikon Capture 3 Editor,
which is used to enhance photographs after shooting, and Nikon Capture 3 Camera Control,
which is used to control D1-series or D100 digital cameras remotely while they are connected
to the computer.  Using these five components, you can transfer pictures to your computer,
view and edit them, and print them all in a single process.

Use with a Nikon D1, D1X, D1H, or D100 digital
camera to control the camera from your computer
and save photos directly to disk as they are taken.

Nikon Capture 3 Camera Control

D1-series or D100
camera connected to

computer

Starts automatically when a supported Nikon digi-
tal camera is connected, or a memory card from a
supported Nikon digital camera inserted in a card
reader or PC card slot.  Use to transfer pictures
from the camera to your computer hard disk.  Once
transferred, pictures can be previewed in Nikon
Browser.

Nikon Transfer

Existing pictures
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About This Product

Nikon Browser comes into play after you have
transferred pictures to your computer hard disk
using Nikon Transfer or Nikon Capture 3 Camera
Control.  Use to organize pictures into folders and
select pictures for viewing in Nikon Viewer or ed-
iting in Nikon Capture 3 Editor.

Nikon Browser

Use to enhance photographs taken with Nikon
digital cameras.

Nikon Capture 3 Editor

Use to view and print pictures.

Nikon ViewerData flow



6

System Requirements

System Requirements
What You Need to Run Nikon Capture 3

Before installing Nikon Capture 3, make sure that your system satisfies the following require-
ments:

* With CarbonLib version 1.5 or later.
† Camera Control with D1-series cameras not supported under Mac OS X versions 10.1.4 or earlier.

** The camera may not function as expected when connected to an IEEE 1394 hub.
†† A list of boards and cards that have been tested and approved for use with the D1, D1X, and D1H is

available on-line (  2).
***The camera may not function as expected when connected to a USB hub or keyboard.
††† Camera Control with the D100 not supported in the Macintosh version of Nikon Capture 3.

Windows Macintosh

OS

Pre-installed versions of Windows XP
Home Edition, Windows XP Professional,
Windows 2000 Professional, Windows
Millennium Edition (Me), Windows 98
Second Edition (SE)

Mac OS 9.0.4*, 9.1, 9.2, Mac OS X (ver-
sion 10.1.3† or later)

CPU/Model 300 MHz Pentium or better
iMac, iMac DV, Power Mac G3 (Blue &
White), Power Mac G4 or later, iBook,
PowerBook G3 or later

RAM
(Nikon Capture 3)

• Windows XP, Mac OS X: 128 MB (256 MB or more recommended)
• Mac OS 9: memory allocation of 32 MB or more to Nikon Capture 3 Camera

Control, 128 MB or more to Nikon Capture 3 Editor
• Other operating systems: 64 MB (128 MB with RAW images) or more recom-

mended

RAM
(Nikon View 5)

64 MB (128 MB with RAW images) or more recommended.

Video resolution
800 × 600 pixels or more with 16-bit color (High Color/thousands of colors).  24-
bit color (True Color/millions of colors) recommended.

IEEE
1394**

Open Host-Controller Interface (OHCI)
compliant IEEE 1394 interface board or
card†† required for connection to D1, D1X,
and D1H

Built-in IEEE 1394 (FireWire) interface re-
quired for connection to D1, D1X, and
D1H

Interface

USB***
Built-in USB interface required for connection to D100 and COOLPIX-series cam-
eras with USB interface.  Direct connection to other COOLPIX-series cameras not
supported.

Hard-disk space
200 MB required for installation, with additional free disk space of 10 MB plus an
amount equal to double the capacity of camera memory card available on system
disk when Nikon Capture 3 is running.

Supported
cameras

• All functions, including Camera Control: D1, D1X, D1H, and D100†††

• All functions except Camera Control: USB-equipped COOLPIX cameras

Other
• CD-ROM drive required for installation
• Internet connection required for upload to the Web; e-mail program required

when sending pictures by e-mail
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What You Need to Run Nikon Capture 3

Installation
For information on installing Nikon Capture 3, see the Nikon Capture 3 Install Guide.

Windows XP Home Edition/Professional, Windows 2000 Professional, Mac OS X

Installing Nikon Capture 3 under a multi-user operating system requires Administrator privileges.  When
installing Nikon Capture 3, log in as:

Mac OS 9.0

If you are using Mac OS 9.0, use the Software Update control panel to update to the latest version of
CarbonLib before beginning installation.

Windows XP Home Edition/Professional Computer administrator

Windows 2000 Professional Administrator

Mac OS X Administrator
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Workflow

Step 1—Transfer pictures

Camera

Memory card

Computer

• Select type of pictures to
be transferred (  21)

• Select destination (  22)

Nikon Transfer  (  13)

Card reader
or

PC card slot

Interface cable

Step 2—View pictures

• Select pictures
(  47)

• View pictures
(  112)

Nikon Browser (  41)Nikon Viewer (  107)

Step 3—Edit pictures

• Modify pictures (  134)
• Save modified pictures (  168)
• Print pictures (  172)

Nikon Capture 3 Editor (  121)

Workflow
Using Nikon Capture 3

How you will use Nikon Capture’s various components depends on whether you are taking
photographs in the field or in a studio with a D1, D1X, D1H, or D100 connected to a computer.
Regardless of where you take your photographs, Nikon Capture 3’s batch option can be used
to process multiple images automatically.

Workflow 1: Field Photography
This workflow is for users of D100, D1-series, or COOLPIX cameras taking photographs in the
field, away from their computers.

Step 4—Use pictures

• Print selected pictures (  71)
• Send pictures by e-mail (  80)
• Upload pictures to web (  84)

Nikon Browser (  41)
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Using Nikon Capture 3

Step 5—Edit pictures

• Modify pictures (  134)
• Save modified pictures (  168)

Nikon Capture 3 Editor (  121)

Step 4—View pictures

• Select pictures (
59)

• View pictures
(  112)

Nikon Browser (  41)Nikon Viewer (  107)

Step 3—Take pictures

• Adjust settings in Camera
Control (  204)

• Time lapse photography (
201)

• Photos saved directly to disk
(  194)

• Take pictures directly
using controls on
camera body

• Take pictures from
Camera Control

Nikon Capture 3 Camera Control (  187)

Step 2—Start Nikon Capture 3 Camera Control

Nikon Capture 3 Camera Control (  187)

Step 1—Connect the camera

• If Nikon Transfer
starts, click Close
to exit

Computer

Interface cable

D1-series or
D100 camera

Workflow 2: Studio Photography
This workflow is for users of D100 or D1-series cameras who want to capture photographs
directly to their computer as they are taken.
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Workflow

Step 4—Process pictures

• Process pictures (  175)

Batch dialog (  173)

Step 3—Adjust settings

• Modify pictures (  134)
• Save settings (  167)

Nikon Capture 3 Editor
(  121)

Step 2—Select pictures

• Select pictures (  47)
Nikon Browser (  41)

Step 1—Transfer pictures

• Select pictures to be
transferred (  21)

• Select destination and file
name (  22)

Camera

Memory card

Computer

Card reader
or

PC card slot

Interface cable

Nikon Transfer (  13)

Workflow 3: Batch Processing (Existing Images)
Nikon Capture 3 includes a batch option for automatic processing of multiple images, either
as they are captured from a D100 or D1-series camera (see Workflow 4), or after they have
been saved to disk using Nikon Transfer or Nikon Capture 3 Camera Control.  To process
images after they have been saved to disk:
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Using Nikon Capture 3

Step 6—Take pictures

Nikon Capture 3 Camera Control (  187)

Step 1—Connect the camera

• If Nikon Transfer
starts, click Close
to exit

Computer

Interface cable

D1-series or
D100 camera

Step 2—Start Nikon Capture 3 Camera Control

Nikon Capture 3 Camera Control (  187)

Step 3—Take a test shot

Step 4—Adjust settings

Nikon Capture 3 Editor (  121)

• Modify picture (  134)
• Save settings (  167)

Step 5—Choose batch options

• Adjust settings

Live Batch dialog (  197)

Nikon Capture 3  Camera Control (  187)

Workflow 4: Batch Processing (Studio Photography)
To process photographs automatically as they are captured from the camera (“live batch”):
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Nikon Transfer is used to transfer (copy) pictures from the cam-
era memory card to your computer.  When transferring pic-
tures, Nikon Transfer allows you to select the type of images
to be transferred, choose transfer options, specify the desti-
nation folder for transferred images, and choose how trans-
ferred images will be named on the computer.

This chapter is divided into the following two sections:

The Nikon Transfer Window
This section outlines the controls and displays in the Nikon
Transfer window, and describes how to start, exit, and restart
Nikon Transfer.

Transferring Images
Read this section for instructions on transferring images from
a camera memory card to a folder of your choice on your
computer.

Copying Pictures to Your Computer

Nikon Transfer
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The Nikon Transfer Window

The Nikon Transfer Window
Getting to Know Nikon Transfer

The main parts of the Nikon Transfer window are identified below.

Image transfer rule
Specifies the type of pictures that will be
transferred from the memory card cur-
rently inserted in the camera, card reader,
or PC card slot (  21).

After transfer is completed
Shows the action that will be performed
after transfer, as specified in the General
tab of the Transfer options dialog (  31).

File destination and naming
The destination folder and file naming
method for transferred images are dis-
played in this area.  To change the desti-
nation and file naming options, click
Change... (  22).

The Menu Bar (Macintosh)

The Macintosh version has a menu bar containing commands that replicate the functions of the buttons
in the Nikon Transfer window.  No menus are available in the Windows version.

Transfer to the computer all pictures of the type
selected in the Image transfer rule menu.

View help.

Specify the information that will be added to
pictures as they are transferred.

Specify the actions to be performed when pic-
tures are transferred.

Function

Close the Nikon Transfer window.

Transfer

Help

Add additional information
(IPTC field) to images

Transfer options

Name

Close

Button

38

—

36

30

16
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Getting to Know Nikon Transfer

Starting Nikon Transfer
Nikon Transfer starts automatically when a supported camera is connected or a memory card
from a supported camera is inserted in a card reader or PC card slot.

1 Connect the camera or insert the memory card
Connect a camera containing a memory card from a supported camera is connected, or
insert a memory card from a supported camera in a card reader or PC card slot.  For
information, see the Nikon Capture 3 Install Guide.

2 Nikon Transfer will start automatically

Auto Launch

Nikon Transfer will only start automatically if Auto launch when connected to a camera or a card (the
default option) is selected in the "Auto Launch" tab of the Nikon Browser or Nikon Viewer Preferences
dialog (  96).

Starting Nikon Transfer from Nikon Browser or Nikon Viewer

Nikon Transfer can also be started by selecting Launch Image Transfer… from the Tools menu in Nikon
Browser.

Starting Nikon Transfer on a Macintosh

When Nikon Transfer is started by connecting a camera or inserting a memory card in a card reader or PC
card slot, Nikon Browser will also start automatically.

The Removable Disk Dialog (Windows XP)

When a camera is connected to a computer running
Windows XP, or a memory card is inserted in a card reader
or card slot connected to a computer running Windows
XP, a Removable Disk dialog may be displayed.  Select
Copy to a folder on my computer using Nikon View
5 and click OK to display the Nikon Transfer window.
For more information on the Removable Disk dialog, see
the Nikon Capture 3 Install Guide.
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The Nikon Transfer Window

Exiting Nikon Transfer
The Nikon Transfer window will close automatically when transfer is complete, and the Nikon
Browser window will be displayed.  To close the Nikon Transfer window without transferring
pictures:

1 Click the  button or click the close box
Click the  button in the Nikon Transfer window, or click the close box in the title bar
at the top of the window.

2 The Nikon Browser window will be displayed
Closing the Nikon Transfer window starts Nikon Browser (Windows) or activates the Nikon
Browser window (Macintosh).

Close button

Close box

Mac OS X

Mac OS 9

Quitting Nikon Transfer (Macintosh)

In Mac OS X, you can quit Nikon View 5 by selecting Quit Nikon View 5 from the application menu.  In
Mac OS 9, select Quit from the File menu.
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Getting to Know Nikon Transfer

Disconnecting the Camera

For information on disconnecting the camera, see the Nikon Guide to Digital Photography or User's Manual
provided with your camera.

Warnings

If you perform the following actions when Nikon Transfer is running, a warning will be displayed.  Click
OK to exit Nikon Transfer.

The following warning will be displayed if you disconnect the camera or card reader or turn the camera off
while Nikon Transfer is running:

The following warning will be displayed if you remove the memory card from the card reader or card slot
while Nikon Transfer is running:

FotoStation Easy (European Customers Only)

In the European release of Nikon View 5, FotoStation
Easy will start automatically, when transfer is com-
plete, or you click the  button in the Nikon
Transfer window.  FotoStation Easy is an image da-
tabase application, designed for use with Nikon
View 5 and your Nikon digital camera.  It includes a
useful editing program for resizing, cropping, and
enhancing pictures, and a handy search feature that
allows you to locate image files either by name or
using text labels added to pictures with the Nikon
Transfer IPTC information option.  Images can be
kept in pre-named folders created by FotoStation
Easy, ensuring that you never loose a picture.  You
can also share pictures at the touch of a button
through Nikon FotoShare, Nikon’s free on-line photo
community for customers in some European coun-
tries  (  84).

FotoStation Easy can also be used to organize pictures by folder, file name and text label.  Images can be
selected in FotoStation and then dragged to a conveniently titled folder such as Hobby, Friends and Family
or Work. FotoStation Easy has simple to use tools for making images look better as well as cutting them
down in size and saving them to a Nikon on-line photo album on the Internet.
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The Nikon Transfer Window

Restarting Nikon Transfer
How you can restart Nikon Transfer after exiting depends on whether the camera is still con-
nected and powered on and/or the memory card still inserted in the camera, card reader, or PC
card slot.

If the camera is still connected and/or the memory card in place:

1 Start Nikon Browser (  41)

2 Select Launch Image Transfer… from the Tools menu
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Getting to Know Nikon Transfer

If the camera has been turned off:
Turn the camera on.

If the camera has been disconnected:
Reconnect the camera and turn the camera on.

If the memory card has been removed from the camera:
Reinsert the memory card and turn the camera on.

If the memory card has been removed from the card reader or PC card slot:
Reinsert the memory card.

Nikon Transfer will start automatically.
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Transferring Images

Transferring Images
Using Nikon Transfer

This section describes how Nikon Transfer can be used to transfer pictures to your computer
from a memory card inserted in a camera, card reader, or PC card slot.

Specify the actions to be performed when pictures are transferred

 21

Specify the destination folder and choose how pictures will be named

 27

Choose image transfer options

 30

Choose what file information will be added to pictures

 35

Transfer pictures

 38
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Using Nikon Transfer

1 Choose the type of pictures to be transferred
Select the type of pictures to be transferred from the Image transfer rule menu.

The following rules are available:

Cameras with a Transfer Button

If your camera is equipped with a transfer button, you can use this button to transfer pictures to your
computer.  See the documentation provided with your camera for details.

Transfer Marking

Pictures can be marked for transfer using the camera transfer button or the Transfer or Auto Transfer
options in the camera menus.  Some cameras do not support transfer marking; see the documentation
provided with your camera for details.

* Hidden images will only be transferred if the Copy all images marked as “hidden” option
is checked in the Transfer tab of the Transfer Options dialog (  30).  If the camera is
connected using PTP, all images will be transferred, regardless of whether Copy all images
marked as “hidden” is selected.

Option

All Images

Images marked for
transfer

Images marked for
protection

Images unmarked for
protection

Description

All pictures are transferred.*

Only pictures marked for transfer using the camera transfer
marking function are transferred.

Only protected pictures are transferred.

Only pictures that have not been protected are transferred.
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Transferring Images

Hot Folders

If a hot folder is specified in the Specify a hot folder field of the Transfer Options Database tab (  34),
the hot folder will appear in the File destination text box and you will be not be able to choose a new
destination folder.

File destination
This text box lists the current destination for transferred pictures.  The default folder at
installation is:

Windows
…\My Documents\My Pictures
(If the My Documents folder does not contain a My Pictures folder, pictures will be
transferred to My Documents.)

Mac OS 9
Documents

Mac OS X
Pictures

2 Choose a destination folder and file naming method
Before transferring pictures, you can select the destination folder on your computer hard
drive and choose how the transferred files will be named on your computer.

"File destination and naming" area
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Using Nikon Transfer

File naming
Two options are available: "Original file name" and "Automatically generated name."  If
the former is displayed, the images transferred to your computer will have the name origi-
nally assigned to them by the camera.  If the latter is displayed, images will be assigned a
new file name automatically generated by Nikon Transfer according to rules you specify.

To choose a new destination or change how files are named after transfer, click the
Change… button.

The File Destination and Naming dialog will be displayed.

Files with the Same Name

If you attempt to transfer pictures with the same names as files already present in the destination folder,
the new files will be renamed by adding numbers sequentially before the period that separates the file
name and the extension.

Any changes made in the File Destination and Naming dialog will be reflected in the "File
destination and naming" area of the Nikon Transfer window.

Change… button



24

Transferring Images

Copy folder names from camera
This check box is enabled when Create a new sub-folder for each transfer is
checked.  Checking this option to transfer pictures using the folder hierarchy and
folder names (e.g., "100ND100") used on the camera memory card.

Folder
The "Folder" area of the File Destination and Naming dialog lists the folder in which
pictures will be stored after transfer.

Transfer destination
This text box lists the current destination folder.  To select a different folder, click
Browse… and navigate to the desired folder.  If you are using database software
with a hot folder, "Database hot folder" will appear in the Transfer text box.

Create a new sub-folder for each transfer
Check this option to store images in a new sub-folder with each transfer.  The sub-
folder will be created under the folder listed in the "Transfer" text box and named as
shown in the "Example" field.  Click Change… to change how sub-folders are named.

"Folder" area
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Sub Folder Naming
Clicking Change… in the Folder area displays the “Sub Folder Naming” dialog.

Prefix
Specify the characters you want to append to the beginning of the folder name.

Suffix
Specify the characters you want to append to the end of the folder name.

Folder names consist of a prefix, identifier, and suffix, where the identifier is a unique
number, date, or date and time, depending on the option selected in the Unique
naming key between pre and suffix menu.

Prefix Identifier Suffix

Panorama Assist/Ultra HS

If you are using a Nikon camera equipped with a "Panorama Assist" scene mode or a "Continuous"
setting of "Ultra HS," be sure to check Copy folder names from camera before transferring pictures to
ensure that each sequence of pictures taken at these settings will be transferred a separate folder on the
computer.  These folders will be appear as sub-folders in the Nikon Browser thumbnail list (Windows) or
folder tree (Macintosh).

MacintoshWindows

Other
pictures

Panorama
Assist

Ultra HS
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Unique naming key between pre and suffix
Use this pull-down menu to select the identifier portion of the folder name.  Choose
from Use sequential number, Use current date, or Use current date & time.
The options in the “Sub-Folder Naming” dialog depend on the identifier selected.

When you select Use sequential number, names will be assigned to folders in as-
cending order beginning with the starting number and number of digits you specify.

When you select Use current date, the folder name will include the date of transfer.

When you select Use current date & time, the folder name will include the date
and time of transfer.

The date and time is of the form YYYY-MM-DD-HH-MM-SS-NN, where YYYY de-
notes the year, MM the month, DD the day of the month, HH the hour, MM the
minute, SS the second, and NN the serial number added if the selected folder name
already exists.  The characters that will separate the year, month, and day and hour,
minute, and second can be entered in the Year, month, day separator and Hour,
minute, second separator text boxes.
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Choosing a File Name
You can choose how files will be named in the “File naming” area of the File Destination
and Naming dialog box.

File Naming Conventions

Windows: In environments that do not support long file names, the maximum length is eight characters;
file names may not contain spaces, quotes, or any of the following characters: “\” “/” “:” “,” “;” “*” “<“
“>” and “|”.

Where long file names are supported, the maximum length is 255 characters, file names may not contain
quotes or any of the following characters: “\” “/” “:” “,” “;” “*” “<“ “>” and “|”.

Macintosh: The maximum length for Macintosh file names is thirty-one characters.  Colons (“:”) are not
allowed.

"File naming" area

Original file name
Select this option to save transferred images using the file names originally assigned
by the camera when the pictures were taken.

Change
Select this option to save the transferred files under an automatically generated file
name.
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Extensions

Transferred files are automatically assigned an extension based on file type:

File type Extension

Photograph (JPEG) .JPG

Photograph (TIFF) .TIF

Photograph (RAW) .NEF

Movie .MOV

Sound (voice memo) .WAV

File Naming
Clicking Change… in the File Naming area displays the “File Naming” dialog.

Prefix
Select Original file name to append the file name assigned in the camera to the
beginning of the transferred file name.  Select Other to append characters of
your choice to the beginning of the file name.

Suffix
Specify the characters you want to append to the end of the folder name.

File names consist of a prefix, identifier, and suffix, where the identifier is a unique
number, date, or date and time, depending on the option selected in the Unique
naming key between pre and suffix menu.

Prefix Identifier Suffix
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Unique naming key between pre and suffix
Use this pull-down menu to select the identifier portion of the file name.  Choose
from Use sequential number, Use current date, or Use current date & time.
The options in the “File Naming” dialog depend on the identifier selected.

When you select Use sequential number, names will be assigned to files in ascend-
ing order beginning with the starting number and number of digits you specify.

When you select Use current date, the file name will include the date of transfer.

When you select Use current date & time, the file name will include the date and
time of transfer.

The date and time is of the form YYYY-MM-DD-HH-MM-SS-NN, where YYYY de-
notes the year, MM the month, DD the day of the month, HH the hour, MM the
minute, SS the second, and NN the serial number added if the selected file name
already exists.  The characters that will separate the year, month, and day and hour,
minute, and second can be entered in the Year, month, day separator and Hour,
minute, second separator text boxes.
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3 Choose image transfer options
Clicking the Transfer Options button in the Nikon Transfer window displays the Transfer
Options dialog.

The Transfer Options dialog contains the following tabs:

After changing transfer options, click OK to save changes and return to the Nikon Trans-
fer window.  Click Cancel to cancel any changes to settings and return to the Nikon
Transfer window.

Transfer options button

Database

Creator
(Macintosh version only)

Transfer

General

Tab

Choose a database program to catalog transferred files.

Choose the applications that will be associated with trans-
ferred photographs, movies, and sound files.

Specify what actions will be performed during transfer.

Specify the actions that will be performed once transfer is
complete.

Description

34

33

32

31
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The General Tab
This tab allows you to choose what you want the computer to do after transferring image
files.

Start Nikon Browser
Select this option to start Nikon Browser after the image files are transferred.  Selecting
this option enables the Upload all images to NikonNet check box.

Upload all images to NikonNet (North, South, and Central America only)
Check this box to upload all the transferred image files to NikonNet, a free on-line photo
album service available to customers resident in the United States of America (  85).
This option is not available outside the Americas.

Launch third-party image database program
Select this option to launch the image database program specified in the Database tab
(  34) and catalog the transferred files.

Do nothing
Select this option if you want Nikon View 5 to do nothing after the transfer of the image
files is complete.  On a Macintosh, the thumbnail display in Nikon Browser will not be
updated when the images are transferred to your computer.
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The Transfer Tab
This tab allows you to adjust settings for the images about to be transferred.  Note that
there are some differences between the Windows and Macintosh versions of this tab.

Delete original files after transfer is completed
Check this box to delete the image files from the memory card after they are transferred
to your computer.  Protected image files and image files that are not transferred are not
deleted.  If this box is not checked, the original files on the camera memory card will be
left untouched after transfer.

Add thumbnail icon (Macintosh only)
Check this option to add thumbnail icons to the transferred image files.

Copy all images marked as “hidden” (Windows only)
Check this option to transfer all the image files that are marked as “hidden.”  Hidden files
are not transferred if the box is not checked.

Add additional information (IPTC field) to all files
Check this box to add the file information set in the IPTC Information dialog box (  36)
to the transferred image files.  Selecting this option enables the Copy Shooting data
(Shutter speed etc.…) to the IPTC caption field check box.

Copy Shooting data (Shutter speed etc.…) to the IPTC caption field
Check this box to copy shooting data to the caption field of images as they are trans-
ferred.

Windows

Macintosh
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The Creator Tab (Macintosh Only)
This tab (available only in the Macintosh version) allows you to specify the programs that
will be associated with transferred files.  Double-clicking a file after transfer will open it in
the associated program.

Still image (Exif format)
Lists the application associated with “.JPG” and “.TIF” image files.  .

Still image (NEF format)
Lists the application associated with RAW (“.NEF”) image files.

Movie
Lists the application associated with “.MOV” movie files.

Sound
Lists the application associated with ".WAV" sound files.

Use the Change… buttons to specify application associated with each format .
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The Database Tab
This tab allows you to specify the database program for managing the transferred image
files.

If “Launch Third-Party Database Program” Is Not Selected

If Launch third-party database program is not selected in the General tab, the Database tab is disabled.

Supported Image Database Applications

Support is provided for the following image database applications:
• Cumulus 5.0 (Canto Software): images registered in catalog
• FotoStation 4.0 (Fotoware): images registered in folder
• iView MediaPro 1.0.4 (iView Multimedia): images registered in catalog

Select a third-party database application
Click Change… and select the image database application you wish to use.  Be sure that
the application selected is supported under Nikon View 5.

Specify database catalog file
Set this field if the selected image database program catalogs images in a file (e.g., .Cu-
mulus 5.0 or iViewMediaPro 1.0).  Click Change… to select an existing catalog file, or
click New to create a new catalog file.

Specify a hot folder
Set this field if the selected image database program stores image in folders.  Click
Change… to select a hot folder to which image files will be copied.  The folder name you
specify here is automatically reflected in the File Destination and Naming dialog (  22).
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To switch from the simple to the detail view, click the Detail… button.  Click Simple… to
switch back.

The IPTC Information dialog offers simple and detail views.

4 Add file information
Clicking the  (File Information) button displays the IPTC Information dialog, where you
can specify additional file information, such as captions and keywords, that can be added
to images as they are transferred.  This information can be viewed in Nikon Browser after
transfer (  41).

File Information button

Detail view

Simple view
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IPTC Information (Simple View)

Caption
The caption entered in this text box will be added to photographs if the Add additional
information (IPTC field) to all files option is checked in the Transfer tab of the Transfer
options dialog (  30) when the pictures are transferred.

Keywords
Keywords entered in this area can be added to photographs if the Add additional infor-
mation (IPTC field) to all files option is checked in the Transfer tab of the Transfer
options dialog (  30) when the pictures are transferred.  To add keywords to the list in
the Recorded Keywords text box, click Add.  Up to twenty keywords can be recorded.

Adding File Information

The information in the IPTC Information dialog will be added to photographs if the Add additional
information (IPTC field) to all files option is checked in the Transfer tab of the Transfer options dialog
(  30) when the pictures are transferred.  IPTC information will not be added to movie files.

To save IPTC information in a separate file, click Save….  Previously saved information can
be loaded by clicking Load….
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IPTC Information (Detail View)

Caption
Enter a caption in this text box as described on the pre-
ceding page.  You can also add information in the Writ-
ten by, Headline, and Special Instructions fields.

Keywords
Enter keywords as described on the preceding page.

Category
Choose a category and urgency level.  Categories can be
created in the same manner as keywords.

Credit
Enter information for By-line, By-line title, Credit,
Source, and Copyright.

Locations
Enter information for City, State/Province, Country, Object Name, Date Created, and
Original Transmission.
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During Transfer

You cannot perform any other operation in Nikon View 5 while the progress dialog is displayed.

5 Transfer image files
Click the Transfer button to start transfer at the selected settings.

A progress dialog is displayed during transfer, showing a thumbnail preview of the file
currently being transferred.  Thumbnails will not be displayed if the Show thumbnail
box is not checked.

Transfer button
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Cancelling Transfer
To cancel transfer of the image files, click Cancel or press Escape.  When you are transfer-
ring multiple image files, the images that have already been transferred at the time trans-
fer is cancelled are saved in the destination folder.

After Transfer
When transfer is completed, Nikon View will perform the action specified in the General
tab (  31) of the Transfer options.  By default, transferred images will be displayed in
Nikon Browser.
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Nikon Browser is used to browse thumbnail images of the
pictures and folders that have been transferred to your com-
puter.  You can also use the browser view photo information,
rotate images, or display pictures automated slide shows.

This chapter is divided into the following sections:

The Nikon Browser Window
This section outlines the controls and displays in the Nikon
Browser window, and describes how to start and exit Nikon
Browser.

Using Nikon Browser
This section details how Nikon Browser can be used to browse
files after transfer, to manage files by moving them into differ-
ent folders and organizing folders into favorites, to view and
print images, and how to distribute images by e-mail or up-
load them to the Web.

Nikon Browser Preferences
Read this section for information on fine-tuning settings for
Nikon Browser and Nikon Viewer.

Browsing Pictures after Transfer

Nikon Browser
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The Nikon Browser Window
Getting to Know Nikon Browser

The main parts of the Nikon Browser window are identified below.

Menu Commands and Tool Buttons

Although the majority of operations can be performed using both menu commands and the buttons in
the toolbar, the explanations in this manual give priority to operations performed using tool buttons.

Folder tree
Shows your current position in the
hierarchy of volumes and folders
(  47).

Shooting data area
Displays photo information for pic-
ture currently selected in the
thumbnail list (  59).

Thumbnail list
The images in the current folder
are displayed as small thumbnail
images.  (  52).

Title bar
Displays the name of the current
folder.

Status bar
Displays such information as the
number of pictures in the current
folder and the number of items
selected in the thumbnail list.

Menu bar
Contains commands for a variety
of browser operations.

Toolbar
Contains the buttons listed in the
table opposite.
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The names and functions of the buttons in the Nikon Browser window are shown in the
following table:

Button Name

Back

Forward

Up One Level

Favorites

Transfer
Destination

View

Edit

Print

Rotation

Slideshow

E-mail

Thumbnail slider

48

48

48

50

48

63

67

71

58

76

80

54

Function

Return to the folder that was displayed immediately
before you selected the current folder.

Return to the folder displayed immediately before you
clicked the Back button.

Takes you up one level in the folder hierarchy.

Add the current folder to your list of favorites or se-
lect a folder from the your favorites.

Display a list of the ten most recent destination fold-
ers for images transferred from memory cards using
Nikon Transfer or captured using Nikon Capture 3
Camera Control.  Choosing a folder from the list se-
lects it in the folder tree area.

View the pictures currently selected in the thumbnail
list.

Open the pictures currently selected in the thumb-
nail list in the application selected for editing.

Print all still images in the current selection.

Rotate all still images in the current selection.

View the images in the current selection in an auto-
mated slideshow.

Append the selected images to an e-mail message.

Adjust the display size of thumbnails.

Publish to
NikonNet or PDA

85

Upload all images in the current selection to the Web
(residents of the USA only) or a Pocket PC or Palm
hand-held device.  This button is only available in the
version of Nikon View released in the Americas.

Help –View help.



44

The Nikon Browser Window

Starting Nikon Browser
Nikon Browser can be started from the Start menu (Windows) or by double-clicking the Nikon
View application icon.

Windows

1 Turn the computer on
Turn the computer on and wait for the operating system to start up.

2 Start Nikon Browser
Select Nikon View from the Start menu (Windows XP)
or  Start > Programs > Nikon View 5 > Nikon View 5
(other Windows versions).

Starting Nikon Browser from Nikon Transfer

Nikon Browser will be displayed automatically when the Nikon Transfer window closes after transfer.

Starting Nikon Browser from Nikon Capture 3 Editor

Nikon Browser can also be started by selecting Show current folder in Nikon View from the Tools
menu in Nikon Capture 3 Editor.

Nikon Browser will start.
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Macintosh

1 Turn the computer on

2 Double-click the Nikon View 5 icon
Open the folder to which you installed Nikon View 5 and double-click the Nikon View 5

 icon.

Serial Number

If prompted to supply a serial number when starting Nikon View 5, Nikon Capture 3 Editor, or Nikon
Capture 3 Camera Control, enter the serial number for Nikon Capture 3.

Other Ways of Starting Nikon Browser

Nikon Browser can be started by double-clicking the Nikon View 5 icon  in the folder to which you
installed Nikon View 5 (Windows, Mac OS 9).  If Nikon View 5 was added to the Dock during installation,
Mac OS X users will be able to start Nikon Browser by clicking the Nikon View 5 icon  in the Dock.
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Exiting Nikon Capture 3 Browser
To exit Nikon Browser, open the File menu and select Exit (Windows) or Quit (Mac OS 9).  In Mac
OS X, select Quit Nikon View 5  from the application menu.

Windows

Mac OS X

Mac OS 9
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Keyboard Shortcuts

In Windows, you can select folders with the following keyboard shortcuts:
• HOME Selects the Desktop icon displayed at the root of the folder tree.
• END Selects the folder or drive displayed at the bottom of the folder tree area.
• BACKSPACE Selects the folder one level higher than the current folder in the folder tree.

Using Nikon Browser
Browser Window Operations

Working with Folders
When you select a folder from the folder tree area, the thumbnails of image files in the folder
are displayed in the thumbnail list area.

You can close the folder tree area by clicking the Close button in the upper right corner.  To
display the folder tree area again, select View Folders from the View menu.

Folder tree area

Close Button
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You can go back to the previous folder by clicking the Back button in the toolbar.  You can also
select from up to 10 previous folders by clicking the drop-down arrow on the right.

Use the Forward button to go back to where you were when you clicked the Back button.  You
can also select from up to 10 folders by clicking the drop-down arrow on the right.

Click the Up One Level button to select a folder one level higher than the current folder in the
folder hierarchy.

Click the Transfer Destination button to view a list of 10 most recent destination folders for
image files that were transferred using Nikon Transfer.  When you select a folder from the list,
the folder will be selected in the folder tree area.

 Opening Folders in the Explorer or the Finder

In Windows, you can open a folder in Explorer by selecting a folder and choosing Open with Explorer
from the Folder menu.  In Macintosh, you can open a folder in Finder by selecting a folder and choosing
Open in Finder from the Folder menu.

Choosing a Folder
The folder tree area displays drives and folders in your computer as a tree from the desktop
down.  In the folder tree area, you can only select one folder at a time.

Up One Level button

Forward button

Back button

Transfer Destination button
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Moving Files between Folders
You can move image files by dragging and dropping thumbnails from the thumbnail list area
to a folder in the folder tree area.

Creating and Deleting Folders

You cannot create or delete folders in the folder tree area.  If a folder is created in a program other than
Nikon View 5, the display of the folder tree area is refreshed when Nikon View 5 is notified by the system
that a new folder was created (Windows), or when the user selects Refresh from the View menu
(Macintosh).

Deleting Folders (Windows)

To delete a folder, select the folder one level higher than the folder you want to delete.  The folder you
want to delete will be displayed in the thumbnail list area.  Select the folder, then choose Delete from the
File menu.

Drag and drop

To

Move a file to another
location on the same drive

Copy a file to another
location on the same drive

Move a file to another drive

Copy a file to another drive

Windows

Use drag and drop

Press the CTRL key while
dragging the file

Press the SHIFT key while
dragging the file

Use drag and drop

Windows

Use drag and drop

Press the option key while
dragging the file

—

Use drag and drop
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The “Add to Favorites” Dialog
To add a folder to Favorites, use the folder tree area to select the desired folder, then click the
Favorites button on the toolbar.  You can also select Favorites > Add to Favorites from the
Folder menu.  The Add to Favorites dialog will be displayed.

Name
Displays the name of the folder to be added to favorites.

Folder location
Displays the location of the folder to be added to favorites.  If you want to specify a different
folder, click Browse….  The name of the new folder will be displayed automatically under
“Name.“  Click OK to add the selected folder to your list of favorites.

Adding Folders to Favorites
In Nikon Browser, you can add folders containing transferred images to Favorites.  Folders to
be added to Favorites can be selected using either the Favorites tool button or the Favorites
option in the Folder menu.  Up to 30 folders can be listed in Favorites.
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The “Organize Favorites” Dialog
To organize folders within Favorites,
click the Favorites button in the
toolbar, or select Favorites > Orga-
nize Favorites from the Folder
menu.  The Organize Favorites dia-
log will be displayed.

List Favorites
The folders that have been added to Favorites are displayed in the list.

Move up / Move down
Click to move the selected folder in up or down in the Favorites list.  The folders in the Folder >
Favorites sub-menu will be displayed in the specified order.

Add
Click to display the Add to Favorites dialog, where you can add folders to your Favorites.

Change
Click to display the Change Favorites dia-
log, where you can change the name
under which folders are listed in the Fa-
vorites list without changing the name
of the original folder.

Delete
Click to remove the selected folder from your list of favorites.  The original folder is not deleted
from your computer.
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Working with Thumbnails
The thumbnail list area displays thumbnails for all images stored in the selected folder.

To display the contents of the folder in the thumbnail list area, select the folder icon in the
thumbnail list area and click the View button on the toolbar.  The folder will be selected in the
folder tree area.

Note also that a folder icon is displayed in the thumbnail list area if the current folder contains
sub-folders (Windows version only).

Thumbnail list

Folder icon
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If this happens, check Re-create thumbnails from actual image data in the Thumbnails tab
(  97) of the Preferences dialog.  This will enable Nikon View 5 to create thumbnail data from
the original image.  The new thumbnail will be displayed in the thumbnail list area.

Thumbnail Display
Sometimes, a generic file icon is displayed instead of a thumbnail in the thumbnail list area.
This is because some image editing programs remove the thumbnail data appended to the
image file.
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Changing Thumbnail Size
The size of the thumbnails displayed in the thumbnail list can be changed using the slider in
the toolbar or by selecting the desired size using the View Size option in the View menu.

The following five sizes are available:

Slider

Thumbnail Size

Images created with certain cameras, such as the D1, include only one thumbnail 160 × 120 pixels in size.
If a larger size is selected, the existing thumbnail data will be enlarged to display at the selected size.  To
create a less ragged thumbnail, select Recreate thumbnails from actual image data in the Thumb-
nails tab of the Nikon View 5 Preferences dialog.  This is not necessary when displaying pictures created
with cameras such as the D1X, D1H, D100, E5000, and the E5700, which include larger thumbnails with
the original image.

Minimum

Small

Normal

64 × 64 pixels

96 × 96 pixels

128 × 128 pixels

Large 192 × 192 pixels

Maximum 256 × 256 pixels
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Selecting Thumbnails
Thumbnail previews of the images in the selected folder are shown in the thumbnail list area.
Click a thumbnail to select it.  To select multiple thumbnails, hold down the CTRL key (Win-
dows) or the Command key (Macintosh) while clicking on each of the thumbnails.  You can
also select multiple thumbnails by dragging the mouse.

Selecting Multiple Images

To select all images with the hidden (Windows only) or protected attributes, choose the appropriate
option from the Select sub-menu in the Edit menu.

Selected thumbnails
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You can also protect (Windows and Macintosh) or hide (Windows only) images associated
with the selected thumbnail by selecting Attribute from the File menu.  Protecting an image
prevents it from accidental deletion.  Hiding an image prevents it from being shown in Ex-
plorer.

Thumbnail Attributes
Each thumbnail displayed in the thumbnail list area has an icon that represents its attributes.
There are four types of icon: Protection, Hide (Windows version only), Movie, and Voice memo.

Icon Attribute

Protection

Hide

Movie

Voice memo

Description

Image is protected.

Image is hidden and will not be displayed in Windows Explorer..

Image is a movie.

Voice memo is attached to image.

Attribute icon



57

Browser Window Operations

Playing Voice Memos
To play a voice memo, select an image marked with the voice
memo icon, and select Play Sound from the File menu.  Un-
der Windows, the voice memo will be played back in the ap-
plication specified in the Sound tab (  104) of the Prefer-
ences dialog.

On a Macintosh, click the play button to start playback.

Windows

Macintosh

Play
button
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Rotating JPEG Images

Nikon Browser rotates and flips JPEG images without decompressing them first, and no drop in image
quality results.  We recommend that you flip or rotate JPEG images in Nikon Browser before opening them
in Nikon Capture 3 Editor or another application.  NEF and TIFF images do not degrade when rotated or
saved.

Rotating Movies

Movies cannot be rotated.  If a movie file is included among the selected thumbnails, the movie file will
not be displayed in the Rotate Image(s) dialog.

Rotating Thumbnails
In the thumbnail list area, you can rotate selected thumbnails.  The rotation applied to a
thumbnail is also reflected in the associated image file.  Use the Rotate Image(s) dialog to
rotate thumbnails.  To display the Rotate Image(s) dialog, click the Rotate button on the toolbar,
or select Rotate from the Image menu.

In the Rotate Image(s) dialog, click CCW 90º to rotate the thumbnail 90 degrees counterclock-
wise or CW 90º to rotate 90 degrees clockwise.  Click the same button twice if you want to
rotate the thumbnail 180 degrees.  You can check the results in the preview area.

When One Thumbnail Is Selected
Click Apply to rotate both the thumbnail and the associated image file and then close the
dialog.

When Multiple Thumbnails Are Selected
Click Apply to rotate both the thumbnail and the associated image file and then display the
next thumbnail.   To display the next thumbnail without rotating the current thumbnail, click
Next.  Click Apply to all to apply the orientation of the current thumbnail to all the selected
thumbnails and the associated image files.  Rotation is not applied to the hidden files and files
that have already been rotated.
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Displaying Shooting Data
When you select a single thumbnail, shooting data is displayed in the Shooting Data area.  No
shooting data is displayed if no thumbnails are selected or if multiple thumbnails are selected.

 You can show or hide the shooting data by selecting View Shooting Data from the View
menu.  You can also expand or collapse the Shooting Data area by clicking the toggle button
(a small triangle) in the upper left corner.

Shooting Data

Depending on the application and the file format used, shooting data may be lost when pictures created
with the camera are opened and saved from a third-party imaging application.

Shooting Data area collapsed

Shooting Data area expanded

Toggle button

The information displayed includes the following items.  The information available varies ac-
cording to the model of camera.

Camera Name / Date and Time / Image Quality /
Image Size / Color / Converter Lens / Lens / Focal Length /
Exposure Mode / Metering Mode / Shutter Speed, Aperture /
Exposure Compensation / Sensitivity / White Balance /
AF Mode / Tone Compensation / Flash Sync Mode /
Flash Mode / Dimmer Compensation Offset /
Electronic Zoom Scale / Saturation Control / Color Mode /
Hue Adjustment / Image Sharpening /
Noise Reduction / Image Comment /
Latitude (GPS) / Longitude (GPS) / Altitude (GPS)
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Adding Shooting Data to Images

Shooting data is added to the image file during transfer when Copy Shooting data (Shutter speed
etc.…) to the IPTC caption field is checked in the Transfer tab of the Transfer options dialog (  30).

Viewing File Information
In Nikon Browser, you can use the IPTC Information dialog to view the file information added
to an image file during transfer.

Displaying the IPTC Information Dialog
To open the IPTC Information dialog, select a thumbnail in the thumbnail list area and select
IPTC Information (Windows) or File Information (Macintosh) from the File menu.

Shooting data added to the image file during transfer are displayed in the lower part of the
Caption area in the IPTC Information dialog.

Simple mode
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For more information on the IPTC Information dialog, see “Step 4: Add file information” in
“Nikon Transfer” (  35).

File Information from Nikon Browser

IPTC information displayed in Nikon Browser cannot be edited.  Note that file information is not attached
to movies.

You can view the IPTC Information dialog in Simple or Detail mode.

Click the Simple…/Detail… button to toggle between Simple and Detail modes.
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Deleted Image Files

Deleted image files are moved to the Recycle Bin (Windows) or the Trash (Macintosh).  To cancel the
deletion, open the Recycle Bin or the Trash and return the deleted files to their original location.  In
Windows, if you delete image files from a memory card inserted in the camera, card slot, or card reader, or
from a network folder, the image files are permanently erased and cannot be recovered.

If a folder thumbnail is displayed in the thumbnail list area, the above operation will delete the
folder and all its contents (Windows version only).

If there are any protected images among the images selected for deletion, the dialog shown
below will appear.  Click Yes to proceed with deletion.

Deleting Image Files
To delete image files in Nikon Browser, select the associated
thumbnails in the thumbnail list area and select Delete from
the File menu.  You can attain the same results by pressing
the DELETE key (Windows) or COMMAND + DELETE keys
(Macintosh).

A confirmation dialog will be displayed.  Click Yes to proceed with deletion.
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Other Ways to View Images

You can also open an image in Nikon Viewer by:
• selecting its thumbnail, and clicking the View button on the toolbar or selecting View from the File

menu.
• selecting its thumbnail and pressing the ENTER key (Windows) or the RETURN key (Macintosh).

Displaying Images
When you select a thumbnail in the thumbnail list area, still images are displayed in Nikon
Viewer while movie files are played back in the program selected in the Movie Tab of the
Preferences dialog (   101).

Viewing Still Images
To view a still image, double click its thumbnail in the thumbnail list area.  Nikon Viewer will
open with the image displayed.

Toolbar

Status bar
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In Windows, even if you open only one thumbnail in the thumbnail list area, you can browse
through all the still images stored in the same folder as the selected image by using the For-
ward and Back buttons.

Image Editing Programs

To edit a still image, select its thumbnail and click the Edit button on the toolbar or select Edit from the
File menu.  This will launch the image editing program selected in the “Still image” tab (  99) of the
Preferences dialog.

Displaying Images in Nikon Viewer
Images opened in Nikon Viewer can only be displayed one at a time.  If multiple thumbnails
are opened, only one image will be displayed.  Use the Forward and Back buttons to display
other images.

You can use the Nikon Viewer status bar to check the number of opened images and the
status of the currently displayed image.

You can change the displayed image using the Forward and Back buttons on the toolbar of
Nikon Viewer.

Back button

Forward button
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Installing QuickTime
In Windows, you cannot use Windows Media Player to play back movies recorded with the
COOLPIX series digital cameras.  If a movie player program is not installed, install the version of
QuickTime bundled with Nikon View 5 (COOLPIX series only).  For more information on instal-
lation, see the Install Guide.

Other Ways to Play Movies

You can also play movies back by:
• selecting its thumbnail, and clicking View button on the toolbar, or select View from the File menu.
• selecting the thumbnail and pressing the ENTER key (Windows) or the RETURN key (Macintosh).

Playing Movies Back
To play back a movie, double click its thumbnail in the thumbnail list area.  The application
specified in the Movie tab (  101) of the Preferences dialog launches and plays back the
movie.
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Playing Sound Files
Selecting Play Sound from the File menu when a voice memo
is selected in the thumbnail area opens the selected memo for
audio playback.  In the Windows version of Nikon Capture 3,
the application used for audio playback can be selected in the
Sound tab of the Preferences dialog (  104).  If Use Nikon
View is selected, playback will begin automatically.

In the Macintosh version, playback is controlled using the but-
tons in the window shown below.

Windows

On a Macintosh, click the play button to start playback.

Macintosh

Play
button
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Editing Image Files
Select a thumbnail, then click the  button in the toolbar, or select Edit from the File menu
to display the selected image in the editing program specified in the Preferences dialog.

The editing programs listed are those selected in the Still Image (  99) and Movie tabs (
127) of the Preferences dialog .  If Nikon Capture 3 Editor is selected as the editor for still
images, Nikon Capture 3 Editor will start (  124).  If you have not yet specified or registered
an image editing program, the Add/Remove Editing Program dialog will appear automatically.
To open the dialog on subsequent occasions, see the instructions on the next page.

Registering Image Editing Programs
The Add/Remove Editing Program dialog is used to register (and also to remove) the image
editing programs of your choice.  Click Add to register an image editing program.  Registering
additional editing programs allows you to use an editing application other than the program
specified in the Preferences dialog.  Open registered editing programs using the Edit button
pull down menu, or by selecting Edit using other program from in the File menu.

Edit button
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Displaying the Add/Remove Editing Program Dialog
The Edit button pull down menu (displayed by clicking the triangle to the right of the 
button) and the Edit using other program option can also be used to display the Add/
Remove Editing Program dialog.
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The “Add/Remove Editing Program” Dialog

Program list
The registered programs are displayed in the list.

Move up / Move down
Click to move the program selected in the program list up and down.   This changes the order
in which programs displayed when the Edit tool button is clicked or Edit using other pro-
grams selected from the File menu.

Add
Click to display the Add Program dialog, where you can select and register programs.

Change
Click to display the Change Program dialog, where you can change the name of the registered
programs.

Delete
Click to remove the selected program from the program list.  Note that the program itself is
not deleted.
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In the Change Program dialog, you can change the name of the program that appears in
the Edit tool button pull down menu, and in the Edit using other programs sub-menu.
This does not affect the name of the original program.

The “Add Program” Dialog

Name
You can assign a name to the program selected in “executable file” text box.  The pro-
gram is added to the program list with this name instead of the actual program name.

Executable file
Displays the path and file name of the program that will be added.  To add a different
program to the program list, click Browse… and select the program you want to add.
Click OK to add the selected program to the program list.

The “Change Program” Dialog
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Printing Images
In Nikon Browser, you can print a still image by selecting the thumbnail displayed in the thumbnail
list area.  Use the Print Layout dialog to print a still image.  To display the Print Layout dialog,
select the thumbnail of the image you want to print in the thumbnail list area, then click the

 button on the toolbar, or select Print from the File menu.  You can also print multiple still
images at one time.

When you have made all the necessary settings, click Print to start printing.  Clicking Cancel
closes the Print Layout dialog without printing.
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Print preview
Check this option to display a preview of how the images will print on the currently selected
printer.

Copies (Windows only)
Choose the number of copies that will be printed.  You can print anywhere from 1 to 100
copies.

In the Macintosh version, the number of copies is not displayed in the Print Layout dialog.  To
specify the number of copies, click Print.  A confirmation dialog will be displayed; click Yes to
proceed with printing and specify the number of copies.

Page Setup…
Click to display a Printer Settings dialog in which you can modify the printer and paper set-
tings.  If you are using a Macintosh, the appearance of this dialog depends on the printer in
use.  The changes made are reflected in the “Printer,” “Paper,”  and “Printable area” fields.

The Print Layout Dialog

Printer / Paper / Printable area
These text boxes display current printer settings.  To change printer settings, click the Page
Setup… button (see below).

Printer

Paper

Printable area

Displays the currently selected printer.

Displays the current paper size.

Displays the maximum dimensions of the area that can be printed per
sheet at current printer and paper size settings.



73

Browser Window Operations

• File Name
• Camera Name
• Exposure

 Compensation

You can specify whether or not to print photo information (shooting data) with the im-
age.  You can also opt to print a page consisting solely of photo information by selecting
Image information list from the pull-down menu.  The size of the images are automati-
cally adjusted according to the layout.  The following information is printed when you
select one of the with image info options or Image information list:

Page Layout
Choose from Select layout and Select picture size.

Select layout
When this option is selected, you can choose the number of images that will be printed
from a drop-down menu.

PortraitOption

Page orientation

Landscape

One image printed in center of page1 Up One image printed in center of page

Two pictures printed
one above the other

2 Up Two pictures printed side-by-side

Four pictures printed in two rows of
two columns each

4 Up
Four pictures printed in two rows of

two columns each

Eight pictures printed in four rows of
two columns each

8 Up
Eight pictures printed in two rows of

four columns each

Sixteen pictures printed in four rows of
four columns each

16 Up
Sixteen pictures printed in four rows of

four columns each

Twenty-five pictures printed in five
rows of five columns each

25 Up
Twenty-five pictures printed in five

rows of five columns each

• Image Size (printed only
when with image info
is selected)

• Shutter Speed
/ Aperture

• White Balance
• Date
• Manufacturer
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You can also choose whether to rotate the images and choose how many copies of the
image will be printed per page.

Rotate image(s) to fit
Check this option to automatically rotate each image so as to minimize the unused space
inside each image frame.

Print a picture multiple times
To print an image the desired number of  times, check this option and select a number
from between two and ten from the pull down menu.

Borderless print (Windows) / Eliminate white border (Macintosh)
Check this option to adjust the image size so that it fits exactly inside the red border,
without leaving any white space.  If the aspect ratio of the box and the image differ, part
of the image may not be printed.

Use thumbnail data
Check this option to print thumbnail images.

Select picture size
When this option is selected, you can choose print size from a drop-down list.
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Speed
Dragging the slider towards Speed reduces printing time, but also reduces the quality of
the printed image.

Quality
Dragging the slider towards Quality increases printing time, but also increases the qual-
ity of the printed image.

Normal Print / Save [Print Image] as file
Select whether to print images on a printer, or to save the page as a image.

Normal Print
Outputs the selected images to a printer.

Save [Print Image] as file (Windows) / Save image files (Macintosh)
Saves the page as a JPEG image using the layout specified in the Page Layout dialog.
When this option is selected, the Print button in the Page Layout dialog will change to
Save.  Clicking the Save button displays the Save Image(s) dialog, where you can choose
a destination folder and file name and select an Image Quality (JPEG compression) from
Maximum, High, Medium or Low.

Printing quality
Use the slider to adjust the balance between speed and quality.
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You can show or hide the Slideshow Properties dialog by pressing the TAB key.

The slideshow window is displayed with the Slideshow Properties dialog displayed in front of
the slides.  You can change the slideshow settings using this Slideshow Properties dialog.

When a Single Thumbnail Is Selected

In Windows, if you select only one thumbnail in the thumbnail list area, all the images in the same folder
are played back in the slideshow.  In Mac OS, only the selected images are played back in the slideshow.

Slideshow

Slideshow technology licensed from iView Multimedia Ltd (c) 2002.

Slideshows
In Nikon Browser, you can view the image files associated with the selected thumbnails as a
slideshow.

Displaying the Slideshow Properties Dialog
To view a slideshow, select the thumbnails of the image files you want to view in the thumb-
nail list area, then click the Slideshow button on the tool bar or select Slideshow from the
Tools menu.

Slideshow button
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The Slideshow Properties Dialog

The Files Tab
Displays a list of file names (and in Windows, file
paths) of the image files that are currently dis-
played in the slideshow.

The Options Tab
This tab controls how slides are displayed.

Play Movies to end
Check this option to play movies to the end be-
fore showing the next slide.  If this option is not
checked, the next slide will be shown after the
specified interval whether or not the movie has
finished.

Play Sound for all movies
Check this option to play back sound with all the
movie files included in the slideshow.

Display File Info
Check this option to display the file location, size,
and zoom ratio under each slide.

Enable margin between grid cells
If you selected a stage grid option that displays
multiple slides at the same time, checking this
option leaves margins between slides.  If this op-
tion is not checked, no margins will be displayed.

Grid style
Select the format and number of slides to display at the same time.
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Forward 
Displays the next slide.

Fade 
Use this button to select how one slide fades into or out of another.

Resize 
Use this button to select the zoom ratio of the slides.  You can also adjust the aspect ratio,
or adjust the size of the slides to fit the screen.

Mouse icon

The Toolbar
The toolbar has buttons to control the playback of the slideshow, and buttons to specify
how the slides are displayed.

Toggle 
Toggles between the slides and the options tab.

Exit 
Exits the slideshow

Play mode 
Use this button to specify how the slideshow will be played back.  Select Click to ad-
vance to switch slides interactively by clicking the mouse button, Continuous to play the
slideshow again after the last slide is displayed, or Random to play the slideshow in
random order.

Back 
Displays the previous slide.

Play / Pause 
Pauses the slideshow when playing or starts it again when paused.  When you select Click
to advance using the play mode button, the button icon takes the shape of a computer
mouse, on which you can click to display the next slide.

Forward
button Resize

button

Play mode
button

Exit
button

Play/Pause
button

Back
button

Fade
button

Toggle
button
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The Status Bar
You can control the sound volume on the status bar.  You can also check the number of
the remaining slides and the total number of slides, and specify the interval between slide
changes, in the range of 1 to 60 seconds.

Changing the Size of the Slideshow Properties Dialog
You can expand or collapse the Slideshow Properties dialog by clicking the Toggle button
on the toolbar.

Volume control Time display control

Slideshow Properties
dialog (collapsed)

Toggle button
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Sending Images by E-Mail
Images displayed in the thumbnail list area can be appended to e-mail messages.  To send
images, click the  button in the tool bar or select E-mail from the Tools menu.

Settings, including the size of the image to be e-mailed, can be adjusted in the E-mail dialog.

Using E-mail

In order to use the e-mail option in Nikon View 5, your computer must be correctly configured to send e-
mail.  Note that you may incur charges from your Internet service provider and telephone company when
you send e-mail.

Voice Memos

Voice memos attached to Exif files can not be sent by e-mail.

E-mail button
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Current e-mail program
When you click Send (see below),  your e-mail will be sent using the program shown here.

Size of image to be sent

Original size
The selected image will be e-mailed “as is,” without changing its size.

Reduce size to
When this option is selected, you can specify the size of the attached image in pixels. The
value entered applies to the longer side of the image. The shorter side of the image is then
adjusted automatically to preserve the aspect ratio. Note that the reduced size cannot be
larger than the original image.

Supported E-mail Programs

The following e-mail programs are supported:
• Windows

Outlook Express, Outlook, Eudora (Eudora is not supported under Windows XP)
• Macintosh OS 9.0, 9.1, 9.2

Outlook Express, Eudora, Entourage
• Macintosh OS X

Outlook Express, Entourage X, Mail
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Multiple image attachments
Each of the selected images will be sent as an individual attachment.

Single contact sheet
If you selected Reduce size to in the “Size of image to be sent” area, you can send all the
selected images in a single file in which the images are displayed together in a “contact
sheet.”  This option is not available when Original Size is selected.

Contact sheet size
When Single contact sheet is selected, you can choose the
size of the sheet from this menu.  The following options are
available: VGA (640 × 480), SVGA (800 × 600),  XGA
(1024 × 768),  SXGA+ (1400 × 1050), UXGA (1600 × 1200).

Attachment Preferences
Specify whether multiple images will be attached as separate files or as a single file in which
the images are displayed together in a “contact sheet.”

Background color
When Single contact sheet is selected, you can choose the background color of the
contact sheet by clicking the Choose… button to display the system color palette.



83

Browser Window Operations

If you are e-mailing images at a reduced size, or if you are e-mailing images that are not in
JPEG format, the dialog shown below will be displayed, informing you that the images you are
sending will be converted to compressed JPEG format.  Click OK to close the dialog and e-mail
your images.

Click Send to start up the application specified in the “E-mail program” field.
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Uploading Images
Customers in some areas can use Nikon View 5 to upload still images to free on-line photo
albums at Nikon-sponsored web sites.  At the time of writing, this service was available to
customers in the United States of America and some European countries.  To use this service,
American users must register with NikonNet (http://www.nikonnet.com/), European users with
Nikon FotoShare (http://www.nikonfotoshare.com/).  More information on on-line photo al-
bums and other services available through NikonNet and Nikon FotoShare is provided on these
web sites.

Nikon FotoShare (European Customers Only)
Customers in selected European countries can upload images using the Nikon FotoShare
button FotoStation Easy.  The FotoShare registration form appears automatically the first time
FotoStation is started.   You will need to supply a valid e-mail address and possibly your postal
code to register for Nikon FotoShare.  The entire process takes about five minutes, including
waiting for a secret code to unlock your FotoShare account.  If you do not want to register
when you first start FotoStation Easy, you can register at a later date by selecting Nikon
FotoShare Registration from the Links menu in FotoStation Easy.

You can also register for Nikon FotoShare by accessing the FotoShare web site at:
http://www.nikon-euro.com/nikoneuro1/fotoshare/registration.htm

For more information on uploading images, see the on-line help for FotoStation Easy or visit
the FotoShare web site for your country or region (http://www.nikonfotoshare.com/).

Transferring Images to a Palm Organizer1 (North, South, and Central America Only)

Nikon Browser can be used to transfer images to a Palm organizer if Palm Desk Top2 and Photobase for
Palm2 were already installed when you installed Nikon View 5.  To transfer images:
• Select Photo Base for Palm Sync. from the Service Choice pull-down menu in Step 3 of “Uploading

Images to NikonNet.”  After making sure that your Palm is inserted in the cradle, and the cradle is
connected correctly, click OK.

• To transfer the images,  press the Hot Sync.® button on the cradle.  Once transferred, images can be
viewed on the device’s screen.

You do not need to follow the rest of the steps in the Uploading image files section.

1 For instructions on synchronization, refer to the documentation provided with your hand-held device
2 For instructions on installing and using this application, refer to the software documentation.

Hot Sync

Hot Sync is a registered trademark of Palm Inc.
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3 Choose whether to upload images to NikonNet or a hand-held device
If a hand-held device (PDA) is connected to your computer, the Module Selection dialog
will be displayed.  If there are no hand-held devices connected to your computer, proceed
to Step 4.

Uploading Images to NikonNet (American Customers Only)

1 Select images for upload
In the thumbnail list area, select one or more image file thumbnails to upload.

2 Click 
Click the  button in the Nikon Browser toolbar, or select Publish to NikonNet or PDA
from the Tools menu.

Publish to NikonNet or PDA button

Transferring Images to a Pocket PC1 (Windows Only; Not Available Outside the Americas)

Nikon Browser can be used to transfer images to a Pocket PC if Active Sync.2 and Photobase for Pocket
PC2 were already installed when you installed Nikon View 5.  To transfer images:
• Select Photo Base for Pocket PC from the Service Choice pull-down menu in Step 3 of “Uploading

Images to NikonNet.”  After making sure that your Pocket PC is connected correctly, click OK.
• Use Microsoft Active Sync to transfer the images to your Pocket PC.  Once transferred, images can be

viewed on the device’s screen.

You do not need to follow the rest of the steps in the Uploading image files section.

1 For instructions on synchronization, refer to the documentation provided with your hand-held device
2 For instructions on installing and using this application, refer to the software documentation.

To upload images to NikonNet, select Nikon.net Uploader from the Service Choice pull-
down menu, enter your NikonNet user name and password, and click OK.  For more
information on transferring images to a hand-held device, see the notes on these pages.
Additional information on the options available in the Module Selection dialog is provided
in “The Module Selection Dialog” (  88).
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4 Choose upload options
The Upload Preview dialog will be displayed.  After adding information to the image files
or resizing the images, click OK to continue.  For more information, see “The Upload
Preview Dialog” (  90).

If the Module Selection dialog was not displayed in Step 3, the NikonNet User Information
dialog will appear prompting you to enter your NikonNet user name and password.

Publishing to NikonNet

An Internet connection is required to publish your images to NikonNet.  Note that telephone charges and
fees charged by your Internet Service Provider (ISP) may apply.  When registering for NikonNet, you must
have an address in the USA with a valid Zip code.
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5 Choose an album
In the Choose Album dialog, select the album to add the images to, or create a new
album.  For more information, see “The Choose Album Dialog” (  92).

6 Click OK
The images will be uploaded to the selected album.

RAW (NEF) and TIFF Images

RAW (NEF) and TIFF images are converted to JPEG before upload.
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Click OK to close this dialog and upload the selected images.  Click Cancel to exit without
uploading the selected images.

Uploader Dialogs (North, South, and Central America Only)
This section describes options available in the dialogs displayed when you upload images to
NikonNet using the Upload to NikonNet or PDA option in Nikon Browser.  This option is avail-
able only in the Americas.

The Module Selection Dialog
This dialog is where you choose whether to upload images to NikonNet or to a hand-held
device.  This dialog is not displayed if a hand-held device is not currently connected to
your computer.
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Service Choice
Choose Nikon.net Uploader to upload images to an on-line photo album on NikonNet
(this service is restricted to customers in the USA).  If you have installed Palm Desk Top and
Photobase for Palm, you can also choose Photo Base for Palm Sync. to upload images
to your Palm organizer (  84).  If Active Sync. and Photobase for Pocket PC are installed
on your computer, you can upload images to a Pocket PC using the Photo Base for
Pocket PC option (  85).

User Name
If you selected Nikon.net Uploader from the Service Choice menu, enter your NikonNet
user name in this text box.

Don't show this dialog again
Check this option to skip the Module Selection dialog the next time you upload images.
To display the dialog again, click Clear in the Publish to NikonNet or PDA tab of the
Preferences dialog (  106).

Password
If you selected Nikon.net Uploader from the Service Choice menu, enter your NikonNet
password in this text box.

Remember Password
If this option is checked, your password will automatically be entered for you the next
time the Module Selection dialog is displayed.

New Member?
Click to display the NikonNet user registration page in your Web browser.  If you are not
yet a member, click this button to register.

Forgot Password?
Click to display the NikonNet password assistance page in your Web browser.  If you
forget your password, click this button and supply the necessary information.
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When multiple images are selected for upload, you can use the buttons under the pre-
view to display additional images.  Click OK to close this dialog and upload the selected
images at the specified settings.  Click Cancel to exit without uploading the selected
images.

The Upload Preview Dialog
In the Upload Preview dialog, you can resize the images uploaded to the album and add
a caption, keywords, and description.
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Caption
Enter a caption for the image currently displayed in the preview area.  The caption will
appear in the on-line album.

Keyword
Enter keywords for the image currently displayed in the preview area.  The keywords will
appear in the My Pictures section.

Description
Enter a description for the image currently displayed in the preview area.  The description
will appear in the on-line album.

Image size for upload
Images will be uploaded to the on-line album at the size specified.  You cannot select a
size larger than the original size.  When uploading multiple images, you can specify the
upload size separately for each image or apply the selected size to all images using the
Apply Size To All button.

Don't show this dialog again
Check this option to skip the Upload Preview dialog the next time you upload images.  To
display the dialog again, click Clear in the Publish to NikonNet or PDA tab of the Prefer-
ences dialog (  106).
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Click OK to close this dialog and upload the selected images to the album selected under
Current Albums.  Click Cancel to exit without uploading the selected images.

Current Albums
Select the destination album from the drop-down menu.  The selected images will be
uploaded to this album when you click OK.

New Album Information
To create a new album, enter a name and descrip-
tion for the album in the Name and Description
text boxes and click Create.  The new album will
be added to the list of current albums.

The Choose Album Dialog
In the Choose Album dialog, you can select the on-line photo album to which images will
be uploaded, or create a new album for the uploaded files.



93

Browser Window Operations

Don't show this dialog again
Check this option to skip the Choose Album dialog the next
time you upload images.  When this option is selected, you
must choose whether images will be automatically uploaded
to the last album selected in the Current Albums menu or to
a new album created automatically when the images are up-
loaded.  To display the Choose Album dialog again, click Clear
in the Publish to NikonNet or PDA tab of the Preferences
dialog (  106).

Always upload to last album
Select this option to always upload the files to the most
recently used album.

Always create new album
Select this option to create a new album every time you upload the image files.
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Nikon Browser Preferences
Fine-Tuning Nikon Browser

Displaying the Preferences Dialog
To view the Preferences dialog, select Preferences… from the Edit menu (Windows or Mac
OS 9) or application (Mac OS X) menu.

The Preferences dialog contains the following seven tabs:

After making changes to preferences, click OK to save changes and return to the Nikon Browser
window.  Click Cancel to cancel any changes to settings and return to the Nikon Browser
window.

Viewing Preferences

To view settings in any of the seven panes, click the appropriate tab.

Windows/Mac OS 9

Mac OS X

Tab

General
(Macintosh only)

Auto Launch

Thumbnails

Still image

Movie

Sound
(Windows only)

Publish to NikonNet or PDA
(Americas only)

Tab

Choose the volume used for temporary storage.

Choose whether Nikon Transfer starts automatically when
a memory card from a supported camera is detected.

Choose whether to create thumbnails from the original
image data.

Choose the applications that will be used to play back or
edit still images.

Choose the applications that will be used to play back or
edit movies.

Choose the application that will be used to play back voice
memos.

Options for uploading images.

Description

95
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97

99

101

104

106
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The General Tab (Macintosh Only)

Virtual Memory Disk
Choose the volume used for storage of temporary data, including as image cache data, from
the pull-down menu.  The default volume for temporary storage is the System volume.

The General Tab

Changes to settings in the General tab also apply to Nikon Capture 3 Editor and Nikon Capture 3 Camera
Control.  Nikon View 5 must be restarted before changes to settings will take effect.
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The Disable Auto Launch Option in Windows XP

In Windows XP, the Disable auto launch option is effective only with the D1/D1X/D1H and COOLPIX990/
880 cameras.  When other cameras are connected, the Disable auto launch option is ignored and Nikon
Transfer launches automatically.

Auto launch when connected to a camera or a card
Select this option to launch Nikon View 5 automatically when you turn the camera on and
connect it to your computer or when you insert the memory card into the card reader or card
slot.  When Nikon View 5 launches, the Nikon Transfer window will open.

Disable auto launch
Select this option if you do not want Nikon Transfer to launch automatically when a camera is
connected or a memory card is inserted.

The Auto Launch Tab
The options in the Auto Launch tab controls whether Nikon Transfer will launch automatically.



97

Fine-Tuning Nikon Browser

The Thumbnails Tab
The Thumbnails tab contains options that determine how the thumbnails displayed in the
Nikon Browser thumbnail list area are created.

Windows

Macintosh



98

Nikon Browser Preferences

Create
Re-create thumbnails from actual image data
Check this option to create a high-resolution thumbnail from an image file and display the
thumbnail in the Nikon Browser thumbnail list.  Note that this will increase the amount of time
needed to display thumbnails.

If this option is not selected,  there will be some cases when the operating system's generic file
icons appear in the thumbnail list area, instead of actual thumbnails.  If generic file icons are
displayed, click the check box to create thumbnails.

Cache
On
If this option is checked, thumbnails that have already been displayed in Nikon Browser will be
re-created from the cache data, decreasing the amount of time needed to display thumbnails.

Cache folder
The cache folder field specifies the location to which cache files will be saved.  To change the
location, click Change….

Maximum cache size slider
Use the slider to set the maximum size of the cache file.  The maximum size can be set in the
range of 10 MB to 100MB, at 10 MB intervals.  If you reduce the maximum cache size, the
current cache data will be deleted (Windows only).

Delete
Click this button to delete all cached thumbnails.  The original images associated with the
thumbnails will not be affected.

Cache Settings

Changes to cache settings will not take effect until Nikon Browser is restarted.
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The Still Image Tab
The “Still image” is used to choose the default program for editing still images.  The specified
program will launch when you select Edit from the File menu in Nikon Browser or Nikon
Viewer.
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Photo Editing Program
Use the default photo editing program selected by your Operating System
Select this option to edit images in the default image editing program for your operating
system.

Use the following program
Select this option to edit images in the image editing program of your choice.  To choose a
program, click Change… and select the program from the Select Program dialog.

The name of the selected application is displayed under Use the following program.

Windows Macintosh

RAW data display mode
Select how NEF image files will be displayed.  You can choose from High speed and High
quality.

High quality
Choose this option to maximize image quality when images are viewed in close up.  The time
taken to display images will increase.

High speed
Choose this option to reduce the time that it takes to display RAW images.  Note that image
resolution will decrease, and images may appear grainy when zoomed in.



101

Fine-Tuning Nikon Browser

The Movie Tab
The Movie tab is used to select the applications used to view and edit movies.
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Movie Player Program
Use the default movie player selected by your Operating System
Select this option to view movies in the default movie player for your operating system.

Use the following program
Select this option to view movies in the application of your choice.  To choose a program, click
Change… and select the program from the Select Program dialog.

The name of the selected application is displayed under Use the following program.

Windows Macintosh
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Movie Editing Program
Same as movie player program
Select this option to edit movies using the program selected in the Movie Player Program area.

Use the following program
Select this option to edit movies in the application of your choice.  To choose a program, click
Change… and select the program from the Select Program dialog.

Windows Macintosh

The name of the selected application is displayed under Use the following program.
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The Sound Tab (Windows Only)
Use the Sound tab to choose the application that will be used to play back voice memos when
image files containing a voice memo are selected in Nikon Browser.
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Playback program
Use Nikon View
Voice memos will be played back in Nikon View.

Use the default playback program selected by your Operating System
Select this option to play voice memos in the default audio player for your operating system.

Use the following program
Select this option to play voice memos in the application of your choice.  To choose a program,
click Change… and select the program from the Select Program dialog.

The name of the selected application is displayed under Use the following program.
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Clear
Click to clear the Don't show this dialog again check boxes in the Module Selection, Nikon
User Information, Upload Preview, and Choose Album dialogs.

The Publish to NikonNet or PDA Tab (Americas Only)
The Publish to NikonNet tab is used to display the Module Selection, Nikon User Information,
Upload Preview, and Choose Album dialogs after choosing Don’t show this dialog again
during upload to NikonNet.  This panel is displayed only in version of Nikon View 5 released to
North, South, and Central America.
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Nikon Viewer is used to view still pictures selected in Nikon
Browser.  Pictures can be zoomed in or out and scrolled, al-
lowing you to take a closer look at specific parts of the image.

This chapter is divided into the following sections:

The Nikon Viewer Window
This section outlines the controls and displays in the Nikon
Viewer window, and describes how to start and exit Nikon
Viewer.

Using Nikon Viewer
This section details how Nikon Viewer can be used to view
images.

Nikon Viewer Preferences
Read this section for an overview of the Nikon Viewer Prefer-
ences dialog.  Details can be found in “Nikon Browser: Prefer-
ences” (  94).

Viewing Pictures

Nikon Viewer
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The Nikon Viewer Window
Getting to Know Nikon Viewer

The main parts of the Nikon Viewer window are identified below.

 Menu Commands and Tool Buttons

Although many operations can be performed using both menu commands and the buttons in the toolbar,
the explanations in this manual give priority to operations performed using tool buttons.

Title Bar
Lists the name of the cur-
rently image and the zoom
ratio at which it is displayed.

Shooting data area
Displays photo information
for current image (  117).

Toolbar
Contains buttons for per-
forming various operations
(see opposite).

Status bar
Lists such information as the num-
ber of pictures currently open in
Nikon Viewer, the position of the
current image among them, and
the file size of the current image.

Menu bar
Contains menu commands
for the various operations
that can be performed in
Nikon Viewer.

View area
The image is displayed
in this area.
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The names and functions of the buttons in the Nikon Viewer window are shown in the follow-
ing table:

Button Name Function

Fit Image to
Window

113
Displays the current image at a zoom ratio that al-
lows the entire image to be viewed.

Zoom In 113Zooms in on the current image.

Zoom Out 113Zooms out from the current image.

Zoom Cursor 114
The cursor takes the shape of a magnifying glass, al-
lowing you to zoom the current image in or out using
the mouse.

Hand Tool 114
The cursor takes the shape of a hand, allowing you
to scroll the current image using the mouse.

Edit 115
Opens the current image in the designated image
editing program.

Print 115Prints the current image

Slideshow 116
The images currently opened in Nikon Viewer are dis-
played in an automated slideshow.

E-mail 116Append the current image to an e-mail message.

Publish to
NikonNet or PDA

116

Upload all images in the current selection to the Web
(residents of the USA only) or a Pocket PC or Palm
hand-held device.  This button is only available in the
version of Nikon View released in the Americas.

Help –View help.

Previous Image
Selected

112
If the current image is not the first or only image
currently opened in Nikon Viewer, clicking this but-
ton will displays the previous image.

Next Image
Selected

112
If the current image is not the last or only image cur-
rently opened in Nikon Viewer, clicking this button
will displays the next image.
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Starting Nikon Viewer
Nikon Viewer is started from Nikon Browser.

1 Select images
Select the still images you wish to view from the thumbnail list in Nikon Browser.

2 Click 
Click the  (View) button or select View from the File menu.  Nikon Viewer will start
and the selected images will be displayed.

Other Ways of Starting Nikon Viewer

• Double-clicking selected thumbnails in Nikon Browser
• Selecting images in Nikon Browser and pressing the Enter (Windows) or return (Macintosh) key.
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Exiting Nikon Viewer
To exit Nikon Viewer, open the File menu and select Exit (Windows) or Quit (Mac OS 9).  In Mac
OS X, select Quit Nikon View 5  from the application menu.

Windows

Mac OS X

Mac OS 9



112

Using Nikon Viewer

Use the Forward and Back buttons on the toolbar to view the other images when more than
one image is selected.  The order of display is the same as the order of display in the thumbnail
list area of Nikon Browser.

When a Single Thumbnail Is Selected

In Windows, even if you open only one thumbnail in the thumbnail list area, you can browse through all
the still images stored in the same folder as the selected image.

Using Nikon Viewer
Taking a Closer Look

To display a still image in the view area of Nikon Viewer, double-click the associated thumbnail
(Nikon Viewer can not be used to view movies).  Only one image can be displayed at a time.
You can zoom in to and out from images displayed in the viewer.

Nikon Viewer displays only one image at a time.  Use the Back and Forward buttons to view
the other images.   The status bar shows the number of the images currently opened in Nikon
Viewer and the status of the image displayed in the view area.

Image area

Next Image Select button

Previous Image Select button

Status bar
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Viewing the Entire Image
You can make the entire image fit to the display area by clicking the Fit Image to Window
button or selecting View entire image from the View menu.

Zooming Images in and Out
You can zoom into or out of the image that is displayed in the view area.  To zoom in and out,
use the tools described below.  The zoom ratio of the displayed image is displayed in the
window title bar.

The Zoom In / Zoom Out Buttons
Click the Zoom In button to zoom into the image.  Click Zoom Out to zoom out of the image.
You can perform the same operations by selecting Zoom In or Zoom Out from the View
menu.

Fit Image to Window

Zoom ratio

Zoom Out button

Zoom In button
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Grab cursor and Zoom cursor

The Hand and Zoom cursors can not be used at the same time.

Zoom Cursor Button
To select the zoom cursor, click the Zoom Cursor button.  The mouse pointer will change to a
magnifying glass with a “+” sign in its center.

Position the zoom cursor over the current image and click the mouse to zoom in one step.  To
zoom out one step, hold down Alt (Windows) or option (Macintosh).  A “–” sign will appear
in the center of the zoom cursor; click the mouse to zoom out one step.  The image be
centered on the point you clicked.

Scrolling the Image
If the entire image is not visible at the current zoom ratio, you can use the grab cursor to view
other areas of the image.

Click the Grab Cursor button on the toolbar, or select Hand Tool from the View menu.  The
mouse pointer will change to a hand.  To scroll the image, drag the mouse in the direction you
want to go.  You can also scroll the image using the scroll bars below and to the right of the
image area.
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Editing Image Files
You can open and edit the image displayed in the view area with the program specified in the
Still Image (  99) and Movie tabs (  101) of the Preferences dialog.  To open the image in
the specified program, click the Edit button in the toolbar.  If Nikon Capture 3 Editor is selected
as the editor for still images, Nikon Capture 3 Editor will start (  124).

For more information on the Add/Remove Editing Program dialog, see  “The Add/Remove
Editing Program Dialog”  (  68).

Printing Images
You can print the image currently displayed in the view area.  Use the Print Layout dialog to
print the image.  To display the Print Layout dialog, click the Print button on the toolbar, or
select Print from the File menu.  For more information on printing, see “Printing Images” (
71).

Edit button

If you register a program using the Add/Remove editing program dialog, you can also edit the
image with a program other than the one specified in the Preferences dialog.  To display the
Add/Remove editing program dialog, click the drop-down arrow on the Edit tool button and
select Add/Remove editing program from the menu.
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If a Single Image Is Open

In Windows, if the currently displayed image is the only image opened, all the image files in the same
folder as the one displayed are played back as a slideshow.

Viewing a Slideshow
You can view the images opened in the view area as a slideshow.  To view a slideshow, click the
Slideshow button in the toolbar, or select Slideshow from the Tools menu.

Slideshow button

For more information on publishing to the Web, see “Uploading Images” (  84) in “Nikon
Browser.”

For more information on publishing to the Web, see “Sending Messages by E-Mail” (  80) in
“Nikon Browser.”

Uploading Images (Amercias Only)
You can upload the image displayed in the view area to the on-line album at the Nikon Net site
(American residents only).  To upload the image, click the Publish to Nikon Net or PDA button
in the toolbar or select Publish to Nikon Net or PDA from the Tools menu.  This option is
only available in the version of Nikon View released in the Americas.

For more information on playing back a slideshow, see “Slideshows” (  76) in “Nikon Browser.”

Sending Messages by E-Mail
Images displayed in the Image Area can be sent by e-mail.  To send images, click the E-mail
button on the tool bar or select E-mail from the Tools menu.

E-mail button

Publish to Nikon Net or PDA button
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Displaying Shooting Data
Shooting data (photo information) for the current image are displayed in the shooting data
area.  You can expand or collapse the shooting data are by selecting View Shooting Data
from the View menu.  You can also expand or collapse the shooting data area by clicking the
toggle button (a small triangle) in the upper left corner.

For more information on the shooting data, see “Displaying Shooting Data” (  59) in “Nikon
Browser.”

Viewing File Information
In Nikon Viewer, you can display the file information for the image displayed in the view area.
To view the file information, select IPTC Information (Windows) or File Information
(Macintosh) from the File menu to display the IPTC Information dialog.  For more information
on file information, see “Viewing File Information” (  60) in “Nikon Browser.”

Shooting Data area collapsed

Shooting Data area expanded
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Deleted Image Files

Deleted image files are moved to the Recycle Bin (Windows) or the Trash (Macintosh).  To cancel the
deletion, open the Recycle Bin or the Trash and return the deleted files back to their original location.  In
Windows, if you delete image files from the memory card inserted in the camera, card slot, or card reader,
or from a network folder, the image files are permanently erased and cannot be recovered.

 Viewing help in Nikon View 5

The same help file is displayed whether help is selected in Nikon Transfer, Nikon Browser, Nikon Viewer or
Nikon Editor displays the same help file.

Deleting Image Files
To delete the image file displayed in the view area, select Delete from the File menu or press
the Delete key.

The deleted image file will be moved to the Recycle Bin (Windows) or the Trash (Macintosh),
and the next image in the Nikon Browser thumbnail list area will be displayed in Nikon Viewer.
If the deleted image was the last image and there are no following files, nothing will be
displayed in the view area.
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Nikon Viewer Preferences
Fine-Tuning Nikon Viewer

To view the Preferences dialog, select Preferences… from the Edit (Windows or Mac OS 9) or
application (Mac OS X) menu.  For more information on the Preferences dialog, see “Nikon
Browser Preferences” (  94).

The Preferences dialog contains the following seven tabs:

 Viewing Preferences

To view settings in any of the seven panels, click the appropriate tab.

After making changes to preferences, click OK to save changes and return to the Nikon Viewer
window.  Click Cancel to cancel any changes to settings and return to the Nikon Viewer
window.

Mac OS X

Windows/Mac OS 9

General
(Macintosh only)

Auto Launch

Thumbnails

Still image

Movie

Sound
(Windows only)

Publish to NikonNet or PDA
(Americas only)

Tab

Choose the volume used for temporary storage.

Choose whether Nikon Transfer starts automatically when
a memory card from a supported camera is detected.

Choose whether to create thumbnails from the original
image data.

Choose the applications that will be used to play back or
edit still images.

Choose the applications that will be used to play back or
edit movies.

Choose the application that will be used to play back voice
memos.

Options for uploading images.

Description

119

120

121

124

127

130

132

Windows

Macintosh

Tab
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The Nikon Capture 3 editor component contains a variety of
tools for enhancing images, including brightness, contrast,
color balance, and unsharp mask adjustment.  With RAW (NEF)
images, it can be used to adjust white balance, tone compen-
sation.  In the case of RAW (NEF) images, it can be used to
modify white balance, tone compensation, and color mode
settings from those in effect at the time the photograph was
taken.  When RAW images are saved in NEF format, image
enhancement settings are saved separately from the original
image data, allowing you to modify settings repeatedly with-
out degrading the quality of the original image.  Nikon Cap-
ture 3 Editor is also equipped with a batch option for auto-
mated processing of multiple images.

This chapter details the operations that can be performed us-
ing Nikon Capture 3 Editor.  It is divided into the following
sections:

The Editor Window
Read this section for an overview of the controls in the Nikon
Capture 3 Editor window.

Image Adjustment
Read this section for instructions on enhancing images using
Nikon Capture 3 Editor.

Nikon Capture 3 Editor Preferences
Read this section for information on fine-tuning settings in
the Nikon Capture 3 Editor window.

Image Adjustment

Nikon Capture 3 Editor
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The Editor Window
Getting to Know Nikon Capture 3 Editor

The main parts of the Nikon Capture 3 Editor window are identified below.

The Menu Bar and Quick Tools

Although many operations can be performed using both menu commands and the buttons in the Quick
Tools palette, the explanations in this manual give priority to operations performed using tool buttons.

Image window
Displays images cur-
rently opened for edit-
ing.  Any number of im-
age windows can be
open simultaneously.

Image area
Shows the image currently
being edited.

Quick Tools palette
Contains tool buttons
for Nikon Capture 3
Editor (  123).

Tool palettes
These palettes are used for
image enhancement (  134).

Application window
(Windows only)

Menu bar
Contains the menus for
Nikon Capture 3 Editor.

Title bar
Shows the file name of
the image displayed
and the current zoom
ratio.

Shooting data area
Gives photo informa-
tion on the image dis-
played.
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Quick Tools
The Quick Tools palette contains buttons that replicate commonly-used menu commands.

Button Name Function

Open 127Click to open an image file for editing.

Save 168
Save changes to the image in the active image win-
dow.

Copy Image
Adjustment

167
Copy current image-adjustment settings to the clip-
board.

Paste 167
Paste the contents of the clipboard to image enhance-
ment settings in the active window.

Zoom in 113
Zoom in on the image in the active window.  See “Us-
ing Nikon Viewer.”

Zoom out 113
Zoom out from the image in the active window.  See
“Using Nikon Viewer.”

90 degrees CCW 131
Rotate the image in active window ninety degrees
counter-clockwise.

90 degrees CW 131
Rotate the image in active window ninety degrees clock-
wise.

Selection Cursor 133
Use this tool to select the portion of the image in the
active window that will be saved.

Zoom Cursor 114
Use to zoom the image in the active window in and
out.  See “Using Nikon Viewer.”

Grab Cursor 114
Use to view portions of the image not currently visible
in the active window.  See “Using Nikon Viewer.”

Show Nikon
Browser

44Launch Nikon Browser.

Show Nikon Capture
Camera Control

190Launch Nikon Capture 3 Camera Control.

Batch 173
Open the Batch dialog, where you can select a folder
of images for batch processing.

Open in Photoshop 229Open the image in the active window in Photoshop.

Show Original
Image Data

—
Hide the effects of changes to image adjustment set-
tings.

Help
(Windows only)

—

When this button is clicked, a question mark appears
next to the mouse pointer.  Clicking on a window,
menu, or button while the question mark is displayed
will open the help file to the section that displays the
function of the item clicked.
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Starting Nikon Capture 3 Editor
Nikon Capture 3 Editor can be started by selecting Edit from the File menu when thumbnails
are selected Nikon Browser or an image is open in Nikon Viewer.  You can also start the Editor
directly by selecting Nikon Capture 3 Editor from the Start menu (Windows) or double-click-
ing the application icon (Macintosh).

Windows

1 Turn the computer on
Turn the computer on and wait for the operating system to start up.

2 Start Nikon Capture 3 Editor
Select Nikon Capture Editor from the Start menu
(Windows XP) or  Start > Programs > Nikon Capture
3 > Nikon Capture 3 Editor (other Windows versions).

Starting Image Window

In the Macintosh version of Nikon Capture 3, an empty image window is displayed when Nikon Capture
3 Editor is started by double-clicking the application icon.  In the Windows version, the application win-
dow is displayed.
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Macintosh

1 Turn the computer on
Turn the computer on and wait for the operating system to start up.

2 Start Nikon Capture 3 Editor
Double-click the Nikon Capture 3 Editor icon ( ) in the folder to which you installed
Nikon Capture 3.

No image is displayed in the image window

Serial Number

If prompted to supply a serial number when starting Nikon View 5, Nikon Capture 3 Editor, or Nikon
Capture 3 Camera Control, enter the serial number for Nikon Capture 3.

Other Ways of Starting the Editor

Nikon Capture 3 Editor can be started by double-clicking the Nikon Capture 3 icon ( ) in the folder to
which you installed Nikon Capture 3 (Windows, Mac OS 9).  If Nikon Capture 3 was registered in the Dock
during installation, Mac OS X users will be able to start Nikon Capture 3 Editor by clicking the Nikon
Capture 3 icon ( ) in the Dock.
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Exiting Nikon Capture 3 Editor
To close the Nikon Capture 3 Editor window and exit Nikon Capture 3, open the File menu
and choose Exit (Windows) or Quit (Mac OS 9).  In Mac OS X, select Quit Nikon Capture
Editor from the application menu.

Windows

Mac OS 9Mac OS X
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Opening Image Files
Nikon Capture 3 Editor can be used to open images created with supported cameras and
images previously saved using Nikon Capture 3 Editor, Nikon View 5 Editor, or Nikon Capture
version 2 or earlier.

Image files in the above formats can be opened using the Open… command or by drag and
drop.

Using the “Open...” Command

1 Click the  button or select Open… from the File menu
The standard Open dialog for your operating system will be displayed.

NEF Files (Nikon Capture 2)

NEF files created with Nikon Capture 3 can not be opened in Nikon Capture 2.

Original image/saved image File format Extension

NEF (RAW) NEF
(Nikon Electronic Image Format)

.NEF
Compressed NEF (RAW)

RGB-TIFF

TIFF (RGB) .TIF
YCbCr TIFF

16-bit TIFF (RGB)

8-bit TIFF (RGB)

FINE

JPEG .JPG

NORMAL

BASIC

JPEG (Exif-compliant)

JPEG (JFIF-compliant)

Open button
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2 Locate the file
Navigate to the drive (volume) and folder containing the file you wish to open.

3 Open the file
Double-click the file or select it from the files listed and click Open.  The selected file will
be opened in an image window in Nikon Capture 3 Editor.

Opening Images from Nikon Browser or Nikon Viewer
With one or more still images selected in Nikon Browser or an image open in Nikon Viewer,
click the Edit button in the Quick Tools palette or select Edit from the File menu.

Photo Editing Program

Following installation of Nikon Capture 3, the default photo editing program for Nikon Browser is Nikon
Capture 3 Editor.  If the photo editing program has changed, return to the Nikon Browser Preferences
dialog and select Nikon Capture 3 Editor.

Edit button

Selected images are opened in image windows
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Using Drag and Drop
In the Windows version of Nikon Capture 3 Editor, images can be opened by dragging them
into the application window.  In the Macintosh version, images can be opened by dragging
them into the empty image window displayed when Nikon Capture 3 Editor is started by double-
clicking the application icon.

Windows

Macintosh
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The Bird's Eye Palette
The Bird's Eye palette shows the position of the portion of the image visible in the active image
window.  To display or hide the Bird's Eye palette, click the triangle in the Bird's Eye palette title
bar.  By default, the Bird's Eye palette is in Tool Palette 1.

The portion of the image visible in the active image window is indicated by a red outline.

Red outline displayed

When the mouse pointer is moved over the red outline, it changes to a ( ) cursor.  Drag the
red outline over the area of the image you would like to view.   The selected area will be
displayed in the active image window.

Changing the Size of the Bird's Eye Palette

The size of the Bird's Eye palette can be adjusted by dragging the borders of the tool palette (Windows) or
by dragging the handle at its lower right corner (Macintosh).
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Rotating and Flipping Images
The image in the active image window can be rotated or flipped as described below.

Rotating Images
Click the  button or select 90 degrees CW from the Rotate sub-menu to rotate the image
in the active window ninety degrees to the right.  Click the  button or select 90 degrees
CCW from the Rotate sub-menu to rotate the image in the active window ninety degrees to
the left.

Flipping Images
Use the commands in the Flip sub-menu to flip the image in the active window horizontally or
vertically.

Rotating JPEG Images

Image files must be opened in Nikon Capture 3 Editor before being rotated.  To save the changes, the
image must then be saved to disk.  If the image is in JPEG format, it will be compressed when saved, with
a corresponding drop in image quality.  Nikon Browser, in contrast, rotates and flips JPEG images without
decompressing them first, and no drop in image quality results.  We recommend that you flip or rotate
JPEG images in Nikon Browser before opening them in Nikon Capture 3 Editor.

“90 degrees CCW” button “90 degrees CW” button

Image rotated ninety
degrees clockwise

Image before rotation
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x-y coordinates Red, Green, Blue, Average

The Information Palette
The information palette shows the position and color of the pixel under the mouse pointer.  To
display or hide the Information palette, click the triangle in the Information palette title bar.  By
default, the Information palette is in Tool Palette 1.

Preferences: Advanced Color

Clicking the icon at the right end of the Information palette tool bar displays a menu from which you can
access the Advanced Color tab of the Preferences dialog (  223).

Color space

Information Description

Color space
The working color space for the image in the active image window is dis-
played at the top of the information palette.  This information is embedded
in the file when the image is saved.

R, G, B, Avg

The values for each of the red, green, and blue elements of the pixel under
the cursor and the average of the three, weighted according to the proper-
ties of human color perception (the weighted average is calculated as
(Red × 0.299) + (Green × 0.587) + (Blue × 0.114)).  Depending on the se-
lected color space, the average may not reflect the actual luminance of the
pixel under the cursor, but it can be used as a rough guide to brightness.
Values for R, G, B, and the average of the three range from 0 to 255, with
values for twelve-bit images being scaled to fit in this range.  The number on
the left is the input value, or value for the color in the original image.  The
value in the right is the output value, or value after any changes in the Curves
or Color Adjustment windows have been applied.

x-y coordinates
The position of the cursor in the image window, measured in pixels from the
top left corner of the image.
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Selecting a Crop
Using the crop tool, you can select a portion of an image to be saved in a separate file.  If no
selection is made, the entire image will be saved.

1 Click the  button or select Selection Cursor… from the View menu
When the mouse is moved over the image area in the active window, it will change to
( ).

2 Make a selection
Drag the mouse over the image in the active window to make a selection.

Saving a Selection

Unless the image is saved in NEF format, only the selected portion of the image will be saved.  In NEF
format, the entire image is saved together with information about the location of the current crop.

Cancelling the Current Crop
To cancel the current crop and select the entire image, click outside the current crop or choose
Select Entire Image from the Image menu.  Note that you may not be able to select the
entire image when Keep my output size is selected in the Size/Resolution window.

Moving the Crop
To move the crop over a different part of the image, move the pointer over the crop.  The
pointer will change to a  (Windows) or  cursor (Macintosh).  Drag the crop to move it to
a new position.

Changing the Size of the Crop
To change the size of the current crop, move the pointer over the borders of the crop.  The
pointer will change to a double arrow.  Drag the borders of the crop to adjust its size.
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Image Adjustment
Enhancing Images

Before they will be ready for display or output on a monitor or printer, images captured from
the camera will usually need to be adjusted to a size and resolution appropriate to the task at
hand.  Other settings, such as white balance, contrast, and sharpness, may also require adjust-
ment.  These adjustments are performed using the image adjustment tool palettes.

Using the Tool Palettes
To display the default tool palettes, select Tool Palette 1 or Tool Palette 2 from the View
menu.

Displaying the Contents of a Tool Palette
To display or hide the contents of a tool palette, click the triangle to the left of the palette title.

Hiding and Applying Changes to Settings
Settings in most palettes can only be adjusted, and adjustments applied to the image in the
active window, if the Apply button for the palette is checked .  If the Apply button is crossed
out , the effects of the settings in the palette will not be visible in the image window.  To
adjust settings, check the Apply button by clicking it once.

The Size/Resolution palette does not have an Apply button.  Changes to settings in the Size/
Resolution palette are always visible in the image in the active window.

Each palette has a  button.  Click this button to display the palette sub-menu.

Hiding the Tool Palettes

To hide the tool palettes (including the Quick Tools palette), press the tab key.  Press the tab key again to
view the palettes.
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Opening a tool palette in a separate window
Tool palettes can be opened in a separate window by clicking the palette title and dragging it
outside the current window to create a new tool palette window containing only the selected
palette.

Tools can be added to the new window by dragging additional palettes into the window.  The
new window will be added to the View menu in Nikon Capture 3 Editor.  If you close the new
window by clicking the window close box, you can open it again by selecting the desired
palette from the View menu .

Changing the order of palettes
To change the order of palettes in the tool palette window, click a tool palette title bar and
drag it into a new position.

Title bar
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The settings that can be adjusted depend on the image quality setting in effect when the
photograph was recorded.  Photographs taken at an image-quality setting of RAW can be
processed to adjust white balance or to alter exposure compensation, image sharpening, tone
compensation, color mode, and hue adjustment from the settings in effect at the time the
photograph was taken.  All images can be processed to adjust, tone curves, color balance,
sharpness, and size and resolution.

Image quality PaletteProcess

RAW

White BalanceAdjust white balance. 137

Advanced RAW
Choose new settings for exposure compensation, im-
age sharpening, tone compensation, color mode, and
hue adjustment.

143

RAW
RGB-TIFF

YCbCr-TIFF
FINE

NORMAL
BASIC

Unsharp Mask

If the image lacks definition, you can sharpen out-
lines using the controls in the Unsharp Mask pal-
ette.  Unsharp mask only be applied at the last step,
after all other adjustments have been made.

159

Noise Reduction
Reduce the noise common to pictures taken with
digital cameras.  Nikon Capture supports color noise
reduction and edge noise reduction.

162

Size/Resolution
Adjust the size and resolution of the image for out-
put on a particular device.

164

Adjust tone, color balance, and contrast.  There are
two distinct tools for this task: the Curves palette,
which provides precise control over tone, and the
Color Balance palette, which features simpler con-
trols.

Color Balance 156

Curves 146
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White Balance
The tools in the White Balance palette are used to adjust white balance for RAW images.
Using these tools, not only can you correct white balance when the setting chosen with the
camera failed to produce the desired effect, you can also deliberately alter white balance to
introduce a cold or warm cast into the image.  White balance can be adjusted by specifying
the desired color temperature or by sampling the image for the gray point.

Specifying a Color Temperature

1 Select Set Color Temperature
Display the White Balance Adjustment palette and select Set Color Temperature from
the pop-up menu at the top of the palette.

White Balance

White balance can be performed on RAW images only.  If the image in the active window is JPEG or TIFF,
the Apply button in the White Balance palette will be grayed out and inactive.

2 If the Apply button is off ( ) , turn it on ( )
If the Apply button is off, the image in the active image window will reflect the white
balance settings in effect at the time the photograph is taken.

Pop-up menu

Apply button

Color
temperature

Settings menu

Slider
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3 Adjust white balance using the options in the White Balance palette

Camera WB
Shows the white balance setting in effect at the time the photograph was taken and the
amount of fine-tuning performed.

New WB
The white balance setting to be applied to the captured image can be chosen from the
options listed in the table below.  When Daylight, Standard Fluorescent, or High Color
Rendering Fluorescent is selected, white balance can be fine-tuned by selecting an
option from the sub-menu.

— —

— —

— —

— 3,000 K

Direct sunlight 5,200 K

Cloudy 6,000 K

Shade 8,000 K

Warm White 3,000 K

3700K 3,700 K

Cool White
(4100K)

4,100 K

5000K 5,000 K

Daylight
(6500K)

6,500 K

— 5,400 K

Sub-menu
option

Color
temperature

Use Gray
Point

Recorded
Value

Calculate
Automatically

Incandescent

Daylight

Standard
Fluorescent

 High Color
 Rendering
 Fluorescent

Flash

Option

White balance is set to the value chosen in
the gray-point selection dialog (  140).

White balance is set to the value recorded
when the picture was taken.

White balance is adjusted automatically
based on the white balance of the original
image.

Suited to photos taken under incandescent
lighting.

Suited to photos taken in direct sunlight.

Suited to photos taken under overcast skies.

Suited to photos taken in the shade on sunny
days.

Suited to fluorescent lighting, including light-
ing with a noticeable color cast.  The type of
bulb can be chosen from a sub-menu of five
options.

Suited to photos taken with Nikon Speed-
lights.

Description

Fine Adjustment
White balance can be fine-tuned using this slider.  This option is not available when Use
Gray Point or Recorded Value is selected for New WB.  White balance can be adjusted
by ±50 mired.  Note that color temperature can not be raised above 9066 K, and that a
setting of Flash can be fine-tuned in the range  of 4277 K–7479 K.
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“Calculate Automatically”

Depending on the model of camera used to take the image in the active image window, the New WB
menu may not contain an Calculate Automatically option.  Calculate Automatically may not produce
the desired results with all images; if necessary, use another white balance setting or sample the image for
gray point.

“Mired”

Any given change in color temperature produces a greater difference in color at low color temperatures
than it would at higher color temperatures.  For example, at a color temperature of 6000 K, a change of
100 K produces almost no change in color, while a change of the same amount at 3000 K would produce
a large difference in color.  Mired, calculated by multiplying the inverse of the color temperature by 10 6,
is a measure of color temperature that takes such variation into account, and as such is the unit used in
color-temperature compensation filters.

4000 K – 3000 K = 1000 K

Change in Color Temp.

7000 K – 6000 K = 1000 K

83 mired

Mired

23 mired
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Sampling the Image for Gray Point

1 Select Set Gray Point
Select Set Gray Point from the pop-up menu at the top of the White Balance palette.

2 If the Apply button is off ( ) , turn it on ( )

Sample Size

The size of the area sampled with the eyedropper cursor can be set using the Dropper sample size
option in the Advanced Color tab of the Preferences dialog.

Pop-up menu

Apply
button

Reset button

Sliders

3 Sample the image to choose a reference point for white balance
You can define white balance using a single point or the average of several points.  During
sampling, the values for red (R), green (G), and blue (B) for the pixel under the cursor will
be shown in the White Balance palette.  Refer to these values when selecting the point or
points to be sampled.

Using a Single Point to Define White Balance
After selecting Use a single point, click Start.  The cursor will take the shape of an
eyedropper ( ) when moved over the image in the active window.  Click a point that you
would like to appear a neutral gray color in the final image.  The new value for white
balance will be reflected in the image in the active window.

Using the Average of Several Points to Define White Balance
After selecting Average several points, click Start.  The cursor will take the shape of an
eyedropper ( ) when moved over the image in the active window.  You can then sample
points that should be a neutral gray color in the final image.  If you select more than one
point, the average will be used to determine white balance.  After sampling all the desired
points, click Stop.  The new value for white balance will be reflected in the image in the
active window.



141

Enhancing Images

Gain for the red and blue channels will be adjusted based on the points sampled, chang-
ing the slope of the red and blue tone curves and the position of the red and blue sliders.

White balance can also be adjusted by moving the red and blue sliders or by entering a
value from 0.1 to 10 in the text boxes to their right.

Reset
Click this button to reset the red and blue curves to the default value for gain (1.0).

Red slider/Blue slider
Adjust gain by moving these sliders or entering a value from 0.1 to 10 in the text boxes to
their right.

Choosing a Value for Gain

Very large and small values for gain can result in a drop in image quality.  We recommend values between
0.25 and 4.0.

Gain

The values for red and blue gain chosen in the White Balance palette are multiples of the value set for gain
when the photograph was taken.
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The Settings Menu

The White Balance Settings menu can also be displayed by selecting
White Balance from the Settings menu.

The White Balance Settings Menu
Clicking the  icon in the White Balance palette displays the White Balance Settings menu.

DescriptionOption

Copy current white balance settings to the clipboard.Copy to Clipboard

Select this item to save current white balance settings to a
named file.  These settings can later be recalled using the
Load… option.  Choosing Save… displays a dialog where
you can choose a destination and file name for the current
white balance settings.  White balance settings are saved
with the extension “.nwb”.

Save…

Selecting this item restores the value for white balance in
effect at the time the photograph was taken.

Reset to Recorded Value

Open the Nikon Capture 3 Editor Preferences dialog to the
Advanced Color tab (  223).

Advanced Color
Preferences…

Select this item to restore white balance to settings saved
using the Save… option.  A dialog will be displayed where
you can navigate to the drive (volume) and directory con-
taining the desired settings file (only files with the extension
“.nwb” will be displayed).  The settings in the White Balance
palette will instantly revert to the saved settings.

Load…
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2 If the Apply button is off ( ) , turn it on ( )

3 Adjust Advanced RAW settings

Exp Comp
Choose a value from –2 to +2 EV using the slider or enter a value in the text box to its
right.  Choose 0 to perform no compensation.

Sharpening
Adjust the sharpness of outlines in the image according to the scene or your personal
preference.  Choose from Unchanged, None, Low, Normal, or High.  In the case of
photographs taken with the D1, Normal is equivalent to None.

Advanced RAW
The options in the Advanced RAW palette are used to alter exposure compensation, image
sharpening, tone compensation, color mode, and hue adjustment from the settings in effect
at the time the photograph was taken.

1 Display the Advanced RAW palette

Advanced RAW

Advanced RAW can be performed on RAW images only.  If the image in the active window is JPEG or TIFF,
the Apply button in the Advanced Raw palette will be grayed out and inactive.

Color Mode

Mode I is suited to portraits that will be printed or used “as is” with little or no modification.  Mode II is
adapted to the Adobe RGB color space.  This color space is capable of expressing a wider gamut of colors
than sRGB, making it the preferred choice for studio photography or images that will be modified as part
of a commercial production work flow.  Mode III is suited to nature or landscape shots that will be printed
or used “as is” with little or no modification.



144

Image Adjustment

Hue

The RGB color model used in digital photographs reproduces colors using differing amounts of red, green,
and blue light.  By mixing two colors of light, a variety of different colors can be produced.  For example,
red combined with a small amount of green light produces orange.  If red and green are mixed in equal
amounts, yellow results, while a smaller amount of red produces a yellow green.  Mixing different amounts
of red and blue light produces colors ranging from a reddish purple through purple to navy, while mixing
different amounts of green and blue light produces colors ranging from emerald to turquoise.  (Adding a
third color of light results in lighter hues; if all three mixed in equal amounts, the results range from white
through gray.)  When this progression of hues is arranged in a circle, the result is known as a color wheel.

Tone Comp
Adjust image contrast.  Choose from Unchanged, Less Contrast, Normal, More Con-
trast, or User-Defined Custom Curve.  Because the D1 does not store custom curves in
the image file, settings of User-Defined Custom Curve and Unchanged are equivalent
to Normal when selected with photographs taken with the D1.  With the D100, D1X and
D1H, selecting Unchanged restores the tone curve in effect at the time the photograph
was taken.

Color Mode
Choose a color mode for fine control over chroma, brightness, and color gamut, much as
you would choose different kinds of color film for different scenes.  Choose from Un-
changed, D1 Mode (NTSC), Mode I (sRGB), Mode II (Adobe RGB), or Mode III (sRGB).
In the case of images taken with the D1, Unchanged is equivalent to D1 Mode (NTSC).

Hue Adjustment
Adjusts hue without affecting brightness or saturation.  Hue can be adjusted in the range
–9 ° to 9 ° in seven steps of 3 °.  If red is taken as the starting color, raising hue above 0 °
(the default setting, at which hue is unchanged) would introduce a yellow cast, making
colors that would be red at a setting of 0 ° appear increasingly orange.  Lowering hue
below 0 ° would introduce a blue cast, making colors that would be red at a setting of 0 °
appear increasingly purple (in the case of the D1X and D1H, –9 ° is equivalent to a camera
hue setting of 0, 0 ° to a setting of 3, and 9 ° to a setting of 6).  To use the value for hue
adjustment in effect at the time the photograph was taken, turn the Hue Adjustment
check box off.

Saturation Compensation
This option is used to lower color saturation, principally of primary colors (red, green, and
blue).  This is a particularly effective when printing, when it can be used to adjust satu-
rated areas of the image.  Adjustments can be made in ten steps from 0 to 9 using the
slider, with higher numbers representing lower saturation, principally of primary colors.
Levels of 8 or 9 can reduce the color noise seen in photographs taken at high sensitivity
(ISO equivalency) settings.  If the original image was taken with the D100, the default
position for the slider will be the value chosen by the camera; with other cameras, the
default setting is 0.  To use the value for hue adjustment in effect at the time the photo-
graph was taken, turn the Saturation Compensation check box off.
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The Settings Menu

The Advanced RAW Settings menu can also be displayed by selecting Advanced RAW from the Settings
menu.

The Advanced RAW Settings Menu
Clicking the  button in the Advanced RAW palette displays the Advanced RAW settings
menu.

DescriptionOption

Copy current Advanced RAW settings to the clipboard.Copy to Clipboard

Select this item to save current Advanced Raw settings to a
named file.  These settings can later be recalled using the
Load… option.  Choosing Save… displays a dialog where
you can choose a destination and file name for the current
white balance settings.  Advanced Raw settings are saved
with the extension “.nar”.

Save…

Selecting this item restores the settings in effect at the time
the photograph was taken.  In the case of the D1, image
sharpening will be set to None.

Reset to Neutral

Select this item to restore Advanced Raw settings to settings
saved using the Save… option.  A dialog will be displayed
where you can navigate to the drive (volume) and directory
containing the desired settings file (only files with the exten-
sion “.nar” will be displayed).  The settings in the Advanced
Raw palette will instantly revert to the saved settings.

Load…
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Curves
Although your Nikon digital camera will reproduce colors accurately if settings have been
adjusted appropriately, it will usually be necessary to adjust contrast, tone (brightness) levels,
and color balance to make maximum use of the tone range and color gamut offered by a
particular output device, such as a printer or monitor.  Nikon Capture offers two tools for
performing these tasks: the Color Balance palette (see “Color Balance” later in this chapter)
and the Curves palette.   Of the two, the Curves palette offers the more precise control.  The
Color Balance palette is useful when, for example, you want to adjust brightness or color
balance for all pixels in the image.  The Curves palette, in contrast, allows adjustments to be
made to specific portions of the tone range, making it possible to enhance the image while
preserving detail.

Curves—an Overview

Resizing the Curves Palette

The Curves palette can be resized by dragging its borders (Windows) or by dragging the handle at the
lower right corner of the palette (Macintosh).  The curves edit display changes with the size of the palette,
allowing you to enlarge the display to a maximum of 256 × 256 pixels.  At this size, each of the 256 points
on the tone curve is represented by a separate pixel, granting maximum precision when editing curves.

The main editing tool in the Curves palette is the curve edit display, which contains a curve
showing the relationship between input (the tones in the original image) and output (how the
tones in the input will be represented in the final image).  Separate curves control the relation-
ship between input and output for the image as a whole (the “master curve”) and for each of
the red, green, and blue color components, or “channels.”  The default curve in each case is
linear, meaning that tones will be output exactly as they are input.

Apply button

Current channel

Auto contrast button

Histogram button

White-point button

Midpoint button

Black-point button

Reset the active curve

Reset all curves

Curve edit display
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When the cursor is moved over the curve edit display, the input and output values for the point
under the cursor are shown in the input/output display.  The input value represents the level of
the pixel in the original image, the output value the level of the pixel after any changes to the
curve have been applied.

Input/output display

The Curve Edit Display

Although values for input and output in the Curves palette range from zero to 255 (eight-bit precision,
familiar to users of other image editing software), the results of any changes to curves are calculated at a
precision of sixteen bits.  This allows twelve-bit RAW data to be modified without lowering the quality of
the output.

Input is plotted along the horizontal axis, with shadows (the dark areas of the image) to the
left, highlights (the bright areas of the image) to the right, and mid-tones in between.  The left
end of the axis marks the minimum possible value for colors in the selected channel (zero, or
no color), the right end the maximum value.  In the case of the master curve, the minimum
value represents areas of the input image that are a true black; the maximum value represents
areas that are a true white.  Output is plotted along the vertical axis, with the minimum
possible output value (again, zero, or no color) at the bottom and the maximum output value
at the top.
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Viewing the Histogram
The first step in adjusting tone levels and color balance in the Curves palette is to view the
histogram displayed in the background of the curve edit display.  The histogram tells you what
tones are present in the original image and in what amounts, information that you will use
when setting the black point and white point and editing curves.  The histogram takes the
form of a bar graph.  The horizontal axis gives the tone level, with shadows to the left and
highlights to the right.  The vertical axis gives the number of pixels of each tone level found in
the image, scaled to fit in the curve edit display.

Channel Selection Shortcuts

The current channel can also be selected using the following shortcuts:
• Ctrl ~ (Windows)/  ~ (Macintosh)

Master channel (RGB)
• Ctrl 2 (Windows)/  2 (Macintosh)

Green channel (RGB)

• Ctrl 1 (Windows)/  1 (Macintosh)
Red channel (RGB)

• Ctrl 3 (Windows)/  3 (Macintosh)
Blue channel (RGB)

Histogram button

By assigning the darkest tones in the image an output value of zero and the brightest tones in
the image an output value of 255, blacks will be output as blacks and whites as whites,
making the most effective use of the dynamic range of the output device.

To view the distribution of tones in the final, output image after changes to curves, click and
hold the histogram button  .

Channel Selection
You can modify tones for all colors in the image using the master curve, or select any of the
red, green, and blue curves for editing using the channel menu.  The histogram shows tone
levels for the selected channel only. When the master curve is selected, the auto-contrast
button and white-point and black-point eyedropper tools apply simultaneously to all of the
red, green, and blue curves (the master curve is unaffected).  When one of the red, green, and
blue curves is selected, these controls can be used to edit the selected curve only.
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Setting the White Point and Black Point
The endpoints of the curve are referred to as the “white point” and the “black point.”  The
black point for a given channel represents the darkest shade (minimum value) for that color,
the white point, the brightest shade (maximum value).  By default, the input and output values
for the black point are zero.  The darkest shade in the input image may however be greater
than zero, with the result that a portion of the curve is dedicated to reproducing tones not
actually present in the image.  Increasing the input value for the black point until it matches
the darkest shade in the image will steepen the curve, enhancing overall contrast without
causing a corresponding loss of detail in shadows.  Similarly, if the original image does not
actually contain shades corresponding to the maximum value, the white point can be lowered
to match the brightest shade in the image.

There are two steps to selecting a white point and black point for the final image: choosing
the white-point and black-point input levels, and selecting output levels.

White-Point and Black-Point Input Levels
Input levels for the white point and black point can be set using any of the following three
methods:
• automatic contrast adjustment
• white-point and black-point sliders
• direct sampling using the white-point and black-point eyedropper tools

Automatic Contrast Adjustment
In automatic contrast adjustment, Nikon Capture automatically selects white and black points
that exclude a certain percentage of the brightest and darkest pixels in the image, steepening
curves for enhanced contrast (the exact percentage of pixels excluded can be specified in the
Preferences dialog; see “Preferences,” below). By default, 0.5% of the brightest and darkest
pixels are excluded, producing a curve that makes optimal use of the output tone range while
preserving details in shadows and highlights.

To perform an auto contrast operation, click the auto contrast button  . The white and black
points for each of the red, green, and blue channels will be modified simultaneously and the
master curve will be displayed in the Curves palette (the master curve itself is unaffected by
this operation). Clicking the button with the Ctrl (Windows) or option (Macintosh) key held
down adjusts contrast only for the channel currently selected in the channel menu.
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White-Point and Black-Point Sliders
The white-point and black-point sliders can be used to match the white and black points to
the histogram displayed in the curve edit display.  While these sliders can be used to edit curves
for any channel, the best results are usually obtained when they are used to modify the master
curve.

To edit the white point or black point, click the corresponding slider once to activate it, then
drag it to the right or left (a value can also be entered directly in the text box underneath the
slider).  Matching the black-point slider with the lowest input value displayed in the histogram
will set the minimum output value for the selected channel to the darkest pixel actually present
in the image, steepening the curve and enhancing contrast without sacrificing detail in shad-
ows.  Similarly, matching the white-point slider with the highest input value displayed in the
histogram will set the maximum output value for the selected channel to the brightest pixel
present in the image, enhancing contrast without loss of detail in highlights.  Any changes are
applied instantly to the active image.

White-point sliderBlack-point slider
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Sampling the Image for White Point or Black Point
The white point or black point can be set by directly sampling the image, allowing you to
choose the pixels that will be used to set the maximum (white point) or minimum (black point)
output value.  This makes it possible to set the black point by matching it to a pixel in the
darkest part of the image containing detail you want to preserve, eliminating details in darker
areas that are not important to the final image.  Similarly, you can match the white point to a
pixel in the brightest area of the image containing details important to the final image.  While
direct sampling can be used with any channel, it is most effective when used with the master
curve.  When the master curve is selected, sampling will set the white or black point for red,
green, and blue curves simultaneously; the master curve itself is unaffected.

To sample the white point, click the white-point button   .  When the cursor is moved over
the active image, it will take the shape of an eyedropper.  Move the cursor over the image to
find the pixel that you want to use to set the white point, keeping an eye on pixel level display
in the Information palette to identify pixels with high input values.  With the cursor over the
target pixel, click the mouse button.  The input value for the selected pixel will be used as the
input value for the white point.  The cursor will return to its original shape, and the image will
automatically be altered to reflect the new value for white point.

To sample the image for the black point, click the black-point button  and move the eye-
dropper cursor over the image until you find the point that you want to use to set the mini-
mum input value, then click the mouse button to select the black point.

Setting the White Point or Black Point for the Current Channel

By default, sampling sets the white point or black point for all channels and displays the master channel.
To set the white point, midpoint, or black point for the current channel only, sample the image while
holding down the Ctrl key (Windows) or option key (Macintosh) on the keyboard.  Note that midpoint can
not be sampled for a single channel; regardless of the channel currently selected in the channel menu,
sampling the image for midpoint always sets the midpoint for all channels and displays the master chan-
nel.
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White-point output
slider

Black-point output
slider

White Point and Black Point Output Levels
Once you have set the input level for the black point and white point, output levels can be
altered to reflect the actual shade of the darkest and brightest pixels in the image.  If the
darkest shade in the image represents a true black, for example, the output level for the black
point can be left at zero.  If, however, darkest shade present in the image is a lighter color, the
output level for the black point can be raised to achieve more natural coloration.

The output levels for the white point and black point are set using the white-point and black-
point output sliders on the left side of the curve edit display.

To set the output level, click the slider once to activate it, then drag it up or down until you
have found the desired output level (the output level can also be set by entering a value
directly in the text box to the left of the slider).  The effects of the change will be reflected in
the active image.
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Gamma

Gamma (also written “γ”) is a fundamental property of video systems which determines the intensity of
the output signal relative to the input.  When calculating gamma, the maximum possible input intensity is
assigned a value of one, and the minimum possible intensity (no input) is assigned a value of zero.  Output
is calculated by raising input to a power that is the inverse of the gamma value (output = input (1/γ) ).  In
practical terms, raising the gamma value has the same effect as moving the midpoint slider to the left,
raising mid-tone output values and brightening the image while leaving the maximum and minimum
values untouched. Lowering the gamma value has the same effect as moving the midpoint slider to the
right, lowering mid-tone output values and darkening the image.  The default value for gamma is one,
which produces a linear curve in which input and output values are the same. Gamma can be set to any
value between 0.05 and 6.00.

The Midpoint Slider
The midpoint slider is located at the bottom of the curve edit display.

After clicking the slider once to activate it, move it to the left to increase the brightness of mid-
tones in the selected channel, or move it to the right to decrease brightness.  Alternatively, you
can enter a value for gamma directly in the text box under the slider. The effects of changes to
the midpoint can be seen in the active image.

Midpoint slider

Setting the Midpoint
The point midway between the maximum and minimum input values is known as the “mid-
point,” which represents a neutral shade corresponding to an output level of 128. The mid-
point is controlled by a midpoint slider at the bottom of the curve edit display.  Moving the
midpoint slider to the left increases the brightness of mid-tones without “washing out” high-
lights.  Moving the slider to the right darkens mid-tones without obliterating detail in shad-
ows.

The midpoint can be set using the midpoint slider or by directly sampling the image using the
midpoint eyedropper tool.
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Sampling the Image for Midpoint
The midpoint can also be set by direct sampling.  Regardless of the channel currently selected
in the channel menu, sampling simultaneously defines the midpoint for each of the red, green,
and blue channels while leaving the midpoint for the master curve unchanged.

To sample the midpoint, click the midpoint button  .  When the cursor is moved over the
active image, it will take the shape of an eyedropper.  Move the cursor over the image to find
the pixel that you want to use to set the midpoint, keeping an eye on the pixel level display in
the Information palette to identify pixels with a neutral input value (look for pixels that you
think should be a neutral gray color in the final image).  With the cursor over the target pixel,
click the mouse button.  The input value for the selected pixel will be used as the reference
value for the midpoint. The cursor will return to its original shape, and the image will auto-
matically be altered to reflect the new value for midpoint.

Editing Curves Directly
Fine adjustments can be made to brightness and contrast in specific portions of the tone range
by adding additional points to the curves for each channel.  These points can be freely ad-
justed by dragging them into new positions, changing the shape of the curve.  Steepening the
slope in a given portion of the curve will enhance contrast in that portion of the tone range.
Changing the curve so that input levels in a given portion of the tone range are mapped to
higher output levels will brighten tones in the affected tone range; similarly, changing the
curve to map input levels to lower output levels will darken tones in the affected range.

Adding New Points to the Curve
Move the cursor over the curve edit display and click once to enter curve edit mode.  Move the
cursor to the position where you would like to add a new point, then click.  A new point will
be added at this position and the curve will automatically be adjusted to pass through this
point.  The position of the point can be adjusted by dragging it to a new location within the
curve edit display. The image in the active window will automatically be adjusted to reflect
changes to the curve.

Removing Points from the Curve
Points can be removed from the curve by dragging them out of the curve window.

Resetting the Active Curve to Linear
The default linear curve for the current channel can be restored by clicking the  button in
the Curves palette.

Resetting All Curves to Linear
To reset all curves to linear, click the  button.  All curves will be reset and the RGB master
channel will be displayed in the Curve palette.
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The Settings Menu

The Curves Settings menu can also be displayed by selecting Curves
from the Settings menu.

The Curves Settings Menu
Clicking the  button in the Curves palette displays the Curves Settings menu.

DescriptionOption

Copy current Curves settings to the clipboard.Copy to Clipboard

Reset all curves to linear.Reset to Neutral

Select this item to load curves previously saved using the
Save… option (see below).  A dialog will be displayed where
you can navigate to the drive (volume) and directory con-
taining the desired settings file (only files with the extension
“.ncv” will be displayed).  The settings in the Curves palette
will instantly revert to the saved settings.

Load…

Select this item to save curves for all channels to a named
file.  These settings can later be recalled using the Load…
option.  Choosing Save… displays a dialog where you can
choose a destination and file name for the current curves.
Curves are saved with the extension “.ncv”.

Save…

Open the Nikon Capture 3 Editor Preferences dialog to the
Advanced Color tab.

Advanced Color
Preferences…
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Color Balance
The Color Balance palette offers simple controls for adjusting overall brightness, contrast, and
color balance for the entire image.  Unlike the controls in the Curves palette, however, the
Color Balance palette does not allow you to make changes that affect only a portion of the
tone range.

Adjusting Brightness, Contrast, and Color Balance

1 Display the Color Balance palette

2 If the Apply button is off ( ) , turn it on ( )

Apply button

Green

Red

Contrast

Brightness

Blue
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3 Adjust brightness, contrast, and color balance
Adjust brightness, contrast, and color balance using the options in the Color Balance
palette.

Adjusting Overall Brightness
The brightness slider adjusts brightness for the entire image.  Dragging the brightness
slider in the + direction brightens all the colors in the image, making the image as a whole
more white.  Dragging the slider in the – direction darkens all the colors in the image,
making the image as a whole darker and less distinct.  Unlike adjustments to the midpoint
in the Curves palette, this setting applies equally to shadows and highlights, producing a
flat, low-contrast image.  A value for brightness between –50 and +50 can be entered
directly in the text box to the right of the slider.

Adjusting Image Contrast
Dragging the contrast slider in the + direction heightens the difference between high-
lights and shadows in the image, increasing contrast.  Dragging the slider in the – direc-
tion decreases the difference between light and dark portions of the image, lowering
contrast.  A value for contrast between –50 and +50 can be entered in the text box to the
right of the slider.

Adjusting Color Balance
While the brightness slider adjusts brightness for the image as a whole, the three color-
balance controls allow the user to adjust brightness for each color individually.  For ex-
ample, dragging the red slider in the + direction brightens the red portions of the image,
making the image as a whole more red.  Dragging it in the – direction dims the red
elements in the image, bringing out the remaining colors.  Color balance can also be set
by entering values directly in the text boxes to the right of the sliders.
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The Settings Menu

The Color Balance Settings menu can also be displayed by selecting Color
Balance from the Settings menu.

The Color Balance Settings Menu
Clicking the  button in the Color Balance palette displays the Color Balance Settings
menu.

DescriptionOption

Copy current Color Balance settings to the clipboard.Copy to Clipboard

Resets all brightness, contrast, and color balance settings to
zero.

Reset to Neutral

Select this item to load brightness, contrast, and color bal-
ance settings previously saved using the Save… option (see
below).  A dialog will be displayed where you can navigate
to the drive (volume) and directory containing the desired
settings file (only files with the extension “.nca” will be dis-
played).  The settings in the Color Balance palette will in-
stantly revert to the saved settings.

Load…

Select this item to save brightness, contrast, and color bal-
ance settings to a named file.  These settings can later be
recalled using the Load… option.  Choosing Save… dis-
plays a dialog where you can choose a destination and file
name for the current Color Balance settings.  Color Balance
settings are saved with the extension “.nca”.

Save…
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The Warning Button

A warning button appears if the image in the active window is displayed at a zoom ratio too low to allow
the effects of Unsharp Mask to be displayed.  Click the button to view the warning.

Unsharp Mask
Using Unsharp Mask, the user can increase the sharpness of photographs by making edges
more distinct.  Unsharp Mask works by increasing the contrast of the edges in the image while
leaving other areas untouched. The amount of sharpness is determined by three factors: in-
tensity, halo width, and threshold.

Creating Unsharp Masks

1 Display the Unsharp Mask palette

2 If the Apply button is off ( ) , turn it on ( )

Apply button

Unsharp mask list

Color

Delete button

Up/down arrows
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3 Create an Unsharp Mask
Unsharp Mask can be applied to all the colors in the image or selectively to any combina-
tion of red, green, and blue channels.  Select a combination of colors from the color pop-
up menu.  The Unsharp Mask you create will be applied only to edges in the selected
colors.

4 Select values for intensity, halo width, and threshold

Intensity
The amount the contrast of edges will be increased.  Too great an intensity will degrade
your image rather than sharpening it.

Halo width
The size of the areas that will be affected.  The greater the halo width, the wider the
edges in the sharpened image will appear.  Too large a value for halo width will produce
a “halo” along edges in the image.

Threshold
The limit at which sharpening will be applied.  If the threshold is zero, sharpening will
apply to all pixels in the image. Increasing the threshold increases the amount of contrast
that must be present between pixels before Unsharp Mask will be applied, with the result
that only more distinctly contrasting edges will be affected.

5 Create additional masks
The controls in the Unsharp Mask palette allow you to select multiple combinations of
colors that can be sharpened to different degrees.  Repeat steps 1–4 to create additional
masks for different color combinations.  As new masks are created, they will be added to
the end of the Unsharp Mask list.  Masks apply in the order listed.  To change the order in
which masks apply, select a mask in the Unsharp Mask list and click the up arrow to move
it up in the list, or the down arrow to move it down.  To delete an Unsharp Mask from the
list, select it and click the delete button.

Unsharp Mask

Unsharp Mask sharpens edges without affecting color balance by making adjustments only to luminosity
(brightness). The effect is the same as performing Unsharp Mask with the Luminosity channel selected in
the Adobe Photoshop Lab color model.  If Unsharp Mask is applied to a single channel, such as red, the
values for ab (chrominance) are used to determine what points in the image are red, and Unsharp Mask-
ing applied to the Luminosity channel for those points only.  An intensity of around 20% in Nikon Capture
3 is equivalent to about 100% in Adobe Photoshop.

No sharpening will be applied if Intensity is set to zero.  Intensity must be set to at least 1% if sharpening
is to apply.



161

Enhancing Images

The Settings Menu

The Unsharp Mask Settings menu can also be displayed by selecting Unsharp
Mask from the Settings menu.

The Unsharp Mask Settings Menu
Clicking the  button in the Unsharp Mask palette displays the Unsharp Mask Settings
menu.

DescriptionOption

Copy current Unsharp Mask settings to the clipboard.Copy to Clipboard

Select this item to load Unsharp Masks previously saved us-
ing the Save… option (see below).  A dialog will be dis-
played where you can navigate to the drive (volume) and
directory containing the desired settings file (only files with
the extension “.num” will be displayed).  The settings in the
Unsharp Mask palette will instantly revert to the saved set-
tings.

Load…

Select this item to save Unsharp Mask settings to a named
file.  These settings can later be recalled using the Load…
option.  Choosing Save… displays a dialog where you can
choose a destination and file name for the current Unsharp
Mask settings.  Unsharp Mask settings are saved with the
extension “.num”.

Save…

Deletes all Unsharp Masks currently displayed in the Unsharp
Mask palette.

Reset to Neutral
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Noise Reduction
This palette can be use to mitigate the effects of noise that sometimes appears in images
taken with digital cameras.

Reducing Noise

1 Display the Noise Reduction palette

The Warning Button

A warning button appears if the image in the active window is displayed at a zoom ratio too low to allow
the effects of Noise Reduction to be displayed.  Click the button to view the warning.

2 If the Apply button is off ( ) , turn it on ( )

3 Adjust noise reduction options
To reduce color noise, select None, Low, Moderate, or High from the Color Noise
Reduction menu.  Edge noise can be reduced by checking the Edge Noise check box.
Check the results in the image in the active window and adjust settings as necessary.

Apply button

Warning button

Settings menu
button
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The Noise Reduction Settings Menu
Clicking the  button in the Noise Reduction palette displays the Noise Reduction Settings
menu.

The Settings Menu

The Noise Reduction Settings menu can also be displayed by selecting Noise
Reduction from the Settings menu.

DescriptionOption

Copy current Noise Reduction settings to the clipboard.Copy to Clipboard

Select this item to load Noise Reduction settings previously
saved using the Save… option (see below).  A dialog will be
displayed where you can navigate to the drive (volume) and
directory containing the desired settings file (only files with
the extension “.nnr” will be displayed).  The settings in the
Noise Reduction palette will instantly revert to the saved set-
tings.

Load…

Resets Noise Reduction settings to their default values.Reset to Neutral

Select this item to save Noise Reduction settings to a named
file.  These settings can later be recalled using the Load…
option.  Choosing Save… displays a dialog where you can
choose a destination and file name for the current Noise
Reduction settings.  Noise Reduction settings are saved with
the extension “.nnr”.

Save…
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Output Size and Resolution
The Size/Resolution palette is where you specify the final (“output”) size of the portion of the
image that will be saved when Save as… is selected from the File menu.  The choice of
settings in the Size/Resolution palette depends on how you intend to use the image and the
amount of storage space you have available.  Some examples are given below.

If the image will be used in printing or desktop publishing…
…size and resolution will be dictated by the resolution of the output device and the physical
size of the image when printed, measured in centimeters or points rather than pixels.

If you intend to use the image on a web page…
…specify output size in pixels, keeping file size to a minimum for rapid downloads.  Resolution
in this case is not an issue.

Adjusting Size and Resolution

1 Display the Size/Resolution palette
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2 Make changes to options as described below

Keep my crop
When Keep my crop is selected, you can use the mouse to adjust the size and position of
the current crop as desired.  If you enter a new value for height or width in the Size/
Resolution palette, the remaining dimension changes automatically to maintain a con-
stant height-width aspect ratio, and scale is adjusted to reflect the new dimensions (scale
can not be increased beyond 200%).  If the image can not be output at the current
resolution using the new dimensions, resolution will automatically be adjusted to an ap-
propriate value.  This option is useful when you want to specify height and width after
selecting a crop.

Keep my output size
Keep my output size locks output dimensions and file size at their current values, set-
ting the aspect ratio of the current crop according to the dimensions input in the Size/
Resolution palette.  This height-width aspect ratio will be maintained when you adjust the
size of the crop in the active window, and scale will be adjusted to reflect changes to the
size of the crop (scale can not be increased beyond 200%).  If the image can not be
output at the current resolution using the new dimensions, resolution will automatically
be adjusted to an appropriate value. This option is useful when you want to set the output
dimensions and file size of the final image before selecting a crop.

Width/Height
The output dimensions for the current crop can be entered in these
text boxes.  The units used to describe output dimensions can be cho-
sen from the menu to the right of the text boxes.

Scale/File Size

Scale (output size as a percentage of input size, maximum 200%) is displayed at the bottom of the Size/
Resolution palette, together with the uncompressed file size of the image that would be created at current
settings. File size depends on the color model (RGB or CMYK) and, in the case of RGB images, on the pixel
bit-depth that will be used when the image is saved.  Separate file sizes are shown for CMYK and for
eight-bit and sixteen-bit RGB.

At
The At text box is where you enter the output resolution.  This text
box is not active if the unit chosen for output size is “pixels,” when
resolution is fixed at 300 ppi.  The value chosen at other settings should
reflect the resolution of the output device on which the final image is
to be printed.  The units for resolution can be selected from the reso-
lution menu, which offers a choice of pixels per inch (ppi) or pixels per
centimeter (ppcm).  The default resolution is 300 ppi.
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The Settings Menu

The Size/Resolution Settings menu can also be displayed by selecting Size/
Resolution from the Settings menu.

The Size/Resolution Settings Menu
Clicking the  button in the Size/Resolution palette displays the Size/Resolution Settings
menu.

Select this item to load size and resolution settings previ-
ously saved using the Save… option (see below).  A dialog
will be displayed where you can navigate to the drive (vol-
ume) and directory containing the desired settings file (only
files with the extension “.nsr” will be displayed).  The set-
tings in the Size/Resolution palette will instantly revert to the
saved settings.

Load…

Enlarges the crop to include the entire image.  Resolution
will be reset to the default value of 300 ppi (118.11 ppcm).

Reset to 100%

Copy current Size/Resolution settings to the clipboard.Copy to Clipboard

DescriptionOption

Select this item to save size and resolution settings to a named
file.  These settings can later be recalled using the Load…
option.  Choosing Save… displays a dialog where you can
choose a destination and file name for the current size and
resolution settings.  Size and resolution settings are saved
with the extension “.nsr”.

Save…
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Saving and Loading Image Adjustment Settings
Image adjustment settings for all tool palettes (including the status of the Apply button for
each palette) can be copied to the clipboard saved in combined settings file.  When the com-
bined settings are pasted or read into the Nikon Capture 3 Editor, they will apply to all palettes
simultaneously.  These operations are performed using the commands in the Settings > Image
Adjustments menu, which also contains an option for restoring all tool palettes to the set-
tings in effect at the time the photograph was taken.

DescriptionOption

Select this item to load settings previously saved using the
Save… option (see below).  A dialog will be displayed where
you can navigate to the drive (volume) and directory con-
taining the desired settings file (only files with the extension
“.set” will be displayed).  The settings in the Image Adjust-
ment Control Panel window will instantly revert to the saved
settings.

Load…

All image adjustment settings for the image in the active
window are copied to the clipboard.  You can paste them
into the tool palettes for another window by selecting Paste
from the Edit menu when the window is active.

Copy to Clipboard

Select this item to save settings to a named file.  These set-
tings can later be recalled using the Load… option.  Choos-
ing Save… displays a dialog where you can choose a desti-
nation and file name for the current settings.  If this file is
later selected for batch processing, images will be processed
according to the settings in the file (  175,  198).  Joint
settings files are saved with the extension “.set”.

Save…

Select this option to restore image adjustments settings for
the image in the active window to the settings in effect when
the photograph was taken.

Reset to User Defaults
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Saving Images
Nikon Capture supports a variety of file formats.  Images displayed in Nikon Capture can be
saved in a file format that suits the end in view.  Hints for choosing a file format may be found
on the pages that follow.

Choosing a File Type
Nikon Capture 3 supports the following file types when saving images:

Nikon Electronic Image Format (NEF)
All images, including those taken at an image quality setting of RAW, can be saved in Nikon
Electronic Image Format (NEF).  NEF images can only be opened in Nikon View 5 or Nikon
Capture 3, or in Adobe Photoshop 5.0 or later (Photoshop LE excluded) using the Nikon NEF
filter supplied with Nikon View 5.

Images saved in NEF format maintain the high quality of the original photograph; adjustments
to White Balance, Advanced Raw, Curves, Color Balance, Unsharp Mask, Noise Reduction,
and Size/Resolution settings are not applied to the original image data, but are instead saved
separately in the same file.  NEF images can later be opened in Nikon Capture and saved again
in a format that can be opened in other applications.  As changes to settings are only applied
to the original image data when the image is saved in another format, this minimizes any loss
of image quality that may be produced when the image is edited.  Save images in NEF when-
ever you are unsure of how they will be used or when you want to process the original image
in a number of different ways.

TIFF
Use TIFF when saving images for high-quality output or publishing.  Although the lack of
compression will result in larger files, image quality will be maintained at a high level.  TIFF also
preserves the ICC profile and caption information.  This format is supported by a wide variety
of applications on a variety of platforms.

NEF

Nikon Capture 2 may be unable to display NEF images saved using Nikon Capture 3.  Nikon Capture 3 can
however be used to open NEF images created with Nikon Capture 2.

File type Compression Extension

NEF
(Nikon Electronic Image Format)

Uncompressed .NEF

Uncompressed .TIF

16-bit TIFF (RGB)

8-bit TIFF (RGB)

TIFF (CMYK)

Compressed .JPG
JPEG (Exif-compliant)

JPEG (JFIF-compliant)
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JPEG

Image quality will be affected if the same image is saved multiple times in JPEG format.

The Save Button

Clicking the  button saves any changes to the current file, overwriting the original image.  The Save As
dialog is not displayed.

Save button

JPEG
This file type is adequate for images that will be output at low resolution or distributed in
electronic form.  Compression allows more images to be saved in the same amount of disk
space while preserving the ICC profile and caption information.  Note, however, that JPEG
compression results in loss of image information that can not afterwards be restored.  Save
files at the lowest compression ratio possible; if necessary, you can always save them again at
a lower compression ratio.  EXIF is an extension of the JPEG format that allows thumbnail data
and information about the image to be included in a JPEG file.

Options for Saving Image Files
Nikon Capture offers two options for saving files: Save and Save as….  The Save option
saves the image in the same location as the original without changing the file name or format.
The Save as… option lets you choose a location, file name, and format.

Using the “Save” Command
To save changes to an image without creating a new file, click the  button or select Save
from the File menu.  The existing file will be overwritten.
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Using the “Save as…” Command

1 Select Save As… from the File menu
The standard Save dialog for your operating system will be displayed.

2 Choose a location
Navigate to the desired drive (volume) and folder.

3 Choose a file type
Choose a file type (file format) from the pop-up menu.  See “Choosing a File Type” (
168) for more information.

4 Choose a compression ratio
If the file format chosen in Step 3 supports compression, the Use Compression check
box will be checked.  Select the compression ratio from “Highest Compression Ratio,”
“Good Compression Ratio,” “Good Balance,” “Good Quality,” and “Excellent Quality.”

5 Enter a name for the file
The default file name appears in the File name text box.  A new file name can be entered
if desired.

6 Click Save
Click Save to save the file under the specified name.

Save button
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Save Options
In addition to the settings listed above, the following options are available in the Save dialog:

Bit depth
Gives the bit depth (the number of bits of color information per channel for each pixel in
the image) at which the image will be saved.  The 16-bit option is only available if the
selected file type is TIFF format (RGB) and the original image has a bit depth of over eight
bits.

Open in External Application
If Open saved Image in external application is selected in the File Locations tab of the
Preferences dialog, the name of the selected application (e.g., Adobe Photoshop 5.0) will
be displayed.  This option can not be selected if the chosen file format is NEF.  If this check
box is on, the image will automatically be opened in the selected application after being
saved to disk.

Bit depth

Open in External Application
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Setting up Your Printer

Note that the printer must be properly connected and the printer drivers correctly installed.

Printing Images
Images can be printed directly from Nikon Capture 3 Editor to test the effects of image adjust-
ments.  For more information on printing images, see “Nikon Browser: Printing Images” (
71).

1 Open the image
Be sure the image you wish to print is open in Nikon Capture 3 Editor.

2 Adjust the page setup
Choose Page Setup from the File menu to display the
page setup dialog for your printer and operating system.
Adjust settings as desired and click OK.

3 Print the image
Selecting Print… from the File menu displays the Print
Layout dialog, where you can select the layout and the
number of copies to be printed.  Click Print to begin print-
ing.
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Limitations on Batch Processing

Batch processing can only be used with unedited images captured from the camera and images that have
been saved in NEF format from Nikon Capture 3 (images saved in NEF format from Nikon Scan 3 can not
be processed).

Before Using Batch Processing

Batch processing is used to perform the operations specified in the Image Enhancements section of the
Batch dialog on all files in a selected folder.  To ensure that desired results are achieved, we recommend
processing a test image before beginning batch processing.  Batch processing can not be used to adjust
settings separately for each image; instead, the images must be opened one at a time and separate
adjustments made manually for each image.

Batch Processing
Nikon Capture 3 supports automated processing of multiple images (batch processing).  Batch
processing is used to automate image processing, capturing images, applying pre-defined
image adjustment settings, and saving images to disk automatically.  It is most effective when
applied to a series of photographs taken under identical conditions.

When using batch processing, we recommend that you open one of the images to be pro-
cessed in Nikon Capture 3 and edit image adjustment settings (white balance adjustment,
advanced RAW settings, curves, color adjustment, Unsharp Mask, noise reduction, and size
and resolution) to produce the desired result.  You can then save these settings in a joint
settings file using the Save… option in the Settings > Image Adjustment menu (  167).
By selecting the resulting settings file in the Batch dialog, you can perform the same adjust-
ments on all the images processed.  In studio settings where a variety of shooting conditions
can be replicated with ease, you can create separate settings files for commonly encountered
conditions and use these settings to automate repetitive image enhancement operations.

Click the  button or select Batch from the
Tools menu.  174

Open the Batch dialog

Choose folder containing images for batch
processing.  175

Choose how images will be processed.
 175

Choose a file naming method and file for-
mat for processed images.  176

Click OK to begin processing.
 177

Open the Batch progress dialog

Click Batch Complete when processing is
complete.  177

Close the Batch progress dialog
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Selecting Folders for Batch Processing

For improved efficiency, create two folders that are used only for batch processing.  The images to be
processed can be copied to one of these folders, which might be named “Batch In.”  If the Delete files
from this folder after they are processed option is checked, these files will automatically be deleted
from the “Batch In” folder after processing, allowing you to copy more files to the folder without worry-
ing about the files already there (be sure to leave a copy of any images you would like to keep in their
original state in another folder).

This chapter describes how to use batch processing with files that have already been saved to
the computer’s hard disk.  For information on batch processing of images captured directly
from the camera, see “Nikon Capture 3 Camera Control” (  197).

1 Display the Batch dialog
Select Batch from the Tools menu or click the  button to display the Batch dialog.
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2 Choose a source folder
In the Source section, choose the folder containing the images to be processed.  The
current folder is listed in the text box.  To choose a new folder, click the Browse button
and navigate to the desired location.

Include subfolders
Check this option to process all images in any sub-folders under the specified folder.

Periodically check for new files in this folder
When this option is checked, Nikon Capture 3 will check for new images in the specified
folder once every ten seconds.

Delete files from this folder after they are processed
Check this option to delete image files from the selected folder after processing.  A warn-
ing dialog will be displayed before batch processing begins.

3 Specify how images will be processed
In the Image Adjustments section, specify the operations to be performed on each image.

Apply current settings
Select this option to process the images in the selected folder using the settings currently
in effect in the White Balance, Advanced RAW, Curves, Color Balance, Unsharp Mask and
Size/Resolution windows.

Apply settings in
Select this option to process the images in the selected folder using joint settings created
using the Save… option in the Settings > Image Adjustment menu (  167).  When
this option is selected, a joint settings file can be selected by clicking the Browse button
to its right.

Apply settings already in NEF files
Check this option to apply settings previously saved with NEF files.  If this item is not
checked, the saved settings will be replacing with the settings chosen in the Image En-
hancements section.

Orientation

Images processed using the batch option are saved in their original orientation.  When Apply current
settings is selected, images will not be rotated or flipped, regardless of whether flips or rotations have
been applied to the image in the active image window.  If batch processing is performed on images that
have been flipped or rotated in Nikon Browser, these changes in orientation will be preserved when the
image is saved.

Existing Image Adjustment Settings

If the Apply settings already in NEF files option is not checked, any changes to settings stored with files
saved in NEF format will be ignored, and the settings in the selected settings file applied.  If you have
processed a series of NEF images separately and want to save them all as sixteen-bit TIFF, you can check
this option and use batch processing to save all the images to a single folder in sixteen-bit TIFF format.
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4 Choose a destination for the processed images
In the Destination section, choose options for saving the processed images.

Use source folder
When this option is selected, processed images will be saved to the same folder as the
original.

Use source file name
When this option is selected, processed images will be saved under the same name and in
the same location as the original images, although the file extension will change if the
chosen file format differs from the original.

Save to
This text box shows the folder to which the images will be saved after processing.  To
choose a new folder, click the Browse button to the right of the text box and navigate to
the desired location.  This option is not available when Use source folder is selected.

Next file name
This text box shows a sample of the file names that will be used when saving the images
after processing.  To choose a new file name, click the Edit button.  The File Naming
dialog will be displayed.  For more information, see “Nikon Transfer” (  22).

Save as type
Choose the file format that will be used to save the processed images.  For more informa-
tion on the options available, see “File Formats” (  168).

Bit Depth
Choose the bit depth (the number of bits of color information per channel for each pixel
in the image) at which files will be saved.  The 16-bit option is only available if the selected
file type is NEF or TIFF (RGB) and the original image has a bit depth of over eight bits.
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File Naming Conventions

Windows: In environments that do not support long file names, the maximum length is eight characters;
file names may not contain spaces, quotes, or any of the following characters: “\” “/” “:” “,” “;” “*” “<“
“>” and “|”.

Where long file names are supported, the maximum length is 255 characters, file names may not contain
quotes or any of the following characters: “\” “/” “:” “,” “;” “*” “<“ “>” and “|”.

Macintosh: The maximum length for Macintosh file names is thirty-one characters.  Colons (“:”) are not
allowed.

Error Messages

If an invalid file name or other error is identified in the batch processing dialog, a message will be dis-
played.  Return to the batch processing dialog and adjust settings as directed in the message.

To stop batch processing before all images have been processed, click Stop Batch.

6 Exit the batch processing dialog
When batch processing is complete, the Stop Batch button will change to Batch Com-
plete.  Click Batch Complete to exit the batch processing dialog.

5 Begin processing
Click OK to put the selected settings into effect and begin processing.  A batch progress
dialog will be displayed.
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Nikon Capture 3 Editor Preferences
Fine-Tuning Nikon Capture 3 Editor

To view the Preferences dialog, select Preferences… from the Edit (Windows or Mac OS 9) or
application (Mac OS X) menu.

Viewing Preferences

To view settings in any of the five panes, click the appropriate tab.

The Preferences dialog contains the following five tabs:

Windows / Mac OS 9

Mac OS X

General

Temporary Files

Advanced Color

Grid Lines

Color Management

Tab

Specify the default image enhancement options that will
apply to new images.

Specify the location of the folders used for temporary stor-
age.

Set the defaults for the white and black points in the Curves
window.

Specify the spacing and color of the grid displayed in im-
age windows.

Select the color profiles used by the Nikon Color Manage-
ment System (CMS).

Description

179

179

180

181

182
183

Tab

After making changes to preferences, click OK to save changes and return to the Nikon Cap-
ture 3 Editor window.  Click Cancel to cancel any changes to settings and return to the Nikon
Capture 3 Editor window.
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The General Tab
The General tab contains the following items:

“User Default” image adjustments
Choose the settings (Curves, Color Balance,
Unsharp Mask, crop size and location, and out-
put size and resolution) that will apply to the
next image captured from the camera.

Open saved image in
To specify the application used to open saved
images, click the Browse… button and navi-
gate to the desired application.

The Temporary Files Tab
The Temporary Files tab offers the following
option:

Folder for temporary data
Specify the folder or volume in which tempo-
rary data, such as image cache data, will be
stored.  The default folder for Windows is the
“TEMP” folder in the Windows directory, while
the default volume for the Macintosh is the
start-up disk.  To choose a different folder in
the Windows version of the program, click the
Browse… button and navigate to the desired
location.  In the Macintosh version, a new
volume can be chosen from the pop-up menu.

The Temporary Files Tab

Changes to settings in the Temporary Files tab also apply to Nikon Viewer and Nikon Capture 3 Camera
Control.  Nikon Capture 3 must be restarted before changes to settings will take effect.
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The Advanced Color Tab
The Advanced Color tab contains the follow-
ing items:

Auto-Contrast clip
Controls how the auto contrast operation cal-
culates the input values for the white point
and black point.  By default, the white point
is set to a value that excludes 0.50% of the
brightest pixels in the current crop, the black
point to a value that excludes 0.50% of the
darkest pixels in the crop.  This produces an
optimal dynamic range, with minimum loss
of detail in shadows and highlights.  To pre-
serve detail at the expense of dynamic range,
lower the “excluded” value for auto contrast
(a value of 0 will set the black and white points
respectively to the darkest and brightest pixel
in the crop).  To increase the dynamic range
at the expense of detail, raise the “excluded”
value.

Black Dropper value/White Dropper value
Controls the default output values for white point and black point.  Output for each channel
can be set to a value between zero and 255; these settings can also be adjusted in the Curves
window.  By default, output levels for the white point are 255 for each channel, which displays
as white on most computer monitors.  The defaults for the black point are 0 for each channel,
which displays as black.

Dropper sample size
This setting determines the size of the area sampled with the eyedropper cursor in the White
Balance and Curves palettes.  You can select a sample sizes of Point Sample (the default
setting), 3 × 3 Average, and 5 × 5 Average.  When the sample size is set to 3 × 3 or 5 × 5
Average, the average for the pixels sampled is used.  Choosing a large sample size reduces
precision, but also minimizes the effects of noise; choosing a small sample size has the oppo-
site effect.

Reset to Default
Click this button to restore settings in the Advanced Color tab to their default values.
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The Grid Lines Tab
The Grid Lines tab controls the color and spac-
ing of the non-printing grid lines overlaid on
an image when Show Grid Lines is selected
from the Image menu.

Color
The color of the grid lines can be selected from
white, light gray, dark gray, black, red, green,
blue, cyan, magenta, and yellow.

Display grid line every
Enter a value for grid spacing in the text box.
The units for the grid can be selected from
the pop-up menu to the right of the text box.
The options available are pixels, inches, milli-
meters, centimeters, picas, and points; at set-
tings other than pixels grid spacing can be
entered up to two decimal points.

Display n subdivisions per line
The number of subdivisions into which each grid cell will be divided.  The main grid is displayed
as solid lines of the color specified using the Color option, the subgrid as broken lines of the
same color.
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Supported Color Profiles

Nikon Capture 3 supports only ICC (International Color Consortium) monitor and CMYK profiles.  Particu-
lar care should be exercised when choosing a CMYK profile, as the profile supplied by the manufacturer of
your output device may not be an ICC profile.

The Color Management Tab (Windows)
The Color Management tab is where you
specify the color management profiles used
for displaying images on your monitor, edit-
ing and saving RGB images, and saving and
printing CMYK images.

Monitor profile
The ICC monitor profile used to adjust the dis-
play for the non-linear characteristics of your
monitor is displayed here.  To choose a differ-
ent profile, click the Browse… button.

Default RGB color space
The output color-space profile used when work-
ing with RGB images can be selected from
sRGB, Bruce RGB, NTSC (1953), Adobe RGB
(1998), CIE RGB, Adobe Wide RGB, Apple RGB,
and Color Match RGB.  If Use this instead of
an embedded profile when opening files is checked, this RGB color space profile will be
used for all images.  If it is not checked, the profile embedded in each image will be used.

Printer profile
Specifies the printer profile to be used when printing images.  To use the current RGB color-
space profile, check Use profile for printing.  To choose a printer profile, remove the check
from Use profile for printing and click the Browse… button.  If you have chosen to use a
printer profile, the type of matching to be performed can be selected from Relative and Per-
ceptual.  (Depending on the profile, changing the matching method may produce no change
in output.  This option is not supported with some profiles; consult the manufacturer for de-
tails.)

Relative
If the image contains colors not in the gamut of the selected printer profile, all colors in
the image will be compressed to fit the gamut.

Perceptual
Colors not in the gamut of the selected printer profile will printed using the closest colors
available.  Other colors are not affected.

CMYK separation profile
The profile used when converting RGB images to CMYK is displayed here.  To choose a differ-
ent profile, click the Browse…  button.
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The Color Management Tab

Changes to settings in the Color Management tab also apply to Nikon Viewer and Nikon Capture 3
Camera Control.  Nikon Capture 3 must be restarted before changes to settings will take effect.

RGB Color-Space Profiles

See page 282 for more information on the standard color-space profiles supported under Nikon Capture 3.

The Information Palette

The color-space profile for the image in the active window is displayed in the Information palette (  171).

The Color Management Tab (Macintosh)
The Macintosh version displays the profile names selected in the ColorSync control panel (Mac
OS 9) or in System Preferences (Mac OS X).

ColorSync Default Profiles for Documents
The default color-space profiles are displayed in this area.  Clicking the Open ColorSync button
opens the ColorSync dialog, where you can choose the default profiles for the RGB and CMYK
color spaces.

RGB default
Lists the output ICC color-space profile used when working with RGB images.  If Use RGB
default instead of an embedded profile when opening files is checked, this RGB color
space profile will be used for all images.  If it is not checked, the profile embedded in each
image will be used.

CMYK default
Lists the profile used to convert images to CMYK when they are saved as TIFF-CMYK.
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ColorSync Profiles for Standard Devices
The default output color-space profiles for output devices are listed here.  Clicking the Open
ColorSync button opens the ColorSync dialog, where you can choose the default profiles for
monitors and printers.

Display
Lists the monitor profile used to adjust colors for output on your monitor.

Use working RGB color space for printing
If this box is checked, the default RGB color space is used for printing.

Output
Lists the name of the output profile used for printing images when the Use working
RGB color space for printing box is not checked.  Note that CMYK profiles can not be
used in Nikon Capture 3; if a CMYK profile is selected, the status of the Use working
RGB color space for printing check-box can not be changed.

Output intent
If you have chosen to use a printer profile, the type of matching to be performed can be
selected from Relative and Perceptual.  (Depending on the profile, changing the match-
ing method may produce no change in output.  This option is not supported with some
profiles; consult the manufacturer for details.)

Relative
If the image contains colors not in the gamut of the selected printer profile, all colors in
the image will be compressed to fit the gamut.

Perceptual
Colors not in the gamut of the selected printer profile will printed using the closest colors
available.  Other colors are not affected.

Open ColorSync
Opens the ColorSync control panel (OS 9) or System Preferences (OS X), where you can
choose the color profiles used.
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ICC Version 4 Profiles (Macintosh)

Nikon Capture 3 does not support profiles that conform to version 4 of the ICC standard.  If a version 4
profile is selected, Nikon Capture 3 will default to the following profiles:
• Default RGB Color Space: Nks.RGB.icm
• Default CMYK Profile: Nks.CMYK.icm
• Display: NkMonitor_Mac.icm
• Output: the status of the Use working RGB color space for printing check-box can not be changed.
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Using the Camera Control component of Nikon Capture 3,
you can control almost all aspects of camera operation re-
motely from your computer.  If Camera Control is running
when a D100 camera is connected, or a D1-series camera is
connected and set to PC mode, pictures taken with the cam-
era will be stored on your computer hard disk, not the camera
memory card.  The camera can be operated either directly or
using the controls in the Camera Control window.  Camera
settings are displayed in Camera Control.

This chapter describes the Camera Control and Custom Set-
tings windows.  For more information on camera settings, see
the documentation provided with your camera.

The Camera Control Window
Read this section for a description of the controls in the Nikon
Capture 3 Camera Control window, as well as for information
on launching and closing the Camera Control window, cap-
turing photographs to disk, processing photographs as they
are captured, time lapse photography, and custom settings.

Nikon Capture 3 Camera Control Preferences
This section details the options available in the Camera Con-
trol Preferences dialog.

Capturing Photographs

Nikon Capture 3
Camera Control
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The Camera Control Window
Getting to Know Nikon Capture 3 Camera Control

The main parts of the Camera Control window are identified below.

Macintosh Computers

Nikon Capture 3 Camera Control is not available when the D100 is connected to a Macintosh computer,
or when a D1-series camera is connected to a Macintosh running Mac OS X version 10.1.4 or earlier.

Camera Control

Changes made to settings in the Nikon Capture 3 Camera Control window only apply to photographs
taken after the changes are made, not to photographs that have already been taken.

Camera control page selection tabs
The menus, sliders, and buttons on each tab
are used to control camera settings.

Download Options button
Click this button to choose a destination for
photographs captured from the camera.

Menu bar
Use to open the Live Batch and Time Lapse
Photography windows, adjust camera set-
tings, and to set Camera Control Preferences.

Simulated LCD panel
Performs the same function as the informa-
tion display in the camera viewfinder.

Shoot buttons
Click these buttons to take pictures.

Hide Camera Controls button
Click this button to hide the camera control
panels in the Nikon Capture Camera Con-
trol window.



189

Getting to Know Nikon Capture 3 Camera Control

Click OK to close the warning and display the following window.  Preferences can be adjusted
using the options in the menu bar.

Download Options button
Click this button to choose a
destination for photographs
captured from the camera.

If no camera is connected when Nikon Capture 3 Camera Control is launched, a warning will
be displayed.
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Connecting the Camera

For information on connecting the camera to a computer, see the documentation provided with your
camera.

Starting Nikon Capture 3 Camera Control
Nikon Capture 3 Editor can be started by selecting Show (or Launch) Nikon Camera Control
from the Tools menu in Nikon Browser, Nikon Viewer, or Nikon Capture 3 Editor, or by clicking
the  button in the Nikon Capture 3 Editor Quick Tools palette.  You can also start the Editor
directly by selecting Nikon Capture 3 Editor from the Start menu (Windows) or double-click-
ing the application icon (Macintosh).

Windows

1 Connect the camera
Connect the camera to your computer and turn the camera on.  If you are using a D1-
series camera, choose “PC” as the operating mode.

2 Close Nikon Transfer
If Nikon Transfer starts, click the Close button.

3 Start Nikon Capture 3 Camera Control
From the Start menu, select Nikon Capture Camera Control (Windows XP) or  Pro-
grams > Nikon Capture 3 > Nikon Capture 3 Camera Control (other Windows ver-
sions).



191

Getting to Know Nikon Capture 3 Camera Control

The Camera Control window will be displayed.
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Macintosh

1 Connect the camera
Connect the camera to your computer and turn the camera on.  If you are using a D1-
series camera, choose “PC” as the operating mode.

2 Close Nikon Transfer
If Nikon Transfer starts, click the Close button.

3 Start Nikon Capture 3 Camera Control
Double-click the Nikon Capture 3 Camera Control icon  in the folder to which you
installed Nikon Capture 3.

The Camera Control window will be displayed.

Serial Number

If prompted to supply a serial number when starting Nikon View 5, Nikon Capture 3 Editor, or Nikon
Capture 3 Camera Control, enter the serial number for Nikon Capture 3.

Other Ways of Starting Camera Control

Nikon Capture 3 Editor can be started by double-clicking the Nikon Capture 3 Camera Control icon ( )
in the folder to which you installed Nikon Capture 3 (Windows, Mac OS 9).  If Nikon Capture 3 was
registered in the Dock during installation, Mac OS X users will be able to start Nikon Capture 3 Editor by
clicking the Nikon Capture 3 Camera Control icon ( ) in the Dock.
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Exiting Nikon Capture 3 Camera Control
To close the Nikon Capture 3 Camera Control window, open the File menu and choose Exit
(Windows) or Quit (Mac OS 9).  In Mac OS X, select Quit Nikon Capture from the Nikon
Capture menu.

For information on disconnecting your camera from your computer, see the user’s manual
provided with your camera.

Mac OS 9

Mac OS X

Windows
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Capturing Photographs to Disk
If Nikon Capture 3 Camera Control is running when a D100 camera is connected, or a D1-
series camera is connected and set to PC mode, pictures taken with the camera will be stored
on your computer hard disk, not the camera memory card.

1 Start Nikon Capture 3 Camera Control (  190)
Connect the camera to your computer and turn the cam-
era on.  If you are using a D1-series camera, set the oper-
ating mode to PC.

Connect the camera to your computer.

Start Nikon Capture 3 Camera Control.
 194

Choose a destination for captured images.
 195

Choose the application in which captured im-
ages will be displayed.  196

Take pictures.
 196

Finish shooting.
 196

Open the Camera Control window

Open the Download Options dialog

Open the Preferences dialog

Exit Camera Control.
 196

Close the Camera Control window
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3 Choose a destination and file naming for captured images

Folder for images downloaded from camera
Use this area to select the folder to which photographs will be downloaded as they are
taken.

Next file name
This area is used to specify how photographs captured
from the camera will be named as they are saved to disk.
To choose how files are named, click Edit.  The dialog
shown at right will be displayed.  Using the sample file
name as your guide, enter a prefix and suffix and choose
the starting number and number of digits for automatic
sequential file numbering.

2 Display the Download Options dialog
Click Download Options in the Camera Control window.  The following dialog will be
displayed.

File information
Clicking this button displays a dialog where you can select the IPTC information, including
keywords and captions, that will be added to images as they are captured.  For more
information, see “Nikon Transfer” (  22).

After adjusting the above options, click OK to exit the dialog and apply settings to subse-
quent photographs.
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4 Choose the application that will be used to display photographs after shooting
Select Preferences… from the Edit menu (Windows, Mac OS 9) or the application menu
(Mac OS X).  When the Preferences dialog is displayed, click the General tab.

6 Exit Nikon Capture 3 Camera Control
To exit Nikon Capture 3 Camera Control, click the close button in the title bar of the Nikon
Capture Camera Control window.

From the pull-down menu under When a new image is received from the camera,
choose Do nothing, View it with Nikon View, or Show it in Nikon View Browser .
Click OK to close the Preferences dialog.

5 Take pictures
Take pictures using the camera shutter-release button or the AF & Shoot or Shoot but-
tons in the Camera Control window.  If View it with Nikon Viewer or Show it in
Nikon Browser is selected for When a new image is received from the camera in the
General tab of the Preferences dialog, photographs will be opened in Nikon Viewer or
Nikon Browser as they are taken.
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Processing Photographs as They Are Captured
This section describes how live batch processing can be used to process photographs auto-
matically as they are captured.  For information on performing batch processing on images
that have already been saved to disk, see “Batch Processing” (  214).

Select Live Batch from the Camera menu.
 198

Choose how photographs will be processed.
 198

Choose the folder that will be used to store
the photographs.  199

Choose a naming method and file format for
captured photographs.  199

Choose whether to save unmodified photo-
graphs separately.  200

Open the Live Batch dialog

Click Start.
 200

Open the batch progress dialog

Take photographs.
 200

Finish shooting.

Click Batch Complete to exit the Live Batch
dialog.  200

Close the batch progress dialog
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Live Batch Processing

Live batch processing is used to perform the operations specified in the Image Enhancements section of
the Live Batch dialog on all images captured from the camera.  To ensure that desired results are achieved,
we recommend processing a test image before beginning batch processing.  Batch processing can not be
used to adjust settings separately for each image; instead, the images must be opened one at a time and
separate adjustments made manually for each image.

1 Display the Live Batch dialog
Select Live Batch from the Camera Control Camera menu.  The Live Batch dialog will be
displayed.

2 Specify how captured images will be processed
In the Image Adjustments section, specify the operations to be performed on each image.

None (save unmodified image)
Select this option to save images exactly as captured from the camera, without modifica-
tion.

Apply current settings from Nikon Capture Editor
Select this option to process images using the settings currently in effect in the White
Balance Adjustment, Advanced RAW, Curves, Color Adjustment, Unsharp Mask, Noise
Reduction, and Size/Resolution windows in Nikon Capture 3 Editor.  To open Nikon Cap-
ture 3 Editor and adjust settings, click the Launch Nikon Capture Editor button.

Apply settings in
Select this option to process the images using joint settings created using the Save…
option in the Nikon Capture 3 Editor Settings > Image Adjustment menu (  207).
When this option is selected, a joint settings file can be selected by clicking the Browse…
button to its right.
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Save as type
Choose the file format that will be used to save the processed images.  For more informa-
tion on the options available, see “File Formats” (  208).

Bit depth
Choose the bit depth (the number of bits of color information per channel for each pixel
in the image) at which files will be saved.  The 16-bit option is only available if the selected
file type is NEF or TIFF (RGB) and the original image has a bit depth of over eight bits.

3 Choose a destination for captured images
In the Destination section, choose options for saving the processed images.

Save to
This text box shows the folder to which the images will be saved after processing.  To
choose a new folder, click the Browse… button to the right of the text box and navigate
to the desired location.

Next file name
This text box shows a sample of the file names that will be used when saving the images
after processing.  To choose a new file name, click the Browse… button.  The File Naming
dialog will be displayed.  For more information, see  “Nikon Transfer” (  31).

File Naming Conventions

Windows: In environments that do not support long file names, the maximum length is eight characters;
file names may not contain spaces, quotes, or any of the following characters: “\\” “/” “:” “,” “;” “*”
“<“ “>” and “|”.

Where long file names are supported, the maximum length is 255 characters, file names may not contain
quotes or any of the following characters: “\\” “/” “:” “,” “;” “*” “<“ “>” and “|”.

Macintosh: The maximum length for Macintosh file names is thirty-one characters.  Colons (“:”) are not
allowed.
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6 Take photographs
Take photographs as described in the camera User’s Manual.

7 End batch processing
Once you have finished taking photographs, click Batch Complete to end batch process-
ing.

4 Choose whether to save original photographs
In the Archive section, choose whether to save the original, unprocessed photographs.

Save Unmodified Files
Check this option to save both the original image and copies processed according the
options selected in the Image Enhancement section.

Save to
This text box shows the folder to which unprocessed images will be saved.  To choose a
new folder, click the Browse… button to the right of the text box and navigate to the
desired location.

5 Click Start
Click Start to put the selected settings into effect.  A progress dialog will be displayed.
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Time Lapse Photography
Using Nikon Capture, you can take a series of photographs automatically at a time interval you
select.

Select Time Lapse Photography… from the
Camera menu.  202

Choose whether to focus before each shot.
 202

Choose the number of photographs to be
taken.  202

Choose an interval setting.
 202

Choose whether to save photographs auto-
matically.  202

Open the Time Lapse Photography
dialog

Click Start to begin time lapse photography.
 202

Open the time-lapse photography
progress dialog

Follow the progress of time lapse photogra-
phy in the progress dialog.  203

Click Shooting Complete to exit the batch
processing dialog.  203

Close the time-lapse photography
progress dialog
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2 Adjust settings
Before shooting starts, adjust the following settings:

Autofocus before each shot
If this option is checked, the camera will perform an autofocus operation before each
shot.

Keep shooting until cancelled
If this option is checked, the camera will continue to take photographs until you click
Cancel.

3 Specify the number of photographs to be taken
Use the Shots box to choose a number of photographs from 2 to 9,999.  This option is
not available when Keep shooting until cancelled is selected.

4 Choose an interval setting
The delay between shots can be set to any value between 00:00:01 (one second) and
99:59:59 (ninety-nine hours, fifty-nine minutes, and fifty-nine seconds).

5 Click Start
Click Start.  To process images as they are taken, check the Process images before
saving (Live Batch) option in the Time Lapse Photography dialog and click Next.  The
Live Batch dialog will be displayed; adjust settings and click Start to begin time lapse
photography.

Time Interval Settings

If the delay is shorter than the time required to record each photograph, the actual interval between
photographs will be longer than that specified in the Time Lapse Photography dialog.

The Time Lapse Photography Dialog

If you make a mistake in entering settings in the Time Lapse Photography dialog, a warning will be
displayed.  Return to the Time Lapse Photography dialog and adjust settings as directed.

1 Display the Time Lapse Photography dialog
Select Time Lapse Photography… from the Camera menu.  The Time Lapse Photogra-
phy dialog will be displayed.
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Auto Off (D1-Series Cameras)

When the camera is operated on battery power and for 15 minutes has been selected for “While appli-
cation is running, keep camera awake” in the General tab of the Preferences dialog (  223), choose a
delay of fifteen minutes or less.  When taking photographs at longer intervals, use an EH-4 AC adapter
(available separately) to power the camera.

During Time Lapse Photography

No other operations can be performed until the Time Lapse Photography dialog is closed.

Hard Disk Full

A warning will appear when space is no longer available on the destination disk for photographs taken
using time lapse photography.  Use the information in the warning to reduce the number of photographs
or change the destination drive.

6 Follow the progress of time lapse photography in the progress dialog
Click Stop Shooting to end time lapse photography at any time.  If a number of shots
was specified in the Time Lapse Photography dialog, shooting will end when the specified
number of shots has been taken.

7 Close the Time Lapse Photography dialog. Once the specified number of shots has
been taken, click Stop Shooting button will change to Shooting Complete.  Click
Shooting Complete to exit the Time Lapse Photography dialog.



204

The Camera Control Window

The Nikon Capture 3 Camera Control Window
The Nikon Capture 3 Camera Control window shows current camera settings, which may be
viewed by clicking the five page selection tabs.  Camera settings can be altered using the
controls in each tab as described below.  The simulated LCD panel and the Hide Nikon Cap-
ture 3 Camera Control, Download Options, and shoot buttons can be accessed from all
five tabs.

Camera Control page selection tabs

Simulated LCD panel

Shoot buttons

Camera name
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Hide Camera Control
Click this button to hide the Camera Control panels during shooting.

Download Options
Click this button to choose a destination and file name for pictures captured from the camera.

Simulated LCD Panel
The simulated LCD panel shows the information displayed in the camera’s viewfinder, with the
exception of camera errors.  Clicking on an indicator in the panel opens the Nikon Capture 3
Camera Control window to the tab that controls the selected option, where adjustments can
be made.

Shoot Buttons
Click either of these buttons to take a photograph at current settings.

AF and Shoot
When this button is clicked, the camera will perform an autofocus and then release the
shutter to take a photograph.  No autofocus operation will be performed when the cam-
era is in manual focus mode.

Shoot
Click this button to take a photograph.  If the selected focus mode is single-servo AF, an
autofocus operation will be performed before the shutter is released.

Taking Photographs in Continuous Mode

When a D1-series camera is in PC mode, continuous shooting can only be performed using the camera
shutter-release button.  The shoot buttons in the camera control window can only be used to take one
photograph at a time.

Camera Settings That Can Not Be Adjusted from Nikon Capture

The following operations can not be performed from Nikon Capture 3 Camera Control:

CameraOperation

D1-series/D100Taking continuous photographs in continuous shooting mode

D1-series/D100Continuous servo autofocus

D1-seriesShutter-speed lock

D1-series/D100Aperture lock

D1-series/D100Autoexposure lock

D1-series/D100Pressing the shutter-release button halfway to check focus

D1-seriesManual aperture adjustment using the lens aperture ring

D1-series/D100Reactivating the camera after it has entered sleep mode

D1-series/D100Depth-of-field preview

D1-series/D100Auto bracketing

D100Compression options for NEF (RAW) images

D1-series/D100Focus mode

D1-series/D100Metering

D100Exposure mode

D100Shooting mode

Statu
s n

o
t d

isp
layed

Statu
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d
isp

layed
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Bulb

At a setting of Bulb, the shutter remains while the shutter release button is held down.  For this reason,
although a setting of Bulb can be chosen remotely from Nikon Capture 3, you must use the shutter-
release button on the camera to take photos at this setting.  An error message will be displayed if you click
either of the shoot buttons with the shutter speed set to Bulb.

The Exposure 1 Tab
The following settings can be adjusted from
the Exposure 1 tab:

Exposure Mode
This menu can be used to set the exposure
mode for D1-series cameras.  It can not be
used to set exposure mode for the D100.

Shutter Speed
Shutter speed can only be adjusted in Manual
and Speed Priority modes, when it can be
set to values between the maximum and mini-
mum values supported by the camera.  Use
high shutter speeds to freeze motion, low
shutter speeds to suggest motion by blurring
moving objects.

Aperture
Aperture can only be adjusted in Manual and
Aperture Priority modes, when it can be set
to values between maximum and minimum
aperture (small apertures have high f-numbers,
wide apertures low f-numbers; the actual apertures available depend on the lens used).  Aper-
ture can not be controlled from Nikon Capture when Custom Setting 22 (  221) has been set
to allow aperture to be adjusted manually using the lens aperture ring (D1-series only).

Exposure Comp.
Exposure compensation is useful when shooting subjects containing sharp lighting contrasts,
or on other occasions when you want to modify the exposure value determined by the cam-
era.  Exposure compensation is available in all exposure modes.

Flash Comp. (D100 only)
This option is used to adjust the level of the D100’s built-in Speedlight.

Flexible Program
Flexible program can only be used in Program Mode, when it allows you to choose from
predetermined combinations of shutter speed and aperture appropriate to current lighting
conditions.
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The Exposure 2 Tab
The following settings can be adjusted from
the Exposure 2 tab.  See the camera manual
for details:

Focus Area
The focus area can not be selected at an AF-
area mode setting of closest subject priority.
At other autofocus settings, the focus area can
be selected using the arrow buttons.  The ef-
fects of focus area selection depend on the
option selected for AF Area Mode in the Me-
chanical tab (  260).

Metering Mode
This text box shows the current metering
mode.  Note, however, that the metering
mode can not be changed from Nikon Cap-
ture 3.

Flash Sync Mode
This option controls the camera flash sync
mode.

Sensitivity
Sensitivity (ISO equivalency) can be raised when taking photographs in low light conditions.
See the user’s manual provided with your camera for details.

Auto (D100 only)
When this option is checked, the camera will adjust sensitivity (ISO equivalency) automatically
(ISO auto).

White Balance
White balance is used to ensure that colors which appear white when viewed directly are
white in the final photograph.  The following settings are available:

Preset
White balance can be set using a neutral gray or white object as a refer-
ence point.  Depending on the camera, several preset white balance op-
tions may be available.

Direct sunlight Use this setting when taking photographs in direct sunlight.

Auto The camera sets white balance automatically.

Option Description

Shade Use this setting when taking photographs in the shade in sunny weather.

Cloudy Use this setting when taking photographs under overcast skies.

Incandescent Use this setting when taking photographs indoors under incandescent light.

Fluorescent Use this setting when taking photographs indoors under fluorescent light.

Flash Use this setting with Nikon Speedlights.
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Fine Tune…
Click Fine Tune… to make fine adjustments to the white balance settings chosen in the
white-balance pop-up menu.

White Balance

If desired, white balance can be used to produce an intentionally unbalanced rendering of a scene.

If the current white balance setting is Auto, the value selected with the Add to Auto slider
will be added to the white balance setting chosen by the camera.

Clicking the Reset button returns all values to defaults.  Click OK to apply the current settings
to the camera, or click Cancel to discard any changes and return to the Nikon Capture 3
Camera Control window.
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The Storage Tab
The following settings can be adjusted from
the Storage tab:

Data Format
The following data formats are available: RAW
(12-bit), TIFF-RGB (8-bit), TIFF-YCbCr (8-bit)
(D1-series only), and JPEG (8-bit).  The data
format setting determines pixel bit depth and
file size.

Compression
When data format is set to JPEG (8-bit), you
can choose the image quality (JPEG compres-
sion) setting from Fine, Normal, and Basic.
If you are using the D1X or D1H at a data for-
mat setting of RAW (12-bit), you can choose
from a settings of None or Lossless.  If RAW
(12-bit) is selected when the D100 is attached,
images will be saved in uncompressed format,
regardless of the compression option selected
with the camera.

Color
Choose from Color and Black & White (D1-series only).  Black & White is not available with
the D100 or when RAW is selected for Data Format.

Image Size
If you are using the D1 or D1H, image size will be fixed at Medium (2000 × 1312).  The D1X

offers a choice of Large (3008 × 1960) and Medium (2000 × 1312), the D100 a choice of
Large (3008 × 2000), Medium (2240 × 1488), and Small (1504 × 1000) (when data format
is set to RAW (12-bit), image size for the D100 and D1X is fixed at Large).
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The Mechanical Tab
The following settings can be adjusted from
the Mechanical tab:

Shooting Mode
Sets the shooting mode for D1-series cameras
in PC mode to Single or Continuous.  The
advance rate for continuous mode can be set
using Custom Setting 25 (  221).  Changes
to the shooting mode are reflected in Custom
Setting 30.

AF Area Mode
AF area mode can be set to Single Area AF or
Dynamic Area AF.  See the camera manual
for details.

Focus Mode
The current focus mode setting is displayed.
See the camera manual for details.  This set-
ting can not be changed from Nikon Capture.

Lens
Displays the focal length and maximum aper-
ture of the lens currently attached to the cam-
era.  Depending on the lens type, some infor-
mation may not be displayed.

Main Battery Level
Displays the level of the main camera battery.  Green indicates that the battery has enough
charge for continued operation.  Yellow indicates that battery level is low; ready a fully charged
spare battery pack.  Red indicates that the battery is exhausted, and that no further photo-
graphs can be taken until the battery pack has been replaced.  You may not be able to control
the camera from Nikon Capture when the battery is exhausted.  Replace with a fully charged
spare battery pack or use an AC adapter (available separately).

Clock Battery Level (D1-series only)
Displays the level of the camera clock battery.  Should this display turn yellow or red, have the
clock battery replaced by an authorized Nikon service representative (a fee is charged for this
service).
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The Processing Tab
The following settings can be adjusted from
the Processing tab:

Sharpening
This option controls how much the camera
sharpens outlines.  See the camera manual
for details.

Tone Compensation
This setting controls contrast.  See the cam-
era manual for details.

Color Mode (D1X, D1H, and D100 only)
The D100, D1X, and D1H offer a choice of color
modes.  See the camera manual for details.
With the D1, colors are optimized for the NTSC
color space, regardless of the option chosen
for color mode.

Hue Adjustment (D1X, D1H, and D100 only)
Use to modify hue while leaving brightness
and chroma unaffected.  Adjustments can be
made in the range –9 ° to 9 °, with 0 ° repre-
senting the original hues as recorded by the camera (in D1-series cameras, –9 ° is equivalent to
a camera hue setting of 0, 0 ° to a setting of 3, and 9 ° to a setting of 6).

Noise Reduction (D100 only)
At shutter speeds slower than 1/2 s, “noise” in the form of randomly-spaced, brightly-colored
pixels may appear in photographs, particularly in shadows.  Select ON to reduce noise.
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The Camera Menu
The commands in the Camera menu are used to adjust the following camera settings:

Custom Settings…
Selecting this option opens the Custom Settings dialog (  215), where camera Custom Set-
tings can be adjusted.

Set Date and Time…
Selecting this option opens the dialog shown at right, where
you can set the camera’s clock calendar to the current date
and time.  To view the current time and date settings, click
Use Current date/Time.  Click OK to set the clock calendar
to the time and date shown.

Saving and Loading Camera Control Settings
The Camera Control option in the Settings menu is used to
save Nikon Capture 3 Camera Control settings and to load
and apply previously saved settings.

Option Description

Load Camera Settings…

Select this item to load camera settings previously saved us-
ing the Save… option (see below).  A dialog will be dis-
played where you can navigate to the drive (volume) and
directory containing the desired settings file (only files with
the extension “.ncc” will be displayed).  The settings in the
Camera Control window will instantly revert to the saved
settings.

Save Camera Settings…

Select this item to save the settings in the Camera Control
window to a named file.  These settings can later be recalled
using the Load… option.  Choosing Save… displays a dia-
log where you can choose a destination and file name for
current camera settings.  Camera settings are saved with the
extension “.ncc”.
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The controls in the Edit Camera Curves window are identical to those in the Curves window,
except in the following respects: (1) only the master channel, not individual RGB channels,
may be edited; (2) there is a limit of 20 spline points; (3) the midpoint may not be edited; (4) a
user-defined sample image can be selected by clicking the Sample Image… button.    Any
changes to curves are reflected in the sample image.

The upper left section of the Edit Camera Curves window contains Load… and Save… but-
tons.  By clicking the Load… button, previously stored curves, with less than 20 spline points,
can be selected via the “Open” dialog (if the selected file has more than 20 spline points, a
warning will be displayed, and no file will be loaded).  Look for files with the “.ncv” extension.

The Save… button opens the “Save As” dialog, where you can save the current curve.

Fine-Tune White Balance…
Selecting this option displays the dialog shown at right, where
white balance for each of the seven fixed white balance op-
tions can be fine-tuned between –3 and +3.  Clicking the Re-
set button returns all values to defaults.  Click OK to apply
the current settings to the camera, or click Cancel to discard
any changes and return to the Nikon Capture 3 Camera Con-
trol window.

Edit Camera Curves… (Windows only)
This option is used to create a custom tone compensation curve and download it to the cam-
era, where it applies when “Custom” is selected for the camera tone compensation option.
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Edit Image Comment…
Selecting this option displays the dialog shown at right, where
you can enter a comment or title for subsequent photographs.
If the camera currently connected is in the D1-series, enter a
title of thirty-eight characters or less and click OK.  The title
will be used for all subsequent photographs taken while the
camera is connected.  When a D100 camera is connected, the
title is stored in the camera as an image comment of thirty-six
characters or less which is appended to photographs only when
the Append Comment box is checked.

Live Batch…
Selecting this option opens the Live Batch dialog (  197).

Time Lapse Photography…
Selecting this option opens the Time Lapse Photography dialog (  201).

Measure White Balance…
Use this option to measure preset white balance.  If the cam-
era currently connected supports multiple values for preset
white balance, the setting that will be used to store the mea-
sured value can be chosen from the pop-up menu at the top
of the dialog.  Adjust camera settings as described in the sec-
tion on preset white balance in the camera user’s manual and
click OK to measure a value for white balance.

Select Shooting Settings Bank… (D100 only)
Selecting this option displays the dialog shown at right, where
can choose the shooting menu bank (D100 only) in which
changes to settings will be stored while the camera is con-
trolled from Nikon Capture 3 Camera Control.  For more in-
formation, see the D100 user’s manual.

D1X/D1H

D100

D100

D1-series
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Changes to Custom Settings

Changes made to settings in the Custom Settings dialog are stored in the camera, not on the computer
hard disk.  This means that changing settings in the Custom Settings dialog has the same effect as chang-
ing Custom Settings using camera controls.

Custom Settings
Most of the custom settings stored in camera memory can be viewed and adjusted from the
Custom Settings window in Nikon Capture 3 Camera Control.  For more information on Cus-
tom Settings, see the documentation provided with your camera.

1 Select Custom Settings… from the Camera menu
The Custom Settings dialog will be displayed.

The Custom Settings dialog shows the Custom Settings currently in effect.
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Custom Settings

Custom Settings can not be saved to a separate file.  Clicking the Reset button resets all Custom Settings
to their default values.

Settings That Can Not Be Adjusted from the Custom Settings Window

The Custom Settings listed below can not be adjusted in the Custom Settings window.
• Mirror lock-up for CCD cleaning (D1-series Custom Setting 8) /Cleaning mirror up (D100 setup menu):

can only be adjusted from the camera
• RAW (NEF) image save (D1-series Custom Setting 28): if this option is set to “0” (off) when Nikon

Capture is started, a message will be displayed.  Clicking OK in this dialog sets Custom Setting 28 to “1”
(uncompressed RAW image save enabled).  Custom Setting 28 can only be returned to “0” from the
camera.

• ISO Auto (D100 Custom Setting 3) /ISO Boost (D1-series Custom Setting 31): can be adjusted from the
Exposure 2 tab of the Camera Control window.

• PC Shooting Mode (D1-series Custom Setting 30): this option is adjusted from the Mechanical tab of the
Camera Control window.

• Tone Compensation (D1-series Custom Setting 24) /Color Mode (D1X/D1H Custom Setting 32) /Hue Ad-
justment (D1X/D1H Custom Setting 33) /Noise Reduction (D100 Custom Setting 4): can be adjusted from
the Processing tab of the Camera Control window.

The banks available depend on the model of camera currently connected.  When the D1
or D100 is connected, you have a choice of banks A or B; when the D1X or D1H is con-
nected, banks A, B, C, or D can be selected.

3 Click OK
After making any adjustments to Custom Settings, click OK to save the changes in the
camera Custom Settings bank and exit the Custom Settings dialog.

The pages that follow describe the Custom Settings available in each of the three tabs in the
Custom Settings dialog.  Depending on the model of camera connected, some Custom Set-
tings may not be available.

2 Choose a Custom Settings bank
Choose a Custom Settings bank (Custom Settings set) from the pop-up menu at the top
right corner or the Custom Settings dialog.
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The Page 1 Tab
The Page 1 tab contains the following settings (the illustration shows the settings displayed
when the D1X is connected):

The Auto Bracketing Area

The Autofocus Area

Camera Custom Setting #Item

D1-series 3
Bracketing order

D100 12

D1-series 11AE/Flash bracketing

D100 11AE/WB/Flash bracketing

D1-series 9
Dynamic AF mode in single-servo AF

D100 20

Camera Custom Setting #Item

D1-series 4Activate when shutter button is pressed halfway

D1-series 6
Focus area selection

D100 17

D1-series 10
Dynamic AF mode in continuous-servo AF

D100 21

D100 22Activate the AF-assist illuminator
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Other Items

The Battery Pack Area (D100 with MB-D100 Multi-Function Battery Pack Only)

Volume

AF button

Item

26

25

Custom Setting #

Camera Custom Setting #Item

D1-series 2EV steps for exposure control

D1X/D1H 20ISO step value

D1-series 14Center-weighted metering area
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The Page 2 Tab
The Page 2 tab contains the following settings (the illustration shows the settings displayed
when the D1X is connected):

The Viewfinder Area (D100 Only)

The LCD Display Area

Show grid lines

Focus area illumination

Item

19

18

Custom Setting #

Camera Custom Setting #Item

D1-series/
D100

1Image review

D1-series 17
Always use LCD illumination

D100 16

D1-series 18
Monitor-off delay

D100 6

D1X 36Zoom playback while writing images

D1-series 27Display mode
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Other Items

Camera Custom Setting #Item

D1-series 7AE lock when shutter button is pressed halfway

D1-series 12Exchange functions for front and rear command dials

D1-series 13Easy exposure compensation

D1-series 5Anti-mirror-shock mode

D1X/D1H 34Disable shutter button if no CF card is present

D1-series 29File-number sequence

D1X/D1H 35Rear control panel display
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The Page 3 Tab
The Page 3 tab contains the following settings (the illustration shows the settings displayed
when the D1X is connected):

Camera Custom Setting #Item

D1-series 15
Auto meter-off delay

D100 7

D1-series 16
Self-timer delay

D100 8

D1 20Blink self-timer LED when shutter is released

D1-series 22Change aperture setting via lens aperture ring

D100 2Disable shutter button if no CF card present

D100 6File-number sequence

D100 10Easy exposure compensation

D100 13Exchange functions for front and rear command dials

D100 15AE lock when shutter button is pressed halfway

D100 24Anti-mirror-shock mode

D100 9EV steps for exposure control

D1-series 21
AE-L/AF-L button

D100 14

D100 23Flash mode

D1-series 25Continuous mode shooting speed

D1-series 26Continuous mode max shots
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Nikon Capture 3 Camera Control Preferences
Fine-Tuning Nikon Capture 3 Camera Control

To view the Preferences dialog for Nikon Capture 3 Camera Control, select Preferences…
from the Edit (Windows or Mac OS 9) or application (Mac OS X) menu.

Displaying Photographs after Capture

To display photographs after capture when View it with Nikon View or Show it in Nikon Browser is
selected for When a new image is received from the camera in the General tab of the Camera Control
Preferences dialog, select the View captured image immediately option in the Nikon Viewer View
menu, or the Select captured image immediately option in the Nikon Browser View menu.

Viewing Preferences

To view settings in any of the three panes, click the appropriate tab.

The Preferences dialog contains the following three tabs:

Mac OS X

Windows / Mac OS 9

After making changes to preferences, click OK to save changes and return to the Nikon Cap-
ture 3 Camera Control window.  Click Cancel to cancel any changes to settings and return to
the Nikon Capture 3 Camera Control window.

Tab Description

General
Choose the length of time the camera remains active when
no operations are performed and the application used to
open images after shooting.

223

Temporary Files
Specify the location of the folders used for temporary stor-
age.

224

Color Management
Select the color profiles used by the Nikon Color Manage-
ment System (CMS).

224

Tab
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The General Tab
The General tab contains the following items:

While application is running, keep camera
awake
Set the length of time before exposure meters
turn off automatically when the camera is run-
ning on battery power.  This setting only takes
effect when the camera is connected and pow-
ered on, and only when Nikon Capture 3 Cam-
era Control is running.  This setting takes pre-
cedence over the auto meter off option cho-
sen using camera Custom Settings.  The D100
will stay awake indefinitely, regardless of the
setting chosen here.

for 15 minutes (D1-series only)
The time before exposure meters turn off
automatically is set to fifteen minutes.

Always
The camera stays awake indefinitely.  Note that this will increase the drain on the battery.

When powered by an AC adapter (available separately), the camera stays awake indefinitely,
regardless of the setting chosen using the above option.

When a new image is received from the camera
Choose the application that will be used to display photographs immediately after shooting.

Do nothing
Photographs are saved to the computer hard disk

View it with Nikon View
The Nikon Viewer window will open (if Nikon Browser is not already running, Nikon Browser
will start automatically).  If the Select captured image immediately item is checked in
the Nikon Browser View menu, the destination folder for captured images will be opened
in Nikon Browser with the captured image selected.  If the View captured image imme-
diately item is checked in the Nikon Viewer View menu, the captured image will be
displayed in Nikon Viewer.  If neither option is selected, the captured image can be dis-
played in Nikon Viewer by clicking the Next button, and the destination folder can be
opened manually in Nikon Browser using the Transfer Destination button.

Show it in Nikon Browser
Nikon Browser will start automatically.  If the Select captured image immediately item
is checked in the Nikon Browser View menu, the destination folder for captured images
will be opened in Nikon Browser with the captured image selected.  If Select captured
image immediately is not selected, the destination folder can be opened manually in
Nikon Browser using the Transfer Destination button.
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The Temporary Files Tab
The Temporary Files tab contains the follow-
ing item:

Folder for Temporary Data
Specify the folder or volume in which tempo-
rary data, such as image cache data, will be
stored.  The default folder for Windows is the
“TEMP” folder in the Windows directory, while
the default volume for the Macintosh is the
start-up disk.  To choose a different folder in
the Windows version of the program, click the
Browse… button and navigate to the desired
location.  In the Macintosh version, a new
volume can be chosen from the pop-up menu.

Folder for Temporary Data

The folder chosen for temporary storage in the Temporary Files tab also applies to Nikon Capture 3 Editor
and Nikon View.  Changes will only take effect after the program has been restarted.

The Color Management Tab

Changes to settings in the Color Management tab also apply to Nikon Capture 3 Editor.  Nikon Capture 3
must be restarted before changes to settings will take effect.

The Color Management Tab
For more information on the Color Management tab, see “Nikon Capture 3 Editor Preferences”
(  222).

MacintoshWindows
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The appendices cover the following topics.

Appendix A: Supported Color Profiles
Read this section for a description of the RGB color-space pro-
files supported under Nikon Capture 3.

Appendix B: Color Matching in Adobe Photoshop
Learn how to preserve color-space profile information when
opening images in Adobe Photoshop (version 5.0.2 or later).

Appendix C: Troubleshooting
Read this section for information on what to do when Nikon
Capture 3 does not function as expected.

Appendix D: Glossary
Refer to this section when you are unsure of the meanings of
the terms used in this manual.

Technical Notes

Appendices
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Appendix A
Supported Color Profiles

1. Standard RGB Profiles Supported in Nikon Capture 3

1.1 Profiles with a Gamma Value of 1.8

Apple RGB (Nikon Apple RGB 4.0.0.3086)
This profile is used in desk-top publishing applications and in Adobe Photoshop versions 4.0 or
earlier, and is the typical RGB profile for Macintosh monitors.  The corresponding RGB setting
in Adobe Photoshop is “Apple RGB.”  This profile is suitable for working with images dis-
played on the Macintosh.

ColorMatch RGB (Nikon ColorMatch RGB 4.0.0.3086)
The ColorMatch profile is native to Radius PressView monitors.  It has a wider gamut than
Apple RGB, with a particularly wide area devoted to the reproduction of blues.  The corre-
sponding RGB setting in Adobe Photoshop is “Color Match RGB.”

1.2 Profiles with a Gamma Value of 2.2

sRGB (Nikon sRGB 4.0.0.3086)
This RGB profile is used in the majority of Windows monitors.  It closely resembles the RGB
commonly used in color television, and is also used in the digital television broadcasting sys-
tem that is on its way to becoming the industry standard in the United States of America.
Software and hardware manufacturers use it as a default color profile and guarantee opera-
tion when it used.  It is also on its way to becoming the standard for images on the web. This
profile is suited to users who plan to use their digital images “as is,” without editing or print-
ing them.  It however suffers from the drawback of a narrow gamut with a limited area
available for reproducing blues. The corresponding RGB setting in Adobe Photoshop 5.0 and
5.5 is “sRGB,” the corresponding setting in Adobe Photoshop 6.0 “sRGB IWC61966-2.1.”

Bruce RGB (Nikon Bruce RGB 4.0.0.3086)
This color profile attempts to expand on the ColorMatch RGB gamut by defining the chroma-
ticity for G as lying between the values for G in the Adobe RGB and ColorMatch color-space
profiles.  It was proposed by Bruce Fraser, who claims that it includes most of the colors in the
SWOP CMYK gamut.  The R and B used in the Bruce RGB and Adobe RGB color-space profiles
match.

NTSC (1953) (Nikon NTSC (1953) 4.0.0.3086)
This is the color space for video defined by the National Television Standards Committee (NTSC)
in 1953 and used in early color televisions.  This color space is also used in some Far-East
newspaper and printing organizations.  The corresponding RGB setting in Adobe Photoshop is
“NTSC (1953).”
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Adobe RGB (1998) (Nikon Adobe RGB (1998) 4.0.0.3086)
A color-space profile defined in Adobe Photoshop 5.0.  It has a wider gamut than sRGB and
includes the colors found in most CMYK gamuts, making it suitable for users involved in
desktop publishing.  The corresponding RGB setting in Adobe Photoshop 5.0 is “SMPTE-
240M,” the corresponding setting in Adobe Photoshop 5.5 or later “Adobe RGB (1998).”

CIE RGB (Nikon CIE RGB 4.0.0.3086)
A video color-space profile established by the Commission Internationale de l’Éclairage (CIE).
While it boasts a fairly wide gamut, it suffers from the drawback that the area devoted to the
reproduction of cyan is relatively small.  The corresponding RGB setting in Adobe Photoshop is
“CIE RGB.”

Adobe Wide RGB (Nikon Adobe Wide RGB 4.0.0.3086)
This color-space profile, designed by Adobe, incorporates most of the visible colors.  This
however has the consequence that most of the colors it can express can not be reproduced on
standard monitors and printers.  The corresponding RGB setting in Adobe Photoshop 5.0 or
later is “Adobe Wide RGB.”

The gamut of colors that can be expressed in the above color-space profiles is shown in the
following chromaticity (x, y) graph.  The greater the area enclosed by the triangle that repre-
sents the color-space profile, the wider its gamut.

Gamut
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2. Technical Data for RGB Profiles Supported in Nikon Capture 3
The following table shows the gamma values for profiles supported in Nikon Capture 3, to-
gether with the chromaticity values for the white point and for red, green, and blue.

Color
temperature Value

White point

Gamma
value

Chromaticity (x, y)

Name R G BProfile

x

y
6500 K (D65)

0.31271591

0.32900148
1.8

x 0.625 0.28 0.155

y 0.34 0.595 0.07
TrinitronApple RGB

x

y
5000 K (D50)

0.34570292

0.3585386
1.8

x 0.63 0.295 0.155

y 0.34 0.605 0.077
P22-EBUColor Match RGB

y
6500 K (D65) 0.32900148

2.2
y 0.33 0.6 0.06

HDTV
(CCIR 709)

sRGB
x 0.31271591 x 0.64 0.3 0.15

x

y
Std

Illuminant C
0.3101

0.3162
2.2

x 0.67 0.21 0.14

y 0.33 0.71 0.08
NTSC
(1953)

NTSC (1953)

x

y
6500 K (D65)

0.31271591

0.32900148
2.2

x 0.64 0.28 0.15

y 0.33 0.65 0.06
Bruce RGBBruce RGB

x

y
6500 K (D65)

0.31271591

0.32900148
2.2

x 0.64 0.21 0.15

y 0.33 0.71 0.06
Adobe RGB

(1998)
Adobe RGB (1998)

x

y
Std

Illuminant C
0.33333333

0.33333333
2.2

x 0.735 0.274 0.167

y 0.265 0.717 0.009
CIE RGBCIE RGB

x

y
5000 K (D50)

0.34570292

0.3585386
2.2

x 0.735 0.115 0.157

y 0.265 0.826 0.018
700/525/
450 nm

Adobe Wide RGB

x

y
6500 K (D65)

0.31271591

0.32900148
2.2

x 0.64 0.3 0.15

y 0.33 0.6 0.06
HDTV

(CCIR 709)
Default Windows

monitor

x

y
5000 K (D65)

0.34570292

0.3585386
1.8

x 0.625 0.28 0.155

y 0.34 0.595 0.07
Trinitron

Default Macintosh
monitor
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ColorSync (Macintosh)

The explanation in this section assumes that ColorSync version 3.0 or later is installed on your Macintosh.

Appendix B
Color Matching in Adobe Photoshop (Version 5.0.2 or Later)

When an image saved in Nikon Capture 3 is opened in Adobe Photoshop, the profiles used in
Adobe Photoshop should match those used in Nikon Capture 3.  If the profiles do not match,
the colors seen in Adobe Photoshop may not be the same as those in the original image.  The
profiles used with Nikon Capture 3 can be used with Adobe Photoshop version 5.0.2 or later.

The first step is to match the Nikon Capture 3 monitor profile with that used in Adobe Photoshop.
The point to remember is that you should specify the monitor profile for Adobe Photoshop
first and then select the same profile for Nikon Capture 3.  For more information, see “Choos-
ing a Monitor Profile”  (  230).

The next step is to save the image from Nikon Capture 3 using a format that supports inclusion
of color profile information.  If you save the image in TIFF, JPEG (JFIF), or JPEG (Exif), informa-
tion about the color profile used in Nikon Capture 3 will be embedded in the file, and Adobe
Photoshop will use this information to process colors appropriately when the file is opened.
For more information, see “Adjusting Settings in Adobe Photoshop” (  234).
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3 Create a color profile
Follow the on-screen directions to calibrate your monitor.  The resulting monitor profile
will be saved in the folder listed below.  Make a note of the file name.
•Windows\System\Color

4 Choose the profile created in Step 3 for Nikon Capture 3
Choose the profile created in Step 3 as the Nikon Capture 3 monitor profile.  For details,
see “Preferences: The Color Management Tab” (  182).

Step 1—Choosing a Monitor Profile
Choose a monitor profile as described below.

Creating a New Monitor Profile
If you have not yet calibrated your monitor, use Adobe Gamma to create a profile for your
monitor.  Adobe Gamma is included in the standard install of Adobe Photoshop.

Creating a Monitor Profile (Adobe Photoshop 5.x)

1 Display the Adobe Color Management Assistant
Select Color Management… from the Adobe Photoshop Help menu.

2 Click Open Adobe Gamma…
In the Adobe Color Management Assistant dialog, click Open Adobe Gamma….
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2 Create a color profile
Follow the on-screen directions to calibrate your monitor.  The resulting monitor profile
will be saved in the folder listed below.  Make a note of the file name.
•Windows\System\Color

3 Choose the profile created in Step 2 for Nikon Capture 3
Choose the profile created in Step 2 as the Nikon Capture 3 monitor profile.  For details,
see “Preferences: The Color Management Tab” (  182).

Creating a Monitor Profile (Adobe Photoshop 6.0)

1 Start Adobe Gamma
Select Adobe Gamma from the system control panels or double-click the Adobe Gamma
utility icon.
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2 Note the name of the monitor profile
Make a note of the name that appears to the right of the “Monitor” entry in the second
line of the RGB Setup dialog.

3 Locate the monitor profile
The monitor profile that appeared in Step 2 will be stored in the folder listed below.
•Windows\System\Color

4 Choose the profile as the Nikon Capture 3 monitor profile
Choose the profile noted in Step 2 as the Nikon Capture 3 monitor profile.  For details, see
“Preferences: The Color Management Tab” (  182).

Using an Existing Monitor Profile
If you have already calibrated your monitor, follow the steps below to select an existing moni-
tor profile.

Using an Existing Monitor Profile (Adobe Photoshop 5.x)

1 Display the RGB Setup dialog
Select Color Settings > RGB Setup… from the Adobe Photoshop File menu.
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3 Locate the monitor profile
The monitor profile that appeared in Step 2 will be stored in the folder listed below.
•Windows\System\Color

4 Choose the profile as the Nikon Capture 3 monitor profile
Choose the profile noted in Step 2 as the Nikon Capture 3 monitor profile.  For details, see
“Preferences: The Color Management Tab” (  182).

If you are unable to locate a profile with the correct name, create a new profile as directed in
“Creating a Monitor Profile” on page 230.

Using an Existing Monitor Profile (Adobe Photoshop 6.0)

1 Display the Color Settings dialog
Select Color Settings… from the Adobe Photoshop Edit menu.

2 Note the name of the monitor profile
Open the RGB pop-up menu in the Work Spaces section of the Color Settings dialog.
The monitor profile will appear to the right of the Monitor RGB entry.  Note down the
name of the profile.
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Step 2—Adjusting Settings in Adobe Photoshop
The following describes the minimum necessary adjustments to ensure consistent color repro-
duction in Adobe Photoshop.  The menus and dialogs referred to below are all from Adobe
Photoshop.

Opening TIFF, JPEG (JFIF), and JPEG (EXIF) Images Created Using Nikon Capture 3
Images saved in TIFF, JPEG (JFIF), and JPEG (EXIF) formats include color-space profile informa-
tion.  Open files in these formats as described below.

Opening TIFF and JPEG (JFIF) Images in Adobe Photoshop 5.x

1 Display the RGB Setup dialog
Select Color Settings > RGB Setup… from the Adobe Photoshop File menu.

2 Check Display Using Monitor Compensation
In the Monitor section, check Display Using Monitor Compensation.
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3 Close the RGB Setup dialog
Click OK to close the RGB Setup dialog.

4 Display the Profile Setup dialog
Select Color Settings > Profile Setup… from the Adobe Photoshop File menu.

5 Select Convert to RGB Color for Profile Mismatch Handling
Select Convert to RGB Color from the RGB pop-up menu in the Profile Mismatch Han-
dling section.

6 Close the Profile Setup dialog
Click OK to close the Profile Setup dialog.
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2 Check Advanced Mode

Opening TIFF and JPEG (JFIF) Images in Adobe Photoshop 6.0

1 Display the Color Settings dialog
Select Color Settings… from the Adobe Photoshop Edit menu.

Advanced Mode

RGB pop-up menu

Profile Mismatches
section
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3 Select Preserve Embedded Profiles for Color Management Policies
Select Preserve Embedded Profiles from the RGB pop-up menu in the Color Manage-
ment Policies section.

4 Remove the check from Ask When Opening
Remove the check from Ask When Opening in the Profile Mismatches area of the Color
Management Policies section.

5 Close the Color Settings dialog
Click OK to close the Color Settings dialog.

At these settings, a warning may be displayed when an image is opened.  To prevent the
warning being displayed again, select the appropriate option in the warning dialog.
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Nikon Capture 3 and Adobe Photoshop Color Profiles

Nikon Capture 3 output profile Adobe Photoshop profile

sRGB
(Nikon sRGB 4.0.0.3086)

sRGB

Apple RGB
(Nikon Apple RGB 4.0.0.3086)

Apple RGB

Color Match RGB
(Nikon Color Match RGB 4.0.0.3086)

Color Match RGB

Bruce RGB
(Nikon Bruce RGB 4.0.0.3086)

—

NTSC (1953)
(Nikon NTSC (1953) 4.0.0.3086)

NTSC (1953)

Adobe RGB (1998)
(Nikon Adobe RGB (1998) 4.0.0.3086)

Version 5.5 or later: Adobe RGB (1998)
Earlier versions: SMPTE-240M

CIE RGB
(Nikon CIE RGB 4.0.0.3086)

CIE RGB

Adobe Wide RGB
(Nikon Adobe Wide RGB 4.0.0.3086)

Version 5.5 or later: Adobe Wide RGB
Earlier versions: Wide Gamut RGB
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The ReadMe File

Included on the installer CD is a README file containing the most current information on Nikon Capture
3.  Please read this file before installing and using Nikon Capture, as it may contain important information
that could not be included in this manual.  Should you encounter problems with Nikon Capture 3 not
covered in this section, please consult the README file for the most up-to-date information.

Appendix C
Troubleshooting

Should you encounter problems with Nikon Capture 3, check the list on the following pages
before consulting your retailer or Nikon representative.

Nikon Capture 3 Does Not Start
Confirm that your computer system meets all of the requirements specified for using Nikon
Capture 3 (OS, memory, hard disk capacity, etc.).  See “Installing Nikon Capture 3.”

Nikon Capture 3 Does Not Recognize the Camera
If the camera connected to the computer is in the D1 series, verify that the camera’s mode dial
is set to “PC.”  In PC mode, the control panel on the top of the camera will show PC, as will
the view through the camera’s viewfinder.

If the camera is in PC mode, and Nikon Capture 3 still does not recognize the camera, check
the following points:

1 Check the power switch and mode dial
• Is the camera on?
• Is the battery fully charged?  To reduce the drain on the battery, we recommend that the

camera be powered by an adapter (available separately) when connected to the com-
puter.

• If you are using an AC adapter, is it properly connected and plugged in?

2 Verify that the interface cable is properly connected
• Is the interface cable securely connected to both camera and computer?

Remember that IEEE 1394 connectors do not make a “click” when fully inserted.  If the
cable is securely connected, try disconnecting the cable and reconnecting the devices in
a different order.

• Is there another peripheral connected to the IEEE 1394 bus?
Try disconnecting other IEEE 1394 devices and connecting just the computer and the
camera.

3 Are you using a recommended IEEE 1394 interface (D1-series cameras only)?
See the system requirements in “Installing Nikon Capture 3.”  For information on your
IEEE 1394 interface, see the manufacturer’s web-site.
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4 Is the IEEE 1394 interface board correctly registered with the system (Windows
only)?
Check whether:
•The “IEEE 1394 Bus Controller” is not displayed in the Device Manager
•The IEEE 1394 board is listed under “Other Devices” or “Unknown Devices”
•A yellow or red mark appears next to the listing for the IEEE 1394 board

If any of the above apply, the IEEE 1394 board has not been correctly registered with the
system.  See the documentation provided with the board for information on device regis-
tration.

Nikon Transfer Does Not Start
If Nikon Transfer fails to start when a supported camera is connected or a memory card from
a supported camera inserted in a card reader or PC card slot, check that the memory card is
properly inserted in the camera, card reader, or card slot, that the interface cables are properly
connected, and the camera is turned on.  Note that Nikon Transfer will not start automatically
when Disable auto launch is selected in the Auto Launch tab of the Nikon Browser or Nikon
Viewer Preferences dialog.  Nikon Transfer will not start when Nikon Capture 3 Camera Con-
trol is running.

Captured Images are Too Bright, Too Dark, Washed Out, or Out of Focus
• At default settings, Nikon Capture 3 does not modify image images when they are cap-

tured from the camera.  In the General tab of the Preferences dialog, verify that your
images are being captured at Nikon Capture’s default settings and not at the settings of the
last image captured.  See “Preferences” for more information.  Alternatively, check the
settings in the Curves, Color Balance, and Unsharp Mask windows.  Choose the reset
option from the Settings menu for each window, or turn the Apply button for the window
off.

• Are monitor settings correctly adjusted?
Try adjusting your monitor’s contrast/brightness, color system, etc. to be sure that it is
properly set for viewing images.  See the documentation provided with your monitor for
instructions on adjusting monitor settings.

Thumbnails Are Not Displayed in Nikon Browser
Check that the folder selected in the folder tree contains images or sound files created by a
supported model of camera.

Movies Can Not Be Played Back
Confirm that you have installed a program for playing movies back.

Unable to Locate Images after Transfer
Check the destination displayed in the Nikon Transfer window.
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This glossary provides definitions of some of the terms used in this manual.

Bit depth
The number of bits used to express color, also referred to as color depth.  The bit depth
determines the amount of color information in an image.  The greater the bit depth, the larger
the number of colors, and the finer the gradations, that can be expressed.  Bit depth can be
used to refer both to the number of bits per channel and to the combined bit depth for all
channels; thus, for example, an image with a bit depth of eight bits per channel can be said to
have a bit depth of twenty-four bits.  An image with a bit depth of one bit has only two colors,
typically black and white, with no gradation between the two.  See also Channel.

Black Point
The input value below which all input tones are mapped to the minimum output value (by
default no color, or black).  Any details darker than the black point will be lost.  See also Tone,
Tone curve.

Channel
The component colors in a given color space.  The RGB color space is made up of red, green,
and blue channels and a master channel that combines the three.  See also Color space.

Clip
The percentage of pixels at both ends of the curve that are excluded in an auto contrast
operation.  See also Tone curve.

CMS
See Color management system.

CMYK
A reflective (subtractive) color model commonly used in printing, which models color using
combinations of the three secondary colors used in printer’s ink, Cyan, Magenta and Yellow.
Because no combination of these three inks will create a true black, blacK ink is also used.

Color management system
A method of ensuring consistency of color reproduction between devices such as scanners,
monitors, and printers, and between different computer platforms.  In the color management
system used in Nikon Capture 3, accurate color reproduction is ensured through the use of
profiles that provide information about the characteristics of the monitor or printer and the
color space used for editing.  See also ColorSync, ICC, Profile.

Color space
A general term encompassing both the model used to define color (for example, CMYK or
RGB) and the range, or gamut, of colors that can be expressed in a given color model.  See also
CMYK, Gamut, RGB.

ColorSync
A color management system for Mac OS developed by Apple.  See also Color management
system, ICC.
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CompactFlash™ memory card
A small, removable flash memory card.  Used for storage of photographs in Nikon digital
cameras.

Compression
A method for reducing file sizes for storage or transmission.  Compression algorithms can be
divided into “lossless” algorithms, such as LZW, in which no information is lost when files are
restored to their original size for display or editing, and “lossy” algorithms, such as JPEG, in
which some information is lost when the file is restored.  See also JPEG, TIFF.

Crop
The portion of the image selected in an image window.

Curve
See Tone Curve.

Eyedropper
A tool for sampling white point, black point, or midpoint.  See also Black point, Midpoint,
White point.

FireWire
Apple’s term for the IEEE 1394 interface.  See IEEE 1394.

Gamma
Gamma (also written “γ”), a fundamental property of video systems, determines the intensity
of the output signal relative to the input.  When calculating gamma, the maximum possible
input intensity is assigned a value of one, and the minimum possible intensity (no input) is
assigned a value of zero.  Output is calculated by raising input to the inverse of the gamma
value (output = input ( 1/γ ) ).

Gamut
The range of colors that can be expressed by a given input device (for example, scanner or
digital camera), output device (monitor or printer), or color profile.   No gamut can reproduce
all of the colors seen by the human eye.  The gamut of primary RGB (Red, Green, and Blue)
transmitted light displays (film transparencies and color monitors) is very different from, and
complementary to, the gamut of secondary CMYK (Cyan, Magenta, Yellow, and blacK) re-
flected light displays (printed materials).  See also CMYK, Profile, RGB.

Gray point
See Midpoint.

Halo width
The extent of pixels around a selected central pixel affected when Unsharp Mask is applied.
Also referred to as “radius.”  Increasing the halo width increases the width of edges affected
by Unsharp Mask.  Excessive application of Unsharp Mask results in an undesirable halo along
edges in the image.  See also Unsharp Mask.
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Histogram
A bar graph showing the distribution of tones in an image.  The horizontal axis shows tone
level (brightness), the vertical axis the number of pixels.  The bars in the graph show the
number of pixels of a given brightness in the image.  The histogram displayed in the Curves
window shows the distribution of tones for the currently selected channel, and can be used
for reference when editing curves.  See also Tone, Tone curve.

ICC
The International Color Consortium, an international organization working to develop stan-
dards for color management and color management profiles.  ICC profiles were developed for
the conversion of color space information between devices, and are now on their way to
becoming a global standard.  ICC profiles have been proposed as an International Organiza-
tion for Standardization (ISO) standard.  See also Profile.

IEEE 1394
A high-speed transfer protocol developed by the Institute of Electrical and Electronics Engi-
neers for connecting peripherals such as hard disks, MO drives, and digital cameras to a com-
puter via a cable.

JPEG
A standard graphic format designed by the Joint Photographic Experts Group.  Images are
compressed using a discrete cosine transform that takes advantage of the properties of hu-
man vision, which is more sensitive to light in the lower wavelengths, to increase quantization
at lower frequencies.  JPEG compression is “lossy,” meaning that information is lost when
images are compressed, leading to a drop in image quality.  A lossless compression option is
also supported in some implementations.  JPEG images can be compressed to as much as
100:1, though quality will be significantly reduced.  At a compression ratio of 20:1, image
quality is not noticeably diminished.

LCD
Liquid Crystal Display.  LCDs are notable for their thinness, lightness, and the fact that they
consume relatively little energy.

Midpoint
Controls the output level for mid-tones in the original image.  See also Tone, Tone curve.

NEF
An abbreviation of Nikon Electronic Image Format, an image file format developed by Nikon to
support high-resolution, twelve-bit RAW image data.  In Windows, NEF files have the exten-
sion “.nef”.  NEF images can be opened and edited only in Nikon Capture.  The advantage of
NEF is that while user settings such as curves and color balance are saved, they are not applied
to the original image data.  NEF images may thus be edited and saved several times without
degrading or altering the original image.  NEF files however require a relatively large amount
of storage space.  See also RAW image.

Noise
Data in an image file that are not a part of the original image, the digital equivalent of film
grain.  The presence of noise is reflected in a loss in image quality.  Noise appears primarily in
dark areas of the image, and can be reduced by adjusting exposure or lighting to fill in shad-
ows.
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ppcm
pixels per centimeter, a measure of resolution.  The more pixels per centimeter, the higher the
resolution. See also ppi, Resolution.

ppi
pixels per inch, a measure of resolution.  The more pixels per inch, the higher the resolution.
See also ppcm, Resolution.

Preferences
Settings controlling basic operations performed by a given program, adjustable by the user.

Profile
A file defining the color characteristics of an input device such as a scanner or digital camera,
an output device such as a printer or monitor, or the color space used for editing images.
Profiles are used by color management systems to ensure consistent color reproduction.  The
Nikon Color Management System used in Nikon Capture employs ICC profiles.  See also Color
space, ICC.

RAW image
A photograph taken at an image quality setting of HI-RAW.  “Raw,” unmodified image data
from the camera’s image sensor (charge-coupled display, or CCD) are saved in uncompressed
form at a pixel bit-depth of twelve bits per pixel.  RAW images can only be opened in Nikon
Capture 3, and must be saved again in a standard image format such as TIFF or JPEG before
they can be opened in another application.  See also NEF.

Resolution
The density of dots or pixels that make up an image, measured in dots per inch (dpi) or pixels
per inch (ppi); the resolution of Macintosh monitors, for example, is 72 ppi.  The greater the
density of dots or pixels, the higher the resolution and the greater the capacity to express
detail.  Resolution is hence the digital equivalent of film resolving power.  Computer monitors
typically have a resolution of 72 ppi or 96 ppi, while printers may have resolutions of 300 dpi,
600 dpi, 1200 dpi, or 2400 dpi.  See also ppcm, ppi.

RGB
An additive color model commonly used in monitors, in which light emitted in three primary
colors, Red, Green and Blue, is combined to create a wide variety of colors.  White is modeled
by mixing 100% of all three colors.

Scale
The output size of an image as a percentage of the input size.  At a scale of 50%, images will
be output at half their original size.

Speedlight
A brand name for Nikon flashes.

Threshold
The limit up to which Unsharp Mask will be applied.  While it is generally the case that the
higher the threshold, the greater the amount of sharpening applied, the exact effect depends
on other Unsharp Mask settings, such as halo width.  See also Halo width, Unsharp Mask.
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Thumbnail
A small preview image, the digital equivalent of a photographic film contact sheet.  Images
loaded into Nikon Capture are displayed in a thumbnail list in the Thumbnails section of the
Camera Image window.

TIFF
Tagged Image File Format, an image file format for color or grayscale images, suited to storing
bit-mapped images such as digital photographs.  In some implementations, TIFF supports
“lossless” LZW and packbit compression (in “lossless” compression methods, no information
is lost when the image is compressed, as opposed to “lossy” compression methods such as
JPEG, in which detail is sacrificed to achieve higher compression ratios).  Images saved in TIFF
format using Nikon Capture are not compressed.  See also Compression, JPEG.

Tone
Pixel brightness, measured either as the combined intensity for red, green, and blue or the
intensity of each of these colors (channels) individually.  The number of tones that can be
expressed depends on the bit depth of the image; Nikon Capture 3 supports 256 tone levels
per channel at a bit depth of eight bits and 4096 tone levels per channel at a bit depth of
twelve bits (data with a bit depth of twelve bits are handled internally as sixteen-bit data).  The
distribution of tones in the image can be seen in the Curves window histogram.  See also Bit
depth.

Tone curve
A visual tool for editing tones, enhancing brightness and contrast in a selected portion of the
tone range.  Changing the shape of the tone curve changes the mapping between input (the
tones in the original image) and output (tones as they appear after editing).  The digital equivalent
of a densitometric curve.  See also Tone.

Unsharp Mask
A filter for increasing the apparent sharpness of bit-mapped images.  Sometimes abbreviated
as “USM.” Unsharp masks emphasize the differences in color and brightness between edges
(outlines) and the rest of the image.  See also Halo width, Threshold.

White balance
The human eye is able to adapt to changes in lighting, and consequently to humans a white
object will still look white whether viewed in direct sunlight or under overcast skies, or indoors
under incandescent or fluorescent lighting.  A digital camera, in contrast, must adjust colors
according to lighting if colors that appear white when viewed directly are also to appear white
in the final photograph.  This adjustment is called “white balance.”

White point
The input value above which all input tones are mapped to the maximum output value (the
default for the master channel is white).  Any details brighter than the white point will be lost.
See also Tone, Tone curve.


	Notices
	Table of Contents
	Introduction
	Overview
	The Five Components of Nikon Capture 3
	System Requirements
	Workflow

	Nikon Transfer
	The Nikon Transfer Window
	Transferring Images

	Nikon Browser
	The Nikon Browser Window
	Using Nikon Browser
	Nikon Browser Preferences

	Nikon Viewer
	The Nikon Viewer Window
	Using Nikon Viewer
	Nikon Viewer Preferences

	Nikon Capture 3 Editor
	The Editor Window
	Image Adjustment
	Nikon Capture 3 Editor Preferences

	Nikon Capture 3 Camera Control
	The Camera Control Window
	Nikon Capture 3 Camera Control Preferences

	Appendices
	Appendix A
	Appendix B
	Appendix C
	Appendix D


